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1
Installing the Operating System

Ä
CAUTION: Do not add optional hardware or third-party devices to your computer until the operating 
system is successfully installed. Doing so may cause errors and may prevent the operating system from 
installing properly.

Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE PROCESS 
IS COMPLETE. Turning off the computer during the installation process might damage the software that 
runs the computer or prevent its proper installation.

✎ Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor to 
permit the required airflow.

The first time the computer is turned on, the operating system is automatically installed. This 
takes approximately 10 minutes, depending on the operating system being installed. Carefully 
read and follow the instructions that appear on the screen to complete the installation.

✎ If the computer shipped with more than one operating system language on the hard drive, the 
installation process could take up to 60 minutes.

If the computer was not shipped with a Microsoft operating system, some portions of this 
documentation do not apply. For complete operating system installation and configuring 
instructions, refer to the operating system documentation. Additional information is available in 
online help. 

Microsoft security updates are available on the Microsoft Web site.

1.1 Installing or Upgrading Device Drivers
To install optional hardware devices after the operating system installation is complete, the 
drivers for each of the devices must also be installed. 

If prompted for the I386 directory, replace the path specification with C:\i386, or use the Browse 
button in the dialog box to locate the i386 folder. This action points the operating system to the 
appropriate drivers.

Obtain the latest support software, including support software for the operating system from 
www.hp.com/support. Select the appropriate country and language then, select Download 
drivers and software, enter the model number of the computer, and press Enter.

You can also obtain the latest support software on CDs. The following Web site provides 
information on how to purchase a support software CD subscription:

http://h18000.www1.hp.com/support/files/desktops/us/purchase.html.

✎ If the computer has a writable optical drive, install the appropriate application to be able to write 
to the drive. 
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1.2 Transferring Files and Settings
Use the Microsoft Windows XP Files and Settings Transfer Wizard to move files and settings 
from an old computer to a new one. Click Start > All Programs > Accessories > System Tools 
> Files and Settings Transfer Wizard. Follow the wizard to transfer the files and settings to the 
new computer.

1.3 Creating a Disc Recovery Set

Ä
CAUTION: HP no longer ships the Restore Plus! CD with PCs. Instead, HP Backup and Recovery 
Manager is pre-loaded on each system. HP recommends the creation of a recovery CD as soon as the 
computer has been set up. Creating the Restore Plus! CD set is important in the event that you ever need 
to restore the system hard drive to its factory installed state.

HP Backup and Recovery Manager can create the Restore Plus CD set, This set includes the 
Restore Plus CD, the Operating System CD, and any Supplemental Software CDs.

Ä
CAUTION: The Restore Plus CD set will not include any system settings or user data created after the 
initial system setup.

T o create the Restore Plus CD set:

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open 
the Backup and Recovery Wizard, then click Next.

2. Select Create factory software recovery CDs or DVDs to recover the system.

3. Follow the instructions in the wizard.

The HP Backup and Recovery Manager can be used to back up data and system files to the hard 
drive, to network drives, or to removable media, such as CDs, DVDs, or flash media. If data or 
system files are lost, deleted, or corrupted, Backup and Recovery Manager allows you to retrieve 
data or restore the last good system image.

Ä
CAUTION: HP recommends that a backup schedule be created immediately to ensure continued system 
and data protection. Automatic backups can be scheduled using the HP Backup and Recovery Wizard. 
Recovery Points, Entire Drive Backups, and File Backups can be automatically backed up without user 
intervention. HP recommends scheduling Recovery Points Backups to provide the most comprehensive 
coverage.

✎ If HP Backup and Recovery Manager is preinstalled, the Restore Plus CD set and the initial 
recovery point may be saved to disc as often as necessary, but only a single copy of the Microsoft 
Windows CD can be created, due to licensing constraints.

You can access a user manual at Start > HP Backup and Recovery > HP Backup and 
Recovery Manager Manual.

If Create factory software recovery CDs or DVDs to recover the system is unavailable on the 
system, the HP Restore Plus CD set can be obtained through product support on 
http://welcome/country/us/en/contact_us.html.
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2
Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer 
system when contacting Customer Support. These tools can also be used to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the computer are recognized by the system and 
functioning properly.

■ Determine information about the operating environment of the computer.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts.

✎ All features identified in this chapter may not be available on all HP products.

2.1 Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST 
checks the following items to ensure that the computer system is functioning properly:

■ Keyboard

■ Memory modules

■ All mass storage devices 

■ Processors

■ Controllers

✎ If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
will need to enter the password before continuing. Refer to Section 3.1, “Initial Configuration 
and Deployment” for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error 
messages and their solutions refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup Utilities
Use Computer Setup Utilities (F10) to: 

■ Change factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration, including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, 
or USB flash media devices.

■ Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests 
run during a Full Boot. You can set the system to:

❏ always Quick Boot (default);

❏ periodically Full Boot (from every 1 to 30 days); or

❏ always Full Boot.

■ Select Post Messages Enabled or Disabled to change the display status of Power-On 
Self-Test (POST) messages. Post Messages Disabled suppresses most POST messages, such 
as memory count, product name, and other non-error text messages. If a POST error occurs, 
the error is displayed regardless of the mode selected. To manually switch to Post Messages 
Enabled during POST, press any key (except F1 through F12).

■ Establish an Ownership Tag, the text of which is displayed each time the system is turned on 
or restarted.

■ Enter the Asset Tag or property identification number assigned by the company to this 
computer.

■ Enable the power-on password prompt during system restarts (warm boots) as well as during 
power-on.

■ Establish a setup password that controls access to Computer Setup (F10) Utility and the 
settings described in this section.

■ Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable removable media boot ability.

■ Enable or disable legacy diskette write ability (when supported by hardware).

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Replicate the system setup by saving system configuration information on diskette and 
restoring it on one or more computers.

■ Execute self-tests on a specified ATA hard drive (when supported by drive).

■ Enable or disable DriveLock security (when supported by drive).
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2.2.1 Using Computer Setup (F10) Utilities 
Computer Setup can be accessed only by turning on the computer or restarting the system. To 
access the Computer Setup Utilities menu, complete the following steps: 

1. Turn on or restart the computer. If you are in Windows, click Start >Shut Down >Restart. 

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary. 

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and again 
press F10 when the monitor light turns green.

3. Select your language from the list and press the Enter key.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, 
Security, Power, and Advanced. 

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and 
down) keys to select the option you want, then press Enter. To return to the Computer Setup 
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit. 

❏ If you have made changes that you do not want applied, select Ignore Changes and 
Exit.

❏ To reset to factory settings or previously saved default settings, select Set Defaults and 
Exit. This option will restore the original factory system defaults.

Ä
CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the F10 Computer Setup 
changes because the CMOS could become corrupted. It is safe to turn off all power to the computer only 
after exiting the F10 Setup screen. 
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2.2.2 Computer Setup Menu
Heading Option Description

File System Information Lists:
• Product name
• SKU number (some models)
• Processor type/speed/stepping
• Cache size (L1/L2) (dual core processors have this listed twice)
• Installed memory size/speed and number of channels (single or 

dual) (if applicable)
• Integrated MAC address for embedded, enabled NIC (if 

applicable)
• System BIOS (includes family name and version)
• Chassis serial number
• Asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM 
(some models)

Allows you to select a drive containing a new BIOS.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a formatted 
1.44-MB diskette, a USB flash media device, or a diskette-like 
device (a storage device set to emulate a diskette drive).
Restore from Removable Media
Restores system configuration from a diskette, a USB flash media 
device, or a diskette-like device.

Default Setup Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.

Apply Defaults 
and Exit

Applies the currently selected default settings and clears any 
established passwords.

Ignore Changes 
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and 
Exit

Saves changes to system configuration or default settings and exits 
Computer Setup.

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage Device 
Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are 
displayed. The following options may be presented.

Diskette Type (Legacy Diskettes only)
Identifies the highest capacity media type accepted by the diskette 
drive.
Options are 3.5" 1.44 MB, and 5.25" 1.2 MB.

Drive Emulation
Allows you to select a drive emulation type for a certain storage 
device. (For example, a Zip drive can be made bootable by 
selecting diskette emulation.) 

Drive Type Emulation Options

ATAPI Zip drive None (treated as Other)

Diskette (treated as diskette drive)

Hard disk None (prevents BIOS data accesses and 
disables it as a boot device) 

Hard disk (treated as hard drive)

Legacy diskette No emulation options available

CD-ROM drive No emulation options available

ATAPI LS-120 None (treated as Other).

Diskette (treated as diskette drive).

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Device 
Configuration 
(continued)

Multisector Transfers (ATA disks only)
Specifies how many sectors are transferred per multi-sector PIO 
operation. Options (subject to device capabilities) are Disabled, 8, 
and 16.
Transfer Mode (IDE devices only)
Specifies the active data transfer mode. Options (subject to device 
capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra DMA 0, 
and Max UDMA.
Translation Mode (ATA disks only)
Lets you select the translation mode to be used for the device. This 
enables the BIOS to access disks partitioned and formatted on other 
systems and may be necessary for users of older versions of UNIX 
(e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, 
LBA Assisted, User, and None

Ä CAUTION: Ordinarily, the translation mode selected 
automatically by the BIOS should not be changed. If the selected 
translation mode is not compatible with the translation mode that 
was active when the disk was partitioned and formatted, the data 
on the disk will be inaccessible.

Translation Parameters (ATA disks only)

✎ This feature appears only when User translation mode is selected.
Allows you to specify the parameters (logical cylinders, heads, and 
sectors per track) used by the BIOS to translate disk I/O requests 
(from the operating system or an application) into terms the hard 
drive can accept. Logical cylinders may not exceed 1024. The 
number of heads may not exceed 256. The number of sectors per 
track may not exceed 63. These fields are only visible and 
changeable when the drive translation mode is set to User.
Default Values IDE/SATA
Allows you to specify the default values for the Multisector Transfers, 
Transfer Mode, and Translation Mode for ATA devices.

Storage Options Removable Media Boot
Enables/disables ability to boot the system from removable media.

Legacy Diskette Write
Enables/disables ability to write data to legacy diskettes.

✎ After saving changes to Removable Media Write, the computer 
will restart. Turn the computer off, then on, manually.

BIOS DMA Data Transfers
Allows you to control how BIOS device I/O requests are serviced. 
When “Enable” is selected, the BIOS will service ATA device read 
and write requests with DMA data transfers. When “Disable” is 
selected, the BIOS will service ATA device read and write requests 
with PIO data transfers.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Storage Options 
(continued)

SATA Emulation
Allows you to choose how the SATA controller and devices are 
accessed by the operating system. There are up to three supported 
options: IDE, RAID, and AHCI.
IDE is the default option. Use this option for “normal” (non-RAID, 
non-AHCI) configurations.
Select the RAID option to enable DOS and boot accesses to RAID 
volumes. Use this option for RAID configurations under Windows 
2000, XP, or Vista with the appropriate RAID device driver.

✎ The RAID device driver must be installed prior to attempting to 
boot from a RAID volume. If you attempt to boot from a RAID 
volume without the required device driver installed, the system 
will crash (blue screen). Also, do not select the RAID option while 
the DriveLock feature is enabled on any attached hard drives. 
Doing so will cause the DriveLocked drives to remain locked and 
inaccessible during subsequent reboots until another SATA 
emulation mode is selected.

Select the ACHI option to enable DOS and boot accesses to SATA 
devices using the AHCI interface. Select this mode if the target 
operating system supports accessing the SATA devices via AHCI 
(e.g. Windows Vista) and AHCI accesses are desired.

✎ Windows 2000 and Windows XP require a third-party device 
driver to access SATA devices using the AHCI interface. If you 
attempt to boot with either of these operating systems in AHCI 
mode without the required device driver, the system will crash 
(blue screen). 

SATA 0 and 2
Allows you to enable or disable DOS and boot accesses to the 
Primary channel of the first SATA controller. This feature only applies 
when SATA emulation = IDE.

✎ Advanced operating systems like Windows may reenable the 
channel.

SATA 1 and 3
Allows you to enable or disable DOS and boot accesses to the 
Secondary channel of the first SATA controller. This feature only 
applies when SATA emulation = IDE.

✎ Advanced operating systems like Windows may reenable the 
channel.

✎
DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of 

performing the Drive Protection System (DPS) self-tests.

✎ This selection will only appear when at least one drive capable of 
performing the DPS self-tests is attached to the system.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Storage 
(continued)

Boot Order Allows you to:
• Specify the order in which attached devices (such as a USB 

flash media device, diskette drive, hard drive, optical drive, or 
network interface card) are checked for a bootable operating 
system image. Each device on the list may be individually 
excluded from or included for consideration as a bootable 
operating system source.

• Specify the order of attached hard drives. The first hard drive in 
the order will have priority in the boot sequence and will be 
recognized as drive C (if any devices are attached).

✎ MS-DOS drive lettering assignments may not apply after a 
non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device 
specified in Boot Order, restart the computer and press F9 when the 
monitor light turns green. After POST is completed, a list of bootable 
devices is displayed. Use the arrow keys to select the preferred 
bootable device and press Enter. The computer then boots from the 
selected non-default device for this one time.

Security Smart Card 
Options (some 
models)

Allows you to enable/disable the Smart Card to be used in place of 
the Power-On Password. This option only appears if a Smart Card 
reader is attached to the system.

Setup Password Allows you to set and enables setup (administrator) password. 

✎ If the setup password is set, it is required to change Computer 
Setup options, flash the ROM, and make changes to certain plug 
and play settings under Windows.

Power-On 
Password

Allows you to set and enable power-on password. The power-on 
password prompt appears after a power cycle. If the user does not 
enter the correct power-on password, the unit will not boot.

✎ This password does not appear on warn boots, such as 
CTRL+ALT+DEL or Restart from Windows, unless enabled 
in Password Options, below.

Password Options 
(This selection will 
appear only if a 
power-on 
password or setup 
password is set.)

Allows you to:
• Lock legacy resources (appears if a setup password is set)
• Enable/disable network server mode (appears if a power-on 

password is set)
• Specify whether the password is required for warm boot 

(CTRL+ALT+DEL) (appears if a power-on password is set)
• Enable/Disable Setup Browse Mode (appears if a setup 

password is set) (allows viewing, but not changing, the F10 
Setup Options without entering setup password)

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Security 
(continued)

Smart Cover 
(some models)

Allows you to:
• Lock/unlock the Cover Lock.
• Set the Cover Removal Sensor to Disable/Notify User/Setup 

Password.

✎ Notify User alerts the user that the sensor has detected that the 
cover has been removed. Setup Password requires that the setup 
password be entered to boot the computer if the sensor detects 
that the cover has been removed.

Embedded 
Security (This menu 
only appears after 
the Embedded 
Security Device is 
made available 
under Device 
Security)

Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.
• Enable/disable power-on authentication support (some 

models).
• Reset authentication credentials (some models).

This feature is supported on some models only. 

Device Security Enables/disables serial ports, parallel port, all USB ports, system 
audio, network controllers (some models), SMBus controller (some 
models), and embedded security device (some models).

Network Service 
Boot

Enables/disables the computer’s ability to boot from an operating 
system installed on a network server. (Feature available on NIC 
models only; the network controller must reside on the PCI bus or be 
embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST).
• Chassis serial number or Universal Unique Identifier (UUID) 

number. The UUID can only be updated if the current chassis 
serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)

• Keyboard locale setting (for example, English or German) for 
System ID entry.

DriveLock Security Allows you to assign or modify a master or user password for hard 
drives. When this feature is enabled, the user is prompted to 
provide one of the DriveLock passwords during POST. If neither is 
successfully entered, the hard drive will remain inaccessible until 
one of the passwords is successfully provided during a subsequent 
cold-boot sequence.

✎ This selection will only appear when at least one drive that 
supports the DriveLock feature is attached to the system.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Security
(continued)

OS Security ✎ This selection is in effect only if the processor and operating 
system being used comprehend and utilize this feature.

• Data Execution Prevention (some models) (enable/disable). 
Helps prevent OS security breaches.

• Intel Virtualization Technology (some models) (enable/disable). 
Changing this setting requires turning the computer off and then 
back on.

Power OS Power 
Management

• Runtime Power Management - Enable/Disable. Allows certain 
operating systems to reduce processor voltage and frequency 
when the current software load does not require the full 
capabilities of the processor. 

• Idle Power Savings - Extended/Normal. Allows certain 
operating systems to decrease the processors power 
consumption when the processor is idle. 

• ACPI S3 Hard Disk Reset - Enabling this causes the BIOS to 
ensure hard disks are ready to accept commands after 
resuming from S3 before returning control to the operating 
system.

• ACPI S3 PS2 Mouse Wakeup - Enables or disables waking from 
S3 due to PS2 mouse activity.

• USB Wake on Device Insertion - Allows system to wake from 
Standby on USB device insertion.

Hardware Power 
Management

SATA power management enables or disables SATA bus and/or 
device power management.

Thermal Fan idle mode - This bar graph controls the minimum permitted fan 
speed.

✎ This setting only changes the minimum fan speed. The fans are 
still automatically controlled.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced*
*For 
advanced 
users only

Power-On Options Allows you to set:
• POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
• POST messages (enable/disable).
• MEBx Setup Prompt (enable/disable or hidden/displayed). 

Enabling this feature displays the text CTRL+P=MEBx during 
POST. Disabling this feature prevents the text from being 
displayed. However, pressing CTRL+P still accesses the ME 
BIOS Extension Setup Utility, which is used to configure 
manageability settings.

• F9 prompt (enable/disable or hidden/displayed). Enabling 
this feature will display the text F9=Boot Menu during POST. 
Disabling this feature prevents the text from being displayed but 
pressing F9 will still access the Shortcut Boot (Order) Menu 
screen. See Storage > Boot Order for more information. 

• F10 prompt (enable/disable or hidden/displayed). Enabling 
this feature will display the text F10=Setup during POST. 
Disabling this feature prevents the text from being displayed but 
pressing F10 will still access the Setup screen.

• F12 prompt (enable/disable or hidden/displayed). Enabling 
this feature will display the text F12=Network Service Boot 
during POST. Disabling this feature prevents the text from being 
displayed but pressing F12 will still force the system to attempt 
booting from the network.

• Option ROM prompt (enable/disable). Enabling this feature 
will cause the system to display a message before loading 
options ROMs. (This feature is supported on some models only.)

• Remote wakeup boot source (remote server/local hard drive).
• After Power Loss (off/on/previous state): Set this option to ON:

•Off - causes the computer to remain powered off when power 
is restored.

•On - causes the computer to power on automatically as soon 
as power is restored.

•On - allows you to power on the computer using a power strip 
switch, if the computer is connected to an electric power strip.

•Previous state - causes the computer to power on automatically 
as soon as power is restored, if it was on when power was 
lost.

✎ If you turn off power to your computer using the switch on a 
power strip, you will not be able to use the suspend/sleep feature 
or the Remote Management features.

• POST Delay (None, 5, 10, 15, or 20 seconds) 
(enable/disable). Enabling this feature will add a user-specified 
delay to the POST process. This delay is sometimes needed for 
hard disks on some PCI cards that spin up very slowly; so slowly 
that they are not ready to boot by the time POST is finished. The 
POST delay also gives you more time to press F10 to enter 
Computer (F10) Setup.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced*
(continued)
*For 
advanced 
users only

Power-On Options
(continued)

Allows you to set: (continued)
• I/O APIC Mode (enable/disable). Enabling this feature will 

allow Microsoft Windows Operating Systems to run optimally. 
This feature must be disabled for certain non-Microsoft 
Operating Systems to work properly.

• Hyper-threading (enable/disable)
• Limit CPUID Maximum Value to 3 - Restricts the number of 

CPUID functions reported by the microprocessor. Enable this 
feature if booting to WinNT.

Execute Memory 
Test (some models)

Restarts the computer and executes the POST memory test.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you 
specify.

Onboard Devices Allows you to set resources for or disable onboard system devices 
(diskette controller, serial port, or parallel port).

PCI Devices • Lists currently installed PCI devices and their IRQ settings. 
• Allows you to reconfigure IRQ settings for these devices or to 

disable them entirely. These settings have no effect under an 
APIC-based operating system.

PCI VGA 
Configuration

Displayed only if there are multiple PCI video adapters in the 
system. Allows you to specify which VGA controller will be the 
“boot” or primary VGA controller.

✎ In order to see this entry, you must enable integrated video 
(Advanced > Device Options) and Save Changes and 
Exit.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced*
(continued)
*For 
advanced 
users only

Bus Options* On some models, allows you to enable or disable:
• PCI SERR# Generation.
• PCI VGA palette snooping, which sets the VGA palette 

snooping bit in PCI configuration space; only needed when 
more than one graphics controller is installed.

Device Options Allows you to set: 
• Printer mode (Bi-Directional, EPP & ECP, Output Only).
• Num Lock state at power-on (off/on).
• S5 Wake on LAN (enable/disable).

• To disable Wake on LAN during the off state (S5), use the arrow 
(left and right) keys to select the Advanced > Device Options 
menu and set the S5 Wake on LAN feature to “Disable.” This 
obtains the lowest power consumption available on the computer 
during S5. It does not affect the ability of the computer to Wake on 
LAN from suspend or hibernation, but will prevent it from waking 
from S5 via the network. It does not affect operation of the network 
connection while the computer is on.

• If a network connection is not required, completely disable the 
network controller (NIC) by using the arrow (left and right) keys to 
select the Security > Device Security menu. Set the Network 
Controller option to “Device Hidden.” This prevents the network 
controller from being used by the operating system and reduces the 
power used by the computer in S5.

• Processor cache (enable/disable).
• Unique Sleep State Blink Patterns. Allows you to choose an LED 

blink pattern that uniquely identifies each sleep state.
•3 blinks followed by 2-sec. pause = S3
•4 blinks followed by 2-sec. pause = S4

• Integrated Video (enable/disable) Allows you to use integrated 
video and PCI Up Solution video at the same time (available on 
some models only).

✎ After Integrated Video is enabled and changes saved, a new 
menu item appears under Advanced to allow you to select the 
primary VGA controller video device.
Inserting a PCI or PCI Express video card automatically disables 
Integrated Video. When PCI Express video is on, Integrated 
Video must remain disabled.

• Internal speaker (some models) (does not affect external 
speakers)

• Monitor Tracking (enable/disable). Allows BIOS to save 
monitor asset information.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.2.3 Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command 
with the Computer Setup (F10) Utility before Restore is needed.

✎ It is recommended that you save any modified computer configuration settings to a diskette, a 
USB flash media device, or a diskette-like device (a storage device set to emulate a diskette 
drive) and save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media 
emulating a diskette with the saved configuration and perform the Restore from Removable 
Media command with the Computer Setup (F10) Utility.

2.3 HP Insight Diagnostics

✎ HP Insight Diagnostics is included on the Documentation and Diagnostics CD with some 
computer models only.

The HP Insight Diagnostics utility allows you to view information about the hardware 
configuration of the computer and perform hardware diagnostic tests on the subsystems of the 
computer. The utility simplifies the process of effectively identifying, diagnosing, and isolating 
hardware issues.

The Survey tab is displayed when you invoke HP Insight Diagnostics. This tab shows the current 
configuration of the computer. From the Survey tab, there is access to several categories of 
information about the computer. Other tabs provide additional information, including diagnostic 
test options and test results. The information in each screen of the utility can be saved as an html 
file and stored on a diskette or USB HP Drive Key.

Use HP Insight Diagnostics to determine if all the devices installed on the computer are 
recognized by the system and functioning properly. Running tests is optional but recommended 
after installing or connecting a new device.

You should run tests, save the test results, and print them for reference. 

✎ Third party devices may not be detected by HP Insight Diagnostics.

Advanced*
(continued)
*For 
advanced 
users only

Device option
(continued)

• NIC PXE Option ROM Download (enable/disable). The BIOS 
contains an embedded NIC option ROM to allow the unit to 
boot through the network to a PXE server. This is typically used 
to download a corporate image to a hard drive. The NIC 
option ROM takes up memory space below 1MB commonly 
referred to as DOS Compatibility Hole (DCH) space. This space 
is limited. This F10 option will allow users to disable the 
downloading of this embedded NIC option ROM thus giving 
more DCH space for additional PCI cards which may need 
option ROM space. The default will be to have the NIC option 
ROM enabled.

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.3.1 Accessing HP Insight Diagnostics
You must boot to the Documentation and Diagnostics CD, as described in the steps below, to 
access HP Insight Diagnostics.

1. While the computer is on, insert the Documentation and Diagnostics CD into an optical drive 
on the computer.

2. Shut down the operating system and turn off the computer.

3. Turn on the computer. The system will boot to the CD.

✎ If the system does not boot to the CD in the optical drive, you may need to change the boot order 
in the Computer Setup (F10) utility so that the system attempts to boot to the optical drive before 
booting to the hard drive. Refer to the Computer Setup (F10) Utility Guide on the Documentation 
and Diagnostics CD for more information.

4. When prompted, press the y key if you want to operate in Safe mode or any other key if you 
want to operate in Regular mode.

✎ Regular mode is the default mode if no keys are pressed within the specified time frame. If the 
screen remains blank after pressing any key other than y, try rebooting and select safe mode 
when prompted.

5. Select the appropriate language and click Continue.

✎ It is recommended that you accept the assigned default keyboard for your language unless you 
want to test your specific keyboard.

6. In the End User License Agreement page, click Agree if you agree with the terms. The HP 
Insight Diagnostics utility launches with the Survey tab displayed.

2.3.2 Survey Tab
The Survey tab displays important system configuration information. In the View section on the 
left side of the screen, you can select the Summary view to see limited configuration data or 
select the Advanced view to see all the data in the selected category. Regardless of whether you 
choose Advanced or Summary, the following categories of information are available on the 
Survey tab:

All—Gives a listing of all categories of information about the computer.

Overview—Gives you a listing of general information about the computer.

Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows asset tag, system serial number, and processor information.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port 
settings, plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices 
connected to the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on 
the system board and any memory modules installed.
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Miscellaneous—Shows information obtained from the computer configuration memory 
(CMOS), system management BIOS data, system board data, and diagnostics component 
information.

Storage—Shows information about storage media connected to the computer. This list includes 
all fixed disks, diskette drives, and optical drives.

System—Shows information about the system board, processor, chassis, and BIOS, plus internal 
speaker and PCI bus information.

2.3.3 Test Tab
The Test tab allows you to choose various parts of the system to test. You can also choose the 
type of test and testing mode.

There are three types of tests to choose from:

■ Quick Test—Provides a predetermined script where a sample of each hardware component 
is exercised and requires no user intervention in either Unattended or Interactive mode.

■ Complete Test—Provides a predetermined script where each hardware component is fully 
tested. There are more tests available in the Interactive mode, but these require user 
intervention.

■ Custom Test—Provides the most flexibility in controlling the testing of a system. The 
Custom Test mode allows you to specifically select which devices, tests, and test parameters 
are run.

There are two test modes to choose from:

■ Interactive Mode—Provides maximum control over the testing process. The diagnostic 
software will prompt you for input during tests that require your interaction.You may also 
determine whether the test passed or failed.

■ Unattended Mode—Does not display prompts and requires no interaction. If errors are 
found, they are displayed when testing is complete.

To begin testing:

1. Select the Test tab.

2. Select the tab for the type of test to be run: Quick, Complete, or Custom.

3. Select the Test Mode: Interactive or Unattended.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time. 
When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you desire to have the diagnostic test for a specified time period, enter the amount 
of time in minutes.

5. If performing a Quick Test or Complete Test, select the device to be tested from the 
drop-down list. If performing a Custom Test, click the Expand button and select the devices 
to be tested or click the Check All button to select all devices.

6. Click Begin Testing to start the test. The Status tab, which allows you to monitor the 
progress of the test, is automatically displayed during the testing process. When the test is 
complete, the Status tab shows whether the device passed or failed.

7. If errors are found, go to the Log tab and click the Error Log to display more detailed 
information and recommended actions.
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2.3.4 Status Tab
The Status tab displays the status of the selected tests. The type of test executed (Quick, 
Complete, or Custom) is also displayed. The main progress bar displays the percent complete of 
the current set of tests. While testing is in progress, a Cancel Testing button is displayed for use 
if you want to cancel the test.

After testing has completed, the Cancel Testing button is replaced with a Retest button. The 
Retest button will retest the last set of tests executed. This enables you to re-run the set of tests 
without having to re-enter the data in the Test tab.

The Status tab also shows:

■ The devices being tested

■ The test status (running, passed, or fail) of each device being tested 

■ The overall test progress of all devices being tested

■ The test progress for each device being tested

■ The elapsed test times for each device being tested

2.3.5 Log Tab
The Log tab contains a Test Log and an Error Log tab. 

The Test Log displays all tests that have been executed, the number of times of execution, the 
number of times failed, and the time it took to complete each test. The Clear Test Log button 
will clear the contents of the Test Log.

The Error Log displays the tests for devices that have failed during the diagnostic testing and 
includes the following columns of information. 

■ The Device section displays the device tested.

■ The Test section displays the type of test run.

■ The Description section describes the error that the diagnostic test found. 

■ The Recommended Repair will give a recommended action that should be performed to 
resolve the failed hardware. 

■ The Failed Count is the number of times the test has failed.

■ The Error Code provides a numerical code for the failure. The error codes are defined in the 
Help tab.

■ The Clear Error Log button will clear the contents of the Error Log.

2.3.6 Help Tab
The Help tab contains an HP Insight Diagnostics tab, an Error Codes tab, and a Test 
Components tab.

The HP Insight Diagnostics tab contains help topics and includes search and index features.

The Error Codes tab provides a description of each numerical error code that may appear in the 
Error Log tab located on the Log tab. Each code has a corresponding error Message and a 
Recommended Repair action that should help solve the problem. To find an error code 
description quickly, enter the code in the box at the top of the tab and click the Find Error 
Codes button.

The Test Components tab displays low level information on tests that are run.
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2.3.7 Saving and Printing Information in HP Insight Diagnostics
You can save the information displayed in the HP Insight Diagnostics Status and Log tabs to a 
diskette or a USB 2.0 HP Drive Key (64MB or higher). You can not save to the hard drive. The 
system will automatically create an html file that has the same appearance as the information 
displayed on the screen.

1. Insert a diskette or USB 2.0 HP Drive Key (capacity must be 64MB or higher). USB 1.0 
Drive Keys are not supported.

2. Click Save in the bottom right corner of the tab.

3. Select Save to the floppy or Save to USB key.

4. Enter a file name in the File Name box and click the Save button. An html file will be saved 
to the inserted diskette or USB HP Drive Key.

✎ Do not remove the diskette or Drive Key until you see a message indicating that the total file has 
been written to the media.

5. Print the information from the storage device used to save it.

✎ To exit HP Insight Diagnostics, click the Exit Diagnostics button in the bottom left corner of the 
screen then remove the Documentation and Diagnostics CD from the optical drive.

2.3.8 Downloading the Latest Version of HP Insight Diagnostics
1. Go to www.hp.com.

2. Click the Software and Download driver link.

3. Enter the product number (for example, dc7700) in the text box and press the Enter key.

4. Select the specific product.

5. Select the OS.

6. Click the Diagnostics link.

7. Select HP Insight Diagnostics Offline Edition.

8. Select the proper language and click Download.

✎ The download includes instructions on how to create the bootable CD.
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3
Desktop Management

HP Client Management Solutions provides standards-based solutions for managing and 
controlling desktops, workstations, and notebook PCs in a networked environment. 

The key capabilities and features of desktop management are:

■ Initial configuration and deployment

■ Remote system installation

■ Software updating and management

■ ROM flash

■ Asset tracking and security

■ Fault notification and recovery

✎ Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment
HP computers come with a preinstalled system software image. After a brief software 
“unbundling” process, the computer is ready to be used.

A customized software image may be deployed by: 

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as HP OpenView Client Configuration Manager, HP 
OpenView PC Configuration Management Solutions, or Altiris Deployment Solution, to 
replace the preinstalled software with a customized software image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and 
processes. The PC Deployment section of the HP Lifecycle Solutions Web site 
(http://h20219.www2.hp.com/services/cache/80906-0-0-225-121.html) provides information to 
help you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with 
recovery of system software, configuration management and troubleshooting, and power 
management.
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3.1.1 HP OpenView Agent
The Radia Management Agent (RMA) used by both HP OpenView Client Configuration 
Manager and HP OpenView PC Configuration Management Solutions (Radia) is pre-loaded on 
the computer. When installed, it enables communication with the HP OpenView management 
console.

To install the Radia Management Agent:

1. Click Start.

2. Click All Programs.

3. Click HP Manageability.

4. Click Radia Management Agent Readme.

5. Review and follow the instructions contained in the Readme file to install the Radia 
Management Agent.

3.1.2 Altiris Deployment Solution Agent
This program is pre-loaded on the computer. When installed, it enables communication with the 
administrator Deployment Solution console.

To install Altiris Deployment Solution Agent:

1. Click Start.

2. Click All Programs.

3. Click Software Setup.

4. Click Next.

5. Scroll down and click on the link to install Altiris AClient.

3.1.3 HP Backup and Recovery Manager
HP Backup and Recovery Manager can create the Restore Plus! CD set. This set includes the 
Restore Plus! CD, the Operating system CD, and any Supplemental Software CDs. 

Ä
CAUTION: The Restore Plus! CD set will not include and system settings or user data created after the 
initial system setup.

To create the Restore Plus! CD set:

1. Click Start > HP Backup and Recovery > HP Backup and Recovery Manager to open 
the Backup and Recovery Wizard, then click Next.

2. Select Create factory software recovery CDs or DVDs to recover the system.

3. Follow the instructions in the wizard.

In addition to allowing you to create the Restore Plus! CD set, HP Backup and Recovery 
Manager can be used to back up data and system files to the hard drive, to network drives, or to 
removable media, such as CDs, DVDs, or flash media. If data or system files are lost, deleted, or 
corrupted, Backup and Recovery Manager allows you to retrieve data or restore the last good 
system image.
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3.2 Remote System Installation
Remote System Installation allows you to start and set up your system using the software and 
configuration information located on a network server by initiating the Preboot Execution 
Environment (PXE). The Remote System Installation feature is usually used as a system setup 
and configuration tool, and can be used for the following tasks:

■ Formatting a hard drive.

■ Deploying a software image on one or more new PCs.

■ Remotely updating the system BIOS in flash ROM. See Section 3.4.1, “Remote ROM 
Flash.”

■ Configuring the system BIOS settings.

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot 
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the 
screen to continue the process. The default boot order is a BIOS configuration setting that can be 
changed to always attempt to PXE boot.

3.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops, workstations, and 
notebooks:

■ HP System Software Manager

■ HP Client Manager

■ HP ProtectTools Security Manager

■ HP Client Premium Suite

■ HP Client Foundation Suite

■ HP OpenView Client Configuration Manager

■ HP OpenView PC Configuration Management Solutions 

■ HP Proactive Change Notification

■ HP Subscriber's Choice

3.3.1 HP Client Management Interface
HP Client Management Interface (HP CMI) provides an interface to simplify the integration of 
business computers with popular industry system management tools (including Microsoft 
Systems Management Server, IBM Tivoli Software, and HP OpenView Operations) and custom 
inhouse developed management applications. Using HP CMI, systems management tools and 
applications can request in-depth client inventory, receive health status information, and manage 
system BIOS settings by communicating directly with the client computer, reducing the need for 
agent or connector software to achieve integration.

When HP Client Management Interface is used in conjunction with system management 
software, it can:

■ Request in-depth client inventory information - Capture detailed information about the 
processors, hard drives, memory, BIOS, drivers, and sensor information (such as fan speed, 
voltage, and temperature)
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■ Receive health status information - Subscribe for a wide range of client hardware alerts (such 
as over-temperature, fan stall, and hardware configuration changes) to be sent to the system 
management console, application, or to the local client computer. Alerts are sent real-time 
when triggered by hardware events.

■ Manage system BIOS settings - Perform F10 functions including setting and changing the 
BIOS passwords and computer boot order remotely from the system management console of 
any or all of the client systems without having to visit each machine.

3.3.2 HP System Software Manager
HP System Software Manager (SSM) is a free utility that automates remote deployment of 
device drivers and BIOS updates for networked HP business PCs. When SSM runs, it silently 
(without user interaction) determines the revision levels of drivers and BIOS installed on each 
networked client system and compares this inventory against system software SoftPaqs that have 
been tested and stored in a central file store. SSM then automatically updates any down-revision 
system software on the networked PCs to the later levels available in the file store. Since SSM 
only allows distribution of SoftPaq updates to the correct client system models, administrators 
can confidently and efficiently use SSM to keep system software updated.

System Software Manager integrates with enterprise software distribution tools such as 
Microsoft Systems Management Server (SMS). Using SSM, you can distribute customer-created 
or third-party updates that have been packaged in the SSM-format.

SSM may be downloaded at no charge by visiting www.hp.com/go/ssm.

3.3.3 HP Client Manager
HP Client Manager, developed with Altiris, is available free for supported HP business desktop, 
notebook, and workstation models. SSM is integrated into HP Client Manager and enables 
central tracking, monitoring, and management of the hardware aspects of HP client systems.

Use HP Client Manager to:

■ Get valuable hardware information such as CPU, memory, video, and security settings

■ Monitor system health to fix problems before they occur

■ Automatically acquire and install drivers and BIOS updates without visiting each PC

■ Remotely configure BIOS and security settings

■ Automate processes to quickly resolve hardware problems

Tight integration with HP Instant Support tools reduces hardware troubleshooting time.

■ Diagnostics—remotely run & view reports on HP desktop, notebook, and workstation 
models

■ System Health Scan—check for known hardware issues in your installed base of HP client 
systems

■ Active Chat—connect to HP customer support to resolve issues

■ HP Knowledgebase—link to expert information

■ Automated SoftPaq collection and delivery process for fast resolution of hardware problems

■ Identify, inventory, and initialize systems with HP ProtectTools embedded security chip

■ Option for health alerts to display locally on the client system
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■ Report basic inventory information for non-HP clients

For more information on HP Client Manager, visit www.hp.com/go/clientmanager.

3.3.4 HP ProtectTools Security Manager
ProtectTools Security Manager software provides security features that help protect against 
unauthorized access to the computer, networks, and critical data. Enhanced security functionality 
is provided by the following modules:

■ Smart Card Security for ProtectTools

■ Embedded Security for ProtectTools

■ BIOS Configuration for ProtectTools

■ Credential Manager for ProtectTools

The modules available for your computer may vary depending on your model. For example, 
Embedded Security for ProtectTools requires that the Trusted Platform Module (TPM) 
embedded security chip (some models only) be installed on your computer, and Smart Card 
Security for ProtectTools requires an optional smart card and reader.

ProtectTools modules may be preinstalled, preloaded, or available for purchase from the HP Web 
site. Visit http://www.hp.com/products/security for more information.

3.3.5 HP Client Premium Suite
HP Client Premium Suite (HP CPS) is designed for organizations wanting full client hardware 
and software lifecycle management from a single, Web-based management console. It combines:

■ HP Client Manager

■ HP Systems Insight Manager Connector

■ HP OpenView Connector

■ Altiris Client Management Suite - Level 1

■ Altiris Connector Solution

■ Altiris Local Recovery Pro

■ Altiris AuditExpress

For more information on HP Client Management Premium Suite, visit 
http://www.hp.com/go/easydeploy.

3.3.6 HP Client Foundation Suite
The HP Client Foundation Suite (HP CFS) is designed for organizations wanting essential client 
management functionality. It combines:

■ HP Client Manager

■ HP Systems Insight Manager Connector

■ Altiris Migration Suite

■ Altiris Local Recovery Pro

For more information about the HP Client Foundation Suite, visit 
http://www.hp.com/go/easydeploy.



3–6 433612-001 Service Reference Guide, dc7700

Desktop Management

3.3.7 HP OpenView Client Configuration Manager
HP OpenView Client Configuration Manager is a simplified, out-of-the-box, and easy-to-use 
solution that solves immediate PC software configuration management needs.

■ Integrated software management

❏ Inventory collection

❏ Operating system deployment and settings migration

❏ Patch management

❏ Software distribution

❏ Software usage metering

■ Integrated hardware management

❏ Remote control

❏ HP alert monitoring

❏ HP hardware driver and BIOS updates

❏ Integration with HP ProtectTools

❏ Free add-on support for Intel Active Management Technology (AMT)

❏ Free version for basic hardware management of HP desktops and notebooks, and 
software and hardware management for HP Thin Clients.

For more information about the HP OpenView Client Configuration Manager, visit 
http://www.managementsoftware.hp.com/products/ccm/index.html.

3.3.8 HP OpenView PC Configuration Management Solutions
HP OpenView Configuration Management solutions automate the management of software such 
as operating systems, applications, patches, content, and configuration settings to ensure that 
each computing device is maintained in the right configuration.

Proven across enterprises of every size and complexity, HP’s adaptive, policy-based model for 
software Configuration Management, automates the entire software lifecycle management 
process - from discovery, deployment, and ongoing management through to migration and 
retirement.

By substituting automation for manual intervention, HP helps its customers lower costs, 
significantly reduce software related problems, and ensure the software supporting their business 
operations is reliable and secure.

For more information on HP OpenView PC Configuration Management Solution, visit 
http://h20229.www2.hp.com/solutions/ascm/index.html.
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3.3.9 Intel vPro-branded PCs with Active Management 
Technology

Intel Active Management Technology (AMT) allows better discovery, healing, and protection of 
networked computing assets. With AMT, PCs can be managed whether the system is on, off, or 
the operating system is hung.

Intel vPro features include:

■ Hardware inventory information

■ Alerting

■ Power management—power on/off, cycle power

■ Remote diagnosis and repair

❏ Serial-over-LAN—allows console control of remote PC

❏ IDE-Redirect—allows system booting from a remote boot drive, disk, or ISO image

■ Hardware-based isolation and recovery—limit or cut off PC network access, if virus-like 
activity is detected

✎ For an overview of Intel vPro technology, visit http://www.intel.com/vpro.

For HP-specific information on Intel vPro technology, see the white papers at 
http://www.hp.com/support. Select your country and language, select See support and 
troubleshooting information, enter the model number of the computer, and press Enter. In 
the Resources category, click Manuals (guides, supplements, addendums, etc). Under 
Quick jump to manuals by category, click White papers.

On Intel vPro-branded PCs, available management technologies include the following:

■ AMT

■ ASF

■ Virtualization Technology (VT)

ASF and AMT may not be configured at the same time, but both are supported.

To configure Intel vPro systems for AMT or ASF:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down 
> Restart.

2. As soon as the computer is turned on, press the hot key, Ctrl+P, when the monitor light turns 
green.

✎ NOTE If you do not press Ctrl+P at the appropriate time, you must restart the computer and 
again press Ctrl+P when the monitor light turns green to access the utility.
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This hot-key enters the Intel Management Engine BIOS Execution (ME Bx) setup utility. This 
utility allows the user to configure various aspects of the management technology. Configuration 
options include:

■ ME Platform Configuration

❏ ME Platform State Control—enable/disable management engine

❏ ME Firmware Local Update—local enable/disable management of firmware updates

❏ LAN Controller—enable/disable integrated network controller

❏ ME Features Control—enable AMT, ASF, or none

❏ ME Power Control—configure management engine power policies

■ Intel AMT Configuration

❏ Change AMT Password—required in order to configure AMT (the default password is 
admin)

❏ Host Name—allows administrator to assign a name to the client

❏ TCP/IP—allows administrator to assign an IP address or enable DHCP

❏ Provisioning Server—allows administrator to assign IP address of provisioning server

❏ Provision Model—allows administrator to configure either enterprise or SMB mode

❏ Set PID and PPS—allows administrator to provide pre-provisioning key (see HP’s white 
paper, Intel vPro Provisioning)

❏ Un-Provision—allows administrator to reset AMT configuration to factory defaults

❏ VLAN—allows administrator to enable LAN virtualization support

❏ SOL/IDE-R—allows administrator to enable remote boot and control sessions

■ Change MEBx Password (HP highly recommends that this password be changed. The 
default password is admin.)

In order to remotely manage AMT systems, the administrator must use a remote console that 
supports AMT. Enterprise management consoles are available from suppliers such as HP 
OpenView, Altiris and Microsoft SMS. In SMB mode, the client provides a Web browser 
interface. To access this feature, open a browser from any other system on the network and enter 
http://host_name:16992 where host_name is the name assigned to the system. 
Alternatively, the IP address may be used in place of the host name.

3.3.10 Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site in order to 
proactively and automatically:

■ Send you Proactive Change Notification (PCN) e-mails informing you of hardware and 
software changes to most commercial computers and servers, up to 60 days in advance

■ Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, 
Security Bulletins, and Driver alerts for most commercial computers and servers

You create your own profile to ensure that you only receive the information relevant to a specific 
IT environment. To learn more about the Proactive Change Notification program and create a 
custom profile, visit http://h30046.www3.hp.com/subhub.php.
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3.3.11 Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP.

Based on your profile, HP will supply you with personalized product tips, feature articles, and/or 
driver and support alerts/notifications.

Subscriber’s Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you 
that the information you subscribed to in your profile is available for review and retrieval. To 
learn more about Subscriber’s Choice and create a custom profile, visit
http://h30046.www3.hp.com/subhub.php.

3.3.12 Retired Solutions
Two software packages, Altiris Local Recovery, and Dantz Retrospect, will no longer be 
shipping on HP business desktops, notebooks, or workstations. Starting with new business 
desktops, notebooks, and workstations released in 2006, all will ship with HP Backup and 
Recovery Manager.

3.4 ROM Flash
The computer's BIOS is stored in a programmable flash ROM (read only memory). By 
establishing a setup password in the Computer Setup (F10) Utility, you can protect the ROM 
from being unintentionally updated or overwritten. This is important to ensure the operating 
integrity of the computer. Should you need or want to upgrade the BIOS, you may download the 
latest BIOS images from the HP driver and support page: 
http:\\h18000.www1.hp.com/support/files.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set 
the setup password on one or more PCs simultaneously. For more information, visit
http://www.hp.com/go/ssm.

3.4.1 Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
computers directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely on multiple computers results in a consistent 
deployment of, and greater control over, HP PC BIOS images over the network. It also results in 
greater productivity and lower total cost of ownership.

✎ The computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager or System 
Software Manager at http://h18000.www1.hp.com/im/prodinfo.html.
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3.4.2 HPQFlash
The HPQFlash utility is used to locally update or restore the system BIOS on individual PCs 
through a Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the product 
name/number of the computer when prompted.

3.4.3 Boot Block Emergency Recovery Mode
Boot Block Emergency Recovery Mode permits system recovery in the unlikely event of a ROM 
flash failure. For example, if a power failure were to occur during a BIOS upgrade, the ROM 
flash would be incomplete. This would render the system BIOS unusable. The Boot Block is a 
flash-protected section of the ROM that contains code that checks for a valid system BIOS image 
when the system is turned on.

■ If the system BIOS image is valid, the system starts normally.

■ If the system BIOS image is not valid, a failsafe Boot Block BIOS provides enough 
support to search removable media for BIOS image files. If an appropriate BIOS image file 
is found, it is automatically flashed into the ROM.

When an invalid system BIOS image is detected, the system power LED will blink red 8 times, 
one blink every second. Simultaneously, the speaker will beep 8 times. If the portion of the 
system ROM containing the video option ROM image is not corrupt, “Boot Block Emergency 
Recovery Mode” will be displayed on the screen.

To recover the system after it enters Boot Block Emergency Recovery Mode, complete the 
following steps:

1. Turn off the power.

2. Insert a diskette, CD, or USB flash device containing the desired BIOS image file in the root 
directory.

✎ Note: The media must be formatted using the FAT12, FAT16, or FAT32 file system.

3. Turn on the computer.

If the system successfully reprograms the ROM, the system will automatically power off.

4. Remove the removable media used to upgrade the BIOS.

5. Turn the power on to restart the computer.
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3.4.4 Replicating the Setup
The following procedures give an administrator the ability to easily copy one setup configuration 
to other computers of the same model. This allows for faster, more consistent configuration of 
multiple computers. 

✎ Both procedures require a diskette drive or a supported USB flash media device, such as an HP 
Drive Key.

Copying to Single Computer

Ä
CAUTION: A setup configuration is model-specific. File system corruption may result if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7nnn PC 
to a dx7nnn PC.

1. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

2. If you are using a USB flash media device, insert it now.

3. Turn on the computer.

4. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

5. If you are using a a diskette, insert it now.

6. Select File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.

7. Turn off the computer to be configured and insert the configuration diskette or USB flash 
media device.

8. Turn on the computer to be configured.

9. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

10. Select File > Replicated Setup > Restore from Removable Media, and follow the 
instructions on the screen.

11. Restart the computer when the configuration is complete.
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Copying to Multiple Computers

Ä
CAUTION: A setup configuration is model-specific. File system corruption may result if source and target 
computers are not the same model. For example, do not copy the setup configuration from a dc7nnn PC 
to a dx7nnn PC.

This method takes a little longer to prepare the configuration diskette or USB flash media device, 
but copying the configuration to target computers is significantly faster.

✎ A bootable diskette is required for this procedure or to create a bootable USB flash media device. 
If Windows XP is not available to use to create a bootable diskette, use the method for copying to 
a single computer instead (see “Copying to Single Computer”).

1. Create a bootable diskette or USB flash media device. See “Supported USB Flash Media 
Device” or “Unsupported USB Flash Media Device.”

Ä
CAUTION: Not all computers can be booted from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be booted 
from a USB flash media device. Otherwise, a bootable diskette must be used.

2. Select a setup configuration to copy. Turn off the computer. If you are in Windows, click 
Start > Shut Down > Shut Down.

3. If you are using a USB flash media device, insert it now.

4. Turn on the computer.

5. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

6. If you are using a diskette, insert it now.

7. Select File > Replicated Setup > Save to Removable Media. Follow the instructions on the 
screen to create the configuration diskette or USB flash media device.

8. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration 
diskette or USB flash media device. To obtain this utility, go to http://www.hp.com, click 
Software and Driver Downloads, and enter the model number of the computer.

9. On the configuration diskette or USB flash media device, create an autoexec.bat file 
containing the following command:

repset.exe
10. Turn off the computer to be configured. Insert the configuration diskette or USB flash media 

device and turn the computer on. The configuration utility will run automatically.

11. Restart the computer when the configuration is complete.
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Creating a Bootable Device

Supported USB Flash Media Device

Supported devices have a preinstalled image to simplify the process of making them bootable. 
All HP or Compaq and most other USB flash media devices have this preinstalled image. If the 
USB flash media device being used does not have this image, use the procedure later in this 
section (see “Unsupported USB Flash Media Device”).

To create a bootable USB flash media device, you must have:

■ A supported USB flash media device.

■ A bootable DOS diskette with the FDISK and SYS programs. (If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.)

■ A PC that is bootable from a USB flash media device.

Ä
CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot 
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be 
booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1. Turn off the computer.

2. Insert the USB flash media device into one of the computer’s USB ports and remove all other 
USB storage devices except USB diskette drives.

3. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

4. Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click Yes 
(Y) to enable large disk support.

5. Enter Choice [5] to display the drives in the system. The USB flash media device will be the 
drive that closely matches the size of one of the drives listed. It will usually be the last drive 
in the list. Note the letter of the drive.

USB flash media device drive: __________

Ä
CAUTION:   If a drive does not match the USB flash media device, do not proceed. Data loss can occur. 
Check all USB ports for additional storage devices. If any are found, remove them, reboot the computer, 
and proceed from step 4. If none are found, either the system does not support the USB flash media 
device or the USB flash media device is defective. DO NOT proceed in attempting to make the USB flash 
media device bootable.

6. Exit FDISK by pressing the Esc key to return to the A:\ prompt.

7. If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

8. At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

Ä
CAUTION:   Be sure that you have entered the correct drive letter for the USB flash media device.

After the system files have been transferred, SYS will return to the A:\ prompt. Go to 
step 13.

9. Copy any files you want to keep from your USB flash media device to a temporary directory 
on another drive (for example, the system's internal hard drive).
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10. At the A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

Ä
CAUTION:  Be sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more warnings and ask you each time whether you want to 
proceed. Enter Y each time. FORMAT will format the USB flash media device, add the 
system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Copy any files you saved in step 9 back to your USB flash media device.

13. Remove the diskette and reboot the computer. The computer will boot to the USB flash 
media device as drive C.

✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers.”

Unsupported USB Flash Media Device

To create a bootable USB flash media device, you must have:

■ USB flash media device.

■ Bootable DOS diskette with the FDISK and SYS programs. (If SYS is not available, 
FORMAT may be used, but all existing files on the USB flash media device will be lost.)

■ PC that is bootable from a USB flash media device.

Ä
CAUTION: Some older PCs may not be bootable from a USB flash media device. If the default boot 
order in the Computer Setup (F10) Utility lists the USB device before the hard drive, the computer can be 
booted from a USB flash media device. Otherwise, a bootable diskette must be used.

1. If there are any PCI cards in the system that have SCSI, ATA RAID, or SATA drives 
attached, turn off the computer and unplug the power cord.

Ä
CAUTION: The power cord MUST be unplugged.

2. Open the computer and remove the PCI cards.

3. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives. Close the computer cover.

4. Plug in the power cord and turn on the computer.

5. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.
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6. Go to Advanced > PCI Devices to disable both the PATA and SATA controllers. When 
disabling the SATA controller, note the IRQ to which the controller is assigned. You will 
need to reassign the IRQ later. Exit setup, confirming the changes.

SATA IRQ: __________

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new 
partition and mark it active. Exit FDISK by pressing the Esc key.

9. If the system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to 
reboot to the DOS diskette.

10. At the A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash 
media device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI 
cards that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Advanced > PCI Devices and re-enable the PATA and SATA controllers that were 
disabled in step 6. Put the SATA controller on its original IRQ.

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

✎ The default boot order varies from computer to computer, and it can be changed in the Computer 
Setup (F10) Utility. Refer to the Computer Setup (F10) Utility Guide on the Documentation and 
Diagnostics CD for instructions.

If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Return to “Copying to Multiple Computers.”

3.4.5 Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled, the power button can 
function either as an on/off switch or as a standby button. The stand-by feature does not 
completely turn off power, but instead causes the computer to enter a low-power standby state. 
This allows you to power down quickly without closing applications and to return quickly to the 
same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Power Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Stand by.
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After configuring the power button to function as a standby button, press the power button to put 
the system in a very low power state (standby). Press the button again to quickly bring the system 
out of standby to full power status. To completely turn off all power to the system, press and hold 
the power button for four seconds.

Ä
CAUTION: Do not use the power button to turn off the computer unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.

3.4.6 HP Web Site Support
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows that is different from the version included with the computer, you must install 
corresponding device drivers and utilities to ensure that all features are supported and 
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support. 

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to 
run the latest Microsoft Windows operating system on the HP computer.

3.4.7 Industry Standards
HP management solutions integrate with other systems management applications, and are based 
on industry standards, such as:

■ Web-Based Enterprise Management (WBEM)

■ Windows Management Interface (WMI)

■ Wake on LAN Technology

■ ACPI

■ SMBIOS

■ Pre-boot Execution (PXE) support

3.5 Asset Tracking and Security
Asset tracking features incorporated into the computer provide key asset tracking data that can be 
managed using HP Systems Insight Manager, HP Client Manager or other system management 
applications. Seamless, automatic integration between asset tracking features and these products 
enables you to choose the management tool that is best suited to the environment and to leverage 
the investment in existing tools. 

HP also offers several solutions for controlling access to valuable components and information. 
HP Embedded Security for ProtectTools, if installed, prevents unauthorized access to data and 
checks system integrity and authenticates third-party users attempting system access. (For more 
information, refer to the HP ProtectTools Security Manager Guide at www.hp.com.) Security 
features such as HP Embedded Security for ProtectTools, the Smart Cover Sensor and the Smart 
Cover Lock, available on some models, help to prevent unauthorized access to the internal 
components of the personal computer. By disabling parallel, serial, or USB ports, or by disabling 
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removable media boot capability, you can protect valuable data assets. Memory Change and 
Smart Cover Sensor alerts can be automatically forwarded to system management applications to 
deliver proactive notification of tampering with a computer’s internal components.

✎ HP Embedded Security for ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock are 
available as options on some systems.

Use the following utilities to manage security settings on the HP computer:

■ Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide on 
the Documentation and Diagnostics CD included with the computer for additional 
information and instructions on using the Computer Setup Utilities. Some computers also 
have HP BIOS Configuration for ProtectTools, which is a Windows-based component of 
ProtectTools that allows administrators to configure BIOS security settings from within the 
running OS.

■ Remotely, using HP Client Manager Software or System Software Manager. This software 
enables the secure, consistent deployment and control of security settings from a simple 
command-line utility.

The following table and sections refer to managing security features of the computer locally 
through the Computer Setup (F10) Utilities.

Security Features Overview
Option Description

Setup Password Allows you to set and enable setup (administrator) password.

✎ If the setup password is set, it is required to change 
Computer Setup options, flash the ROM, and make changes 
to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable power-on password.

Password Options
(This selection will appear only 
if a power-on password is set.)

Allows you to specify whether the password is required for 
warm boot (CTRL+ALT+DEL) (appears if a power-on 
password is set).

Pre-Boot Authorization Allows you to enable/disable the Smart Card to be used in 
place of the Power-On Password.

Smart Cover Allows you to:
• Enable/disable the Cover Lock.
• Enable/disable the Cover Removal Sensor.

✎ Notify User alerts the user that the sensor has detected that 
the cover has been removed. Setup Password requires that 
the setup password be entered to boot the computer if the 
sensor detects that the cover has been removed.

This feature is supported on some models only and will only 
appear if a Smart Card reader is attached to the system.

Embedded Security Allows you to:
• Enable/disable the Embedded Security device.
• Reset the device to Factory Settings.

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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Device Security Enables/disables serial ports, parallel port, front USB ports, 
system audio, network controllers (some models), and SCSI 
controllers (some models).

Network Service Boot Enables/disables the computer’s ability to boot from an 
operating system installed on a network server. (Feature 
available on NIC models only; the network controller must 
reside on the PCI bus or be embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST).
• Chassis serial number or Universal Unique Identifier 

(UUID) number. The UUID can only be updated if the 
current chassis serial number is invalid. (These ID numbers 
are normally set in the factory and are used to uniquely 
identify the system.)

• Keyboard locale setting (for example, English or German) 
for System ID entry.

DriveLock (some models) Allows you to assign or modify a master or user password for 
certain ATA hard drives. When this feature is enabled, the user 
is prompted to provide one of the DriveLock passwords during 
POST. If neither is successfully entered, the hard drive will 
remain inaccessible until one of the passwords is successfully 
provided during a subsequent cold-boot sequence.

✎ This selection will only appear when at least one drive that 
supports ATA Security is attached to the system.

Security Features Overview (Continued)

Option Description

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide.
Support for security features may vary depending on your specific computer configuration.
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3.5.1 Password Security
The power-on password prevents unauthorized use of the computer by requiring entry of a 
password to access applications or data each time the computer is turned on or restarted. The 
setup password specifically prevents unauthorized access to Computer Setup, and can also be 
used as an override to the power-on password. That is, when prompted for the power-on 
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the power-on password, 
even if one has been established.

3.5.2 Establishing a Setup Password Using Computer Setup
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com. Establishing a setup password through Computer 
Setup prevents reconfigration of the computer (use of the Computer Setup (F10) utility) until the 
password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, Select File > Save Changes and Exit.

Mechanical Security Features 
Feature Purpose How It Is Established

Memory Change Alerts Detects when memory modules 
have been added, moved, or 
removed; notifies user and 
system administrator.

This feature is automatic.

Cable Lock Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal. Can also be used to 
secure the computer to a fixed 
object to prevent theft.

Install a cable lock to secure 
the computer to a fixed 
object.

Security Loop Provision Inhibits access to the interior of 
the computer to prevent 
unwanted configuration 
changes or component 
removal.

Install a lock in the security 
loop to prevent unwanted 
configuration changes or 
component removal.
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3.5.3 Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the computer 
when power is turned on, unless the password is entered. When a power-on password is set, 
Computer Setup presents Password Options under the Security menu. Password options include 
Password Prompt on Warm Boot. When Password Prompt on Warm Boot is enabled, the 
password must also be entered each time the computer is rebooted. 

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, select File > Save Changes and Exit.

Entering a Power-On Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. When the key icon appears on the monitor, type the current password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.

Entering a Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

If a setup password has been established on the computer, you will be prompted to enter it each 
time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. When the key icon appears on the monitor, type the setup password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
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Changing a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. To change the Power-On password, go to step 3.

To change the Setup password, as soon as the computer is turned on, press F10 when the 
monitor light turns green to enter Computer Setup. Press Enter to bypass the title screen, if 
necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. When the key icon appears, type the current password, a slash (/) or alternate delimiter 
character, the new password, another slash (/) or alternate delimiter character, and the new 
password again as shown:
current password/new password/new password

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

4. Press Enter.

The new password takes effect the next time you turn on the computer.

✎ Refer to “National Keyboard Delimiter Characters” for information about the alternate delimiter 
characters. The power-on password and setup password may also be changed using the Security 
options in Computer Setup.

Deleting a Power-On or Setup Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Security Manager Guide at www.hp.com.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. To delete the Power-On password, go to step 3.

To delete the Setup password, as soon as the computer is turned on, press F10 when the 
monitor light turns green to enter Computer Setup. Press Enter to bypass the title screen, if 
necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. When the key icon appears, type the current password followed by a slash (/) or alternate 
delimiter character as shown:
current password/

4. Press Enter.

✎ Refer to the National Keyboard Delimiter Character table below for information about the 
alternate delimiter characters. The power-on password and setup password may also be changed 
using the Security options in Computer Setup.
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National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you 
use for changing or deleting your password depend on the keyboard that came with your 
computer.

Clearing Passwords
If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide 
on the Documentation and Diagnostics CD for instructions on clearing passwords.

If the system is equiped with an embedded security device, refer to the HP ProtectTools Security 
Manager Guide at www.hp.com.

3.5.4 DriveLock
DriveLock is an industry-standard security feature that prevents unauthorized access to the data 
on ATA hard drives. DriveLock has been implemented as an extension to Computer Setup. It is 
only available when hard drives that support the ATA Security command set are detected.

DriveLock is intended for HP customers for whom data security is the paramount concern. For 
such customers, the cost of the hard drive and the loss of the data stored on it is inconsequential 
when compared with the damage that could result from unauthorized access to its contents. In 
order to balance this level of security with the practical need to accommodate a forgotten 
password, the HP implementation of DriveLock employs a two-password security scheme. One 
password is intended to be set and used by a system administrator while the other is typically set 
and used by the end-user. There is no “back-door” that can be used to unlock the drive if both 
passwords are lost. Therefore, DriveLock is most safely used when the data contained on the 
hard drive is replicated on a corporate information system or is regularly backed up. 

In the event that both DriveLock passwords are lost, the hard drive is rendered unusable. For 
users who do not fit the previously defined customer profile, this may be an unacceptable risk. 
For users who do fit the customer profile, it may be a tolerable risk given the nature of the data 
stored on the hard drive.

National Keyboard Delimiter Characters
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish .
French Canadian é Polish - U.S. English /
German - Portuguese -
* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Using DriveLock
When one or more hard drives that support the ATA Security command set are detected, the 
DriveLock option appears under the Security menu in Computer Setup. The user is presented 
with options to set the master password or to enable DriveLock. A user password must be 
provided in order to enable DriveLock. Since the initial configuration of DriveLock is typically 
performed by a system administrator, a master password should be set first. HP encourages 
system administrators to set a master password whether they plan to enable DriveLock or keep 
it disabled. This will give the administrator the ability to modify DriveLock settings if the drive is 
locked in the future. Once the master password is set, the system administrator may enable 
DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a 
power-on password is set and it matches the device’s user password, POST will not prompt the 
user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock 
password. On a cold boot, either the master or the user password may be used. On a warm boot, 
enter the same password used to unlock the drive during the preceding cold-boot. Users will have 
two attempts to enter a correct password. On a cold boot, if neither attempt succeeds, POST will 
continue but the drive will remain inaccessible. On a warm boot or restart from Windows, if 
neither attempt succeeds, POST will halt and the user will be instructed to cycle power.

DriveLock Applications
The most practical use of the DriveLock security feature is in a corporate environment. The 
system administrator would be responsible for configuring the hard drive which would involve, 
among other things, setting the DriveLock master password and a temporary user password. In 
the event that the user forgets the user password or the equipment is passed on to another 
employee, the master password can always be used to reset the user password and regain access 
to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also 
establish a corporate policy for setting and maintaining master passwords. This should be done to 
prevent a situation where an employee intentionally or unintentionally sets both DriveLock 
passwords before leaving the company. In such a scenario, the hard drive would be rendered 
unusable and require replacement. Likewise, by not setting a master password, system 
administrators may find themselves locked out of a hard drive and unable to perform routine 
checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. 
Users in this category include personal users or users who do not maintain sensitive data on their 
hard drives as a common practice. For these users, the potential loss of a hard drive resulting 
from forgetting both passwords is much greater than the value of the data DriveLock has been 
designed to protect. Access to Computer Setup and DriveLock can be restricted through the 
Setup password. By specifying a Setup password and not giving it to end users, system 
administrators are able to restrict users from enabling DriveLock.



3–24 433612-001 Service Reference Guide, dc7700

Desktop Management

3.5.5 Smart Cover Sensor
Cover Removal Sensor, available on some models, is a combination of hardware and software 
technology that can alert you when the computer cover or side panel has been removed. There are 
three levels of protection, as described in the following table.

Setting the Smart Cover Sensor Protection Level
To set the Smart Cover Sensor protection level, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. Select Security > Smart Cover > Cover Removal Sensor, and select the desired security 
level.

4. Before exiting, select File > Save Changes and Exit.

Smart Cover Lock
The Smart Cover Lock is a software-controllable cover lock featured on some HP computers. 
This lock prevents unauthorized access to the internal components. Computers ship with the 
Smart Cover Lock in the unlocked position.

Ä
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password 
prevents unauthorized access to the Computer Setup utility.

✎ The Smart Cover Lock is available as an option on some systems.

Smart Cover Sensor Protection Levels
Level Setting Description

Level 0 Disabled Smart Cover Sensor is disabled (default).

Level 1 Notify User When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed.

Level 2 Setup Password When the computer is restarted, the screen 
displays a message indicating that the 
computer cover or side panel has been 
removed. You must enter the setup 
password to continue.

✎ These settings can be changed using Computer Setup. For more information about Computer 
Setup, see the Computer Setup (F10) Utility Guide.



Service Reference Guide, dc7700 433612-001 3–25

Desktop Management

Locking the Smart Cover Lock
To activate and lock the Smart Cover Lock, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. Select Security > Smart Cover > Cover Lock > Lock option.

4. Before exiting, select File > Save Changes and Exit.

Unlocking the Smart Cover Lock
1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press F10 when the monitor light turns green to enter 
Computer Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press F10 at the appropriate time, you must restart the computer and again press 
F10 when the monitor light turns green to access the utility.

3. Select Security > Smart Cover > Cover Lock > Unlock.

4. Before exiting, select File > Save Changes and Exit.

Using the Smart Cover FailSafe Key
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will 
need a Smart Cover FailSafe Key to open the computer cover. You will need the key in any of the 
following circumstances:

■ Power outage

■ Startup failure

■ PC component failure (such as processor or power supply)

■ Forgotten password

Ä
CAUTION: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order 
this key before you need one (Tamper-resistant wrench PN 166527-001 or tamper-resistant bits PN 
166527-002).

For more information about using the Smart Cover FailSafe Key, please see the Removal and 
Replacement chapter for the specific chassis.

3.5.6 Cable Lock Provision
The rear panel of the computer accommodates a cable lock so that the computer can be 
physically secured to a work area. For illustrated instructions, please see the Removal and 
Replacement chapter for the specific chassis.
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3.5.7 Fingerprint Identification Technology
Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens 
network security, simplifies the login process, and reduces the costs associated with managing 
corporate networks. Affordably priced, it is not just for high-tech, high-security organizations 
anymore.

✎ Support for Fingerprint Identification Technology varies by model.

For more information, visit http://h18004.www1.hp.com/products/security/.

3.6 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network managed by HP Client Manager, the computer sends a 
fault notice to the network management application. With HP Client Manager, you can also 
remotely schedule diagnostics to automatically run on all managed PCs and create a summary 
report of failed tests.

3.6.1 Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in 
some HP computers. DPS is designed to help diagnose problems that might result in unwarranted 
hard drive replacement. 

When HP computers are built, each installed hard drive is tested using DPS, and a permanent 
record of key information is written onto the drive. Each time DPS is run, test results are written 
to the hard drive. Your service provider can use this information to help diagnose conditions that 
caused you to run the DPS software. Refer to the Troubleshooting Guide for instructions on using 
DPS.

3.6.2 Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000 volts without incurring any system downtime or data loss.

3.6.3 Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
computer. This feature displays a warning message when the normal range is exceeded, which 
gives you time to take action before internal components are damaged or data is lost.
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4
Serial and Parallel ATA Drive Guidelines and

Features

✎ Serial ATA = SATA
Parallel ATA = PATA

HP only supports the use of SATA hard drives on these models of computer. The USDT model is 
the only product that supports a PATA optical drive. No PATA drives are supported on any other 
model.

4.1 SATA Hard Drives

SATA connectors on the system board are color coded to make identification easier.

✎ If there is an error on the application of the attach rules, a POST error message may be displayed.

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Identification Color Port
Attachment 
Sequence

Primary channel, device 0 Dark blue SATA 0 1

Primary channel, device 1 Light Blue SATA 2 4

Secondary channel, device 0 White SATA 1 2

Secondary channel, device 1 Orange SATA 3 3
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4.2 SATA Hard Drive Cables

4.2.1 SATA Data Cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the 
SATA 1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and 
never bend it tighter than a 30 mm (1.18 in) radius. 

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As 
shown in the table, each cable has 3 grounds, and 4 transmit/receive pins.

4.2.2 SATA Power Cable

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair
**P5 and P6 differential signal pair

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V 12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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4.3 PATA Device Information
The USDT model is the only product that supports a PATA optical drive. No PATA drives are 
supported on any other model.

4.4 ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP 
Personal Computers have built-in drive failure prediction that warns the user or network 
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault 
prediction and failure indication parameters such as reallocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.

4.5 Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the 
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that 
may be properly accessed by the operating system. A single hard drive may therefore be 
subdivided into a number of unique drive partitions in order to make use of all of its space. 

Because of the differences in the way that drive sizes are calculated, the size reported by the 
operating system may differ from that marked on the hard drive or listed in the computer 
specification. Drive size calculations by drive manufacturers are bytes to the base 10 while 
calculations by Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File 
System

Controller 
Type Operating System

 
Partition Drive 

FAT 32 ATA Windows 2000/ XP 32 GB 2 TB

NTFS ATA Windows NT/2000/XP 2 TB 2 TB
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5
Identifying the Chassis, Routine Care, and

Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures 
and precautions described in this chapter is essential for proper service.

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

5.1 Chassis Designations

5.1.1 Convertible Minitower (CMT)
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5.1.2 Small Form Factor (SFF)

5.1.3 Ultra-Slim Desktop (USDT)
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5.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.

5.2.1 Generating Static
The following table shows that:

■ Different activities generate different amounts of static electricity. 

■ Static electricity increases as humidity decreases. 

✎ 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

Relative Humidity

Event 55% 40% 10%

Walking across carpet
Walking across vinyl floor
Motions of bench worker
Removing DIPs* from plastic tube

7,500 V
3,000 V

400 V
400 V

15,000 V
5,000 V

800 V
700 V

35,000 V
12,000 V
6,000 V
2,000 V

Removing DIPs* from vinyl tray
Removing DIPs* from Styrofoam
Removing bubble pack from PCB
Packing PCBs in foam-lined box

2,000 V
3,500 V
7,000 V
5,000 V

4,000 V
5,000 V

20,000 V
11,000 V

11,500 V
14,500 V
26,500 V
21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.
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5.2.3 Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

■ Heel straps/Toe straps/Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

5.2.4 Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

5.2.5 Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

Static Shielding Protection Levels

Method Voltage

Antistatic plastic
Carbon-loaded plastic
Metallized laminate

1,500
7,500 
15,000
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■ Static awareness labels

■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes

5.3 Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

■ Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and 
cold. 

■ Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all 
vented sides of the computer and above the monitor to permit the required airflow.

■ Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place 
the keyboard, with the keyboard feet down, directly against the front of the desktop unit as 
this also restricts airflow.

■ Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other 
foreign matter can block the vents and limit the airflow. Be sure to unplug the computer 
before cleaning the air vents.

✎ If operating in a dusty environment, periodic cleaning of heatsink and fans is recommended to 
prevent overheating.

■ Never operate the computer with the cover or side panel removed.

■ Do not stack computers on top of each other or place computers so near each other that they 
are subject to each other’s re-circulated or preheated air.

■ If the computer is to be operated within a separate enclosure, intake and exhaust ventilation 
must be provided on the enclosure, and the same operating guidelines listed above will still 
apply.

■ Keep liquids away from the computer and keyboard.

■ Never cover the ventilation slots on the monitor with any type of material.

■ Install or enable power management functions of the operating system or other software, 
including sleep states.
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5.4 Routine Care

5.4.1 General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

5.4.2 Cleaning the Computer Case
Follow all safety precautions in Section 5.4.1 before cleaning the computer.

To clean the computer case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.

5.4.3 Cleaning the Keyboard
Follow all safety precautions in Section 5.4.1 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Section 
5.4.2.

When cleaning debris from under the keys, review all rules in Section 5.4.1 before following 
these procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

■ Visible debris underneath or between the keys may be removed by vacuuming or shaking.

■ Canned, pressurized air may be used to clean debris from under the keys. Caution should be 
used as too much air pressure can dislodge lubricants applied under the wide keys.

■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.
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■ Cleaning under a key may be done with a swab moistened with isopropyl alcohol and 
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Use 
tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before 
reassembly.

5.4.4 Cleaning the Monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body follow the procedures in Section 5.4.2. 

5.4.5 Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull 
out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in Section 5.4.2.

5.5 Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly 
and assembly of the computer.

5.5.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is off 
when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage.

5.5.2 Tools and Software Requirements
To service the computer, you need the following:

■ Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

■ Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

■ Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

■ Phillips #2 screwdriver

■ Diagnostics software

■ HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or 
HP tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)
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5.5.3 Screws
The screws used in the computer are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, it can damage the unit. HP strongly recommends that all screws removed during 
disassembly be kept with the part that was removed, then returned to their proper locations.

✎ Metric screws have a black finish.
U.S. screws have a silver finish and are used on hard drives only.

✎ As each subassembly is removed from the computer, it should be placed away from the work 
area to prevent damage.

5.5.4 Cables and Connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with 
care to avoid damage. Apply only the tension required to seat or unseat the cables during 
insertion or removal from the connector. Handle cables by the connector whenever possible. In 
all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such a way 
that they cannot be caught or snagged by parts being removed or replaced.

Ä
CAUTION: When servicing this computer, ensure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the computer. 

5.5.5 Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are actually mounted in the CPU.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard 
drive while the computer is on or in standby mode.

■ Before handling a drive, ensure that you are discharged of static electricity. While handling a 
drive, avoid touching the connector. For more information about preventing electrostatic 
damage, refer to Section 5.2, “Electrostatic Discharge Information.”

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields such as monitors or speakers.
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5.5.6 Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a 
minimum lifetime of about three years. 

See the appropriate removal and replacement chapter for the chassis you are working on in this 
guide for instructions on the replacement procedures. 

Å
WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the 
battery.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.
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Removal and Replacement Procedures -

Convertible Minitower (CMT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 6.2, 
“Unlocking the Smart Cover Lock” and Section 6.4, “External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

8. Lay the computer down on its side to achieve a safe working position.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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6.2 Unlocking the Smart Cover Lock 
If you have locked the Smart Cover Lock use Computer Setup to unlock the lock. Refer to the 
Desktop Management Guide on the Documentation and Diagnostics CD for more information 
about the Smart Cover Lock.

If you cannot access Computer Setup to unlock the cover you will need to remove the locking 
solenoid by using the Smart Cover FailSafe Key (Spare part number 166527-001 or 
166527-002). Once the solenoid has been deactivated or removed the access panel can be 
removed.

The Smart Cover FailSafe Key will be needed in any of the following circumstances:

■ Power outage

■ Startup failure

■ Processor or power supply failure

■ Lost password

1. Using the Smart Cover FailSafe Key, remove the two tamper-proof screws that secure the 
Smart Cover Lock to the inside of the chassis.

2. Remove the access panel (Section 6.5).

To reattach the Smart Cover Lock, secure the lock in place with the two tamper-proof screws.
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6.3 Hood Sensor 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.5).

3. Disconnect the hood sensor cable from the system board.

4. Slide the hood sensor switch towards the front of the computer 1 and lower it down through 
the slot 2. 

To install the hood sensor, reverse the removal procedure.
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6.4 External Security Devices

6.4.1 Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 

6.4.2 Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
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6.5 Computer Access Panel 
1. Prepare the computer for disassembly (Section 6.1).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Lift up on the access panel handle 1, slide the access panel back about 2.5 cm (1 inch), then 
lift it off the unit 2.

To install the computer cover, reverse the removal procedure.
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6.6 Front Bezel 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Push up on the two release tabs 1, then rotate the front bezel away from the chassis to 
release it 2.

To reinstall the front bezel, reverse the removal procedure 
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6.7 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the access panel (Section 6.5).

3. Remove the front bezel (Section 6.6).

6.7.1 5.25” Drive Bezel Blank 
Gently pull the subpanel, with the bezel blanks secured in it, away from the front bezel, then 
remove the desired bezel blank. 

Ä
CAUTION: Hold the subpanel straight when pulling it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it with the front bezel.

To install a bezel blank, reverse the removal procedure.

✎ When replacing the subpanel, ensure that the aligning pins and any remaining bezel blanks are in 
their proper orientation. The logo in the subpanel should be located at the bottom of the subpanel 
when properly oriented.
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6.7.2 Diskette Drive Bezel or Bezel Blank 
Press up on the two small retaining clips 1  on the bottom of the bezel insert, press down on the 
two small retaining clips 2  on the top of the insert, and push the cover out of the front bezel 3. 

To install a bezel or a bezel blank, reverse the removal procedure.
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6.8 Cable Management 
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped 
when the parts are moved.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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6.8.1 Cable Connections
All cable connectors on the system board are color-coded for ease of installation. 

System Board Connections

Power Supply Cable Connections

System Board Connector, Name, 
and Connector Color

Description

P10, FLOPPY, black Diskette drive

P70, CPU FAN Heatsink fan

P8, CHASSIS FAN Chassis fan

P5, F_PNL Front power button/LED

P23, FRNT USB, Yellow Front I/O audio 

P24, FRNT AUD, black Front I/O USB cable

P6, SPKR Internal speaker

P52, SERIAL B Serial port

P124, HLCK Hood lock solenoid

P125, HSENSE Hood sensor

Power Supply Connector ID Description

P1 Main power

P3 CPU power

P4, White 1st ODD or 2nd HDD if no ODD present, SATA1

P5, Dark blue 1st Hard drive, SATA0

P6 PATA/Zip/Media card reader

P8 Diskette drive

P9 SATA hard/optical drive - Bay 1 only

P10, Light bluet 2nd or 4th HDD if no Odd presenT, SATA2

P11, Orange 2nd ODD or 3rd HDD if no ODD present, 
SATA3
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6.9 Memory 
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Section 5.2, “Electrostatic Discharge Information” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Refer to Appendix F, “Memory” for the correct sequence for installing memory 
modules to get optimal performance.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

4. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position (3).

5. Repeat steps 3 and 4 for any additional modules that you want to install.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.

6.10 Expansion Cards 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Locate the correct vacant expansion socket on the system board and the corresponding 
expansion slot on the back of the computer chassis.

4. Push down and out on the two green thumb tabs inside the chassis and rotate the expansion 
card retention latch up.
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5. If you are installing an expansion card in a vacant socket, remove the appropriate expansion 
slot cover on the back of the chassis. Pull the slot cover straight up to release it from the 
chassis frame.

6. If you are removing an expansion card from a standard expansion socket, hold the card at 
each end and carefully rock it back and forth until the connectors pull free from the socket. 
Lift the expansion card straight up to release it from the chassis frame. Be sure not to scrape 
the card against other components.

✎ Before removing an installed expansion card, disconnect any cables that may be attached to the 
expansion card.
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7. If you are removing a PCI Express card from a x16 PCI Express socket with a retention 
mechanism, pull the retention arm away from the socket then carefully rock the card back 
and forth until the connectors pull free from the socket. Lift the expansion card straight up 
then pull it in toward the center of the chassis to release it from the chassis frame. Be sure not 
to scrape the card against other components.

8. Store the removed card in anti-static packaging.

9. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot and continue with step 12.

If you are installing a new expansion card, continue with step 11.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot 
cover for proper cooling of internal components during operation.
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10. Slide the bracket on the end of the expansion card down into the slot on the back of the 
chassis and press the card down firmly into the socket on the system board. 

✎ When you install an expansion card, make sure you press firmly on the card so that the whole 
connector seats properly in the expansion card socket on the system board.

11. Close the expansion slot latch, making sure that it snaps firmly into place. 

12. Connect external cables to the installed card and internal cables to the system board as 
needed. 

13. Replace the computer access panel.

14. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor.

15. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide on 
the Documentation and Diagnostics CD for instructions about using Computer Setup.
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6.11 PCI Retainer Latch 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Locate the correct vacant expansion socket on the system board and the corresponding 
expansion slot on the back of the computer chassis.

4. Push down and out on the two green thumb tabs inside the chassis and rotate the expansion 
card retention latch up.

5. Use a thin flat blade screwdriver to pry up on the broken plastic latches 1, then complete the 
removal by pulling the latches off the pivoting bar 2.
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6. Slide the pivoting bar to the right 1, then lift the left end 2 to remove it from the chassis. To 
replace the bar, slide it into the socket on the right 1, lower it into position 3, and slide it to 
the left 4 to secure it in place.

7. With the bar in a slightly rotated position, install the latches through the openings in the back 
of the chassis and press them firmly in place on the rotating bar.

✎ The green latches are marked “R” and “L” for your convenience.
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6.12 Expansion Card Guide 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove any expansion cards that might be in the way (Section 6.10).

4. Compress the retaining tabs 1  that secure the card guide to the chassis and remove the guide 
from the chassis 2.

To install the expansion card guide, reverse the removal procedure.
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6.13 Drives
The computer supports up to six drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15 
screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the factory-installed files.

6.13.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions
Item Description Item Description

1 *Three 5.25-inch, half-height bays for 
optional drives and media card 
reader.

3 Two internal 3.5-inch, one-third height 
bay for hard drives)

2 **One standard 3.5-inch, one-third 
height bay (1.44-MB diskette drive 
shown)*

*The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom bay supports a 
drive that is no more than 6.7 inches in depth, including the cables that attach to the back of the drive. Do 
not try to force a larger drive into the bottom bay as it could damage the drive and the system board.
**Depending on the computer configuration, you may have a bezel blank in this position. If you do not 
have a drive in this slot, you may choose to install a 3.5-inch device (such as a diskette drive, hard drive, or 
media card reader).
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6.13.2 Hard Drive 

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. Refer to Section 5.2, “Electrostatic Discharge Information” for more 
information about preventing electrostatic damage.

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5). 

3. Remove the front bezel (Section 6.6).

4. Disconnect the power 1  and data 2  cables from the back of the drive.

✎ The right-angle data cable must be used for this chassis model when installing hard drives in the 
3.5-inch bays to prevent cable damage from overflexing. 
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5. Pull up on the green hard drive drivelock mechanism 1  for that drive and slide the drive 
from the drive bay 2 . 

6. Remove the four guide screws (two on each side) from the old drive and install them in the 
replacement drive. 

✎ Extra guide screws are provided on the chassis. Hard drives use 6-32 standard screws. Optical 
drives use M3 metric screws. The HP-supplied metric screws are black. The HP-supplied 
standard screws used on hard drives are silver.

7. Store the removed drive in anti-static packaging.

8. Install the new drive by sliding it into the appropriate drive bay on the front of the chassis. 
The drivelock automatically secures the drive in the bay.
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6.13.3 Optical Drive 

✎ An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo 
drive. 

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove the front bezel (Section 6.6).

✎ If you are adding a drive in a bay that was previously empty, you must remove the corresponding 
bezel blank from the front bezel.

4. Disconnect the power and data cables on the back of the drive. 

Ä
CAUTION: When removing cables, pull the tab or connector instead of the cable itself to prevent 
damaging the cable.

5. If the computer is in the desktop mode, continue with step 7.

If the computer is in the minitower mode, continue with step 8.

6. In the desktop mode, press down on the yellow drivelock mechanism 1  and slide the drive 
from the drive bay 2.
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7. In the minitower mode, pull up on the green drivelock mechanism 1  for that specific drive 
and slide the drive from the drive bay 2.

8. Remove the four guide screws (two on each side) from the old drive and install them in the 
lower set of holes on the optical drive. 

✎ Extra guide screws are provided on the chassis on the side of the fourth drive bay. Optical drives 
use M3 metric screws. The HP-supplied metric screws are black. The HP-supplied standard 
screws, used only for hard drives, are silver.
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9. After installing the M3 metric guide screws 1, install the drive by sliding it into the 
appropriate drive bay on the front of the chassis 2. The drivelock automatically secures the 
drive in the bay.

Ä
CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use of 
unnecessary force when installing any drive into the drive bay may result in damage to the drive.

10. When installing an optical drive, the default audio solution is digital audio. No separate 
audio cable is required for Windows XP applications.

11. Connect the data and power cables on the to the drive.

✎ Refer to Chapter 4, “Serial and Parallel ATA Drive Guidelines and Features” for information on 
attaching the cabling to get optimum performance.

12. Replace the front bezel (Section 6.6).

13. Replace the computer access panel (Section 6.5)

14. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor (Section 6.2).
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6.13.4 Diskette Drive 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5). 

3. Remove the front bezel (Section 6.6).

4. Pull up on the green hard drive drivelock mechanism 1 and slide the drive from the bay 2. 

5. Remove the four guide screws (two on each side) from the old drive and install them in the 
replacement drive. Install four guide screws, two on each side of the drive.

✎ Extra guide screws are provided on the side of the drive bay under the access panel. The diskette 
drive uses M3 metric screws. The HP-supplied metric screws are black. The HP-supplied 
standard screws, used only for hard drives, are silver.

6. Insert the diskette drive into the bay from the front of the chassis. Push it in until it locks into 
place.

Ä
CAUTION: Make sure the guide screws line up with the guide slots in the drive cage. The use of 
unnecesary force when installing any drive into the drive bay may result in damage to the drive.

7. Connect the data and power cables to the drive.

8. Replace the front bezel (Section 6.6).

9. Replace the computer access panel (Section 6.5).

10. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor (Section 6.2).
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6.14 Front I/O Device 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5). 

3. Remove the front bezel (Section 6.6).

4. Disconnect the two I/O device cables from the system board: the front USB cable pair and 
the front audio cable.

5. Remove the two screws that secure the front I/O device to the mounting bracket 1.

6. Remove the two screws that secure the mounting bracket to the chassis 2.

7. Lift the mounting bracket off the chassis 3.

8. Carefully pull the cables from the front of the chassis making sure that they do not snag on 
the lower drive cage.

To reinstall the I/O device:

1. Thread the cables through the opening and down the space in front of the lower drive cage. 
This step may be easier if you thread a single cable at a time through the opening.

Ä
CAUTION: Be careful when threading the cables in the chassis so the cable ends are not damaged.

2. Position the I/O device and the mounting bracket on the front of the chassis and install the 
two screws that secure the bracket to the chassis.

3. Install the two screws that secure the I/O device to the mounting bracket.

Complete the reassembly by reinstalling the other parts that had been removed.
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6.15 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5). 

3. Remove the front bezel (Section 6.6).

4. Disconnect the power switch/LED cable from the system board. 

5. Squeeze the switch holder retaining clips together at the front of the chassis 1  and pull the 
switch assembly out of the chassis 2.

To install the power switch assembly, reverse the removal procedure. 

✎ When installing the power switch cable it may be necessary to disconnect a data cabe from one 
of the drives to make it easier to grab the free end of the cable.
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6.16 System Board 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove all PCI expansion boards (Section 6.10).

4. Remove the x16 PCI Express graphics card (Section 6.10).

5. Disconnect all cables connected to the system board, noting their location for reinstallation.

6. Compress the system board tray handle 1  to release the latch and slide the system board 
tray towards the front of the computer 2  to free it from the back of the chassis.

To install the system board with its tray, press down on the board to ensure it is latching 1, then 
push the board into its locked position 2. 
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6.17 Battery
The 3-volt lithium coin cell battery that comes with this computer provides power to the 
real-time clock and has a lifetime of about three years. When replacing the battery, use a battery 
equivalent to the battery originally installed on the computer. 

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 60°C (140°F).
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup (F10) 
Utility Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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6.17.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.17.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp 1  that extends above one 

edge of the battery. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.17.3 Type 3 Battery Holder
1. Pull back on the clip 1  that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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6.18 Heatsink 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the heatsink control cable from the system board.

4. Uncrew the four captive screws 1  that secure the heatsink to the system board.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

5. Remove the heatsink 2  from atop the processor.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.
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6.19 Processor 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the heatsink control cable from the system board and remove the heatsink 
(Section 6.18). 

4. Rotate the locking lever to its full open position 1.

5. Raise and rotate the microprocessor retainer to its fully open position 2.

6. Carefully lift the processor from the socket 3.

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.

3. If reusing the existing heatsink, apply the thermal grease provided in the spares kit to the top 
of the processor.

4. Clean the bottom of the heatsink with the provided alcohol pad and place it atop the 
processor.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.
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6. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be 
found on the Web at: http:\\h18000.www1.hp.com/support/files.

6.20 Speaker 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the speaker wire from the system board.

4. Remove the four screws from the inside of the chassis 1 that secure the speaker to the 
chassis.

5. Remove the speaker 2.

To install the speaker, reverse the removal procedures.



6–36 433612-001 Service Reference Guide, dc7700

Removal and Replacement Procedures - Convertible Minitower (CMT) Chassis

6.21 Chassis Fan 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Disconnect the fan control cable from the system board.

4. Remove the four screws that secure the fan assembly to the chassis and then remove the fan 
assembly.

To install the fan assembly, reverse the removal procedure. Be sure to orient the air flow out of 
the unit. Refer to the air flow arrows on the side of the fan housing for proper air flow orientation.
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6.22 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1).

1. Remove the computer access panel (Section 6.5).

2. Disconnect all power cables from the mass storage devices and from the system board.

3. Remove the four screws that connect the power supply to the chassis 1 and slide the chassis 
forward 2 until it is stopped by the retaining clips.
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4. With the power supply stopped by the retaining clips 1, lift the power supply to raise it over 
the clips then slide the power supply forward 2 to remove it from the computer.

To install the power supply, reverse the removal procedure.
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6.23 Changing from Desktop to Minitower 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove the front bezel (Section 6.6).

4. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.

5. To release the drives from the 5.25-inch drive bay, press down on the short yellow drivelock 
as shown. While pressing the drivelock, pull the drives out of the drive bay.
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6. Before you reinstall each drive into the chassis, turn it so that it is in the same orientation as 
the internal 3.5-inch drive. The bottom of the drive should be parallel to the yellow drivelock.

7. Slide the drive into the uppermost available bay until it snaps into place. When the drive is 
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Ä
CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom 
bay supports a drive that is no more than 17 cm (6.7 inches) in depth, including the cables that attach to 
the back of the drive. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This 
could cause damage to the drive and the system board.

The use of unnecessary force when installing any drive into the drive bay may result in damage to the 
drive.

8. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

9. Remove the bezel subpanel (Section 6.7).

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it within the front bezel.

10. Reposition the bezel blanks within the subpanel in the proper orientation for the minitower 
configuration.
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11. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the 
bezel.

12. Replace the front bezel and computer access panel.

13. Reconnect the external equipment.

14. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor.
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6.24 Changing from Minitower to Desktop 
1. Prepare the computer for disassembly (Section 6.1).

2. Remove the computer access panel (Section 6.5).

3. Remove the front bezel (Section 6.6).

4. Disconnect all power and data cables from the back of the drives in the 5.25-inch drive bays.

5. To release the drives from the 5.25-inch drive bay, lift the release tab on the green latch drive 
bracket for the drive. While lifting the release tab, slide the drive from its drive bay. Repeat 
this step for each 5.25-inch drive.
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6. Before reinstalling each drive into the chassis, turn the drive so that it is perpendicular to the 
internal 3.5-inch drive. The drive should be parallel to the green latch drive bracket.

7. Slide the drive into the uppermost available bay until it snaps into place. When the drive is 
properly inserted, the drivelock will secure it. Repeat this step for each drive.

Ä
CAUTION: The bottom 5.25-inch drive bay has a shorter depth than the upper two bays. The bottom 
bay supports a drive that is no more than 17 cm (6.7 inches) in depth, including the cables that attach to 
the back of the drive. Do not try to force a larger drive, such as an optical drive, into the bottom bay. This 
could cause damage to the drive and the system board.

The use of unnecessary force when installing any drive into the drive bay may result in damage to the 
drive.

8. Reconnect all power and data cables to the drives in the 5.25-inch drive bays.

9. Remove the bezel subpanel (Section 6.7).

Ä
CAUTION: Hold the subpanel straight when you pull it away from the front bezel. Pulling the subpanel 
away at an angle could damage the pins that align it within the front bezel.

10. Reposition the bezel blanks within the subpanel in the proper orientation for the desktop 
configuration.
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11. Reposition the subpanel (rotate it 90°) with the logo at the bottom, then snap it back into the 
bezel.

12. Replace the front bezel and computer access panel.

13. Reconnect the external equipment.

14. If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and 
enable the Smart Cover Sensor.



Service Reference Guide, dc7700 433612-001 7–1

7
Removal and Replacement Procedures—

Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

7.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,”for initial 
safety procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 7.2, 
“Unlocking the Smart Cover Lock,” and Section 7.4, “External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette or compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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7.2 Unlocking the Smart Cover Lock 
If you have locked the Smart Cover Lock use Computer Setup to unlock the lock. Refer to the 
Desktop Management Guide on the Documentation and Diagnostics CD for more information 
about the Smart Cover Lock.

If you cannot access Computer Setup to unlock the cover you will need to remove the locking 
solenoid by using the Smart Cover FailSafe Key (Spare part number 166527-001 or 
166527-002). Once the solenoid has been deactivated or removed the access panel can be 
removed.

The Smart Cover FailSafe Key will be needed in any of the following circumstances:

■ Power outage

■ Startup failure

■ Processor or power supply failure

■ Lost password

To open the computer cover with the Smart Cover Lock engaged:

1. Prepare the computer for disassembly (Section 7.1).

2. Using the Smart Cover FailSafe Key, remove the tamper-proof screw 1 that secures the 
Smart Cover Lock to the inside of the chassis.

3. Push the metal arm that wraps around the air vent grid up and back 2 to free the Smart Cover 
Lock from the chassis.

4. Remove the computer cover (Section 7.5).
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To reattach the Smart Cover Lock:

1. Install the Smart Cover Lock assembly on the inside of the rear panel with the metal arm 1 
wrapped around the air vent grid on the back of the chassis.

2. Use the supplied tamper-resistant screw 2 to secure the Smart Cover Lock to the chassis.
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7.3 Hood Sensor 
1. Prepare the computer for disassembly.

2. Remove the computer cover.

3. Remove the special security clip (Section 7.4.1) from the top corner of the power supply 
cage. 

4. Raise the power supply to its full upright position.

5. Disconnect the hood sensor cable from the system board.

6. Slide the hood sensor switch mounted on the power supply towards the outside of the 
computer 1 and lower it through the slot 2.

To install the hood sensor, reverse the removal procedure.
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7.4 External Security Devices

7.4.1 Security Clip
A special clip is required to secure the computer from intrusion. This clip must be installed 
before installing the computer cover.

7.4.2 Cable Lock 
The cable lock may be used to secure the computer cover to the chassis and, at the same time, 
secure the computer to a fixed object. 

Insert the cable lock in the location shown below.
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7.4.3 Padlock 
A padlock may be used by itself to secure the computer cover to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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7.5 Computer Cover 
1. Prepare the computer for disassembly (Section 7.1).

Ä
CAUTION: Before removing the computer cover, ensure that the computer is turned off and that the 
power cord is disconnected from the electrical outlet.

1. Press the buttons on the left and right sides of the computer 1.

2. Slide the computer cover towards the front of the computer until it stops 2, then lift it up and 
off the chassis.

To install the computer cover, reverse the removal procedure.
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7.6 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the drive bezel by pushing the top tab on the right side of the larger front bezel as 
shown 1 and rotating the drive bezel away from the larger front bezel 2. 

✎ The drive bezel will vary depending on the computer configuration.

4. Install a bezel or a bezel blank by pushing the bezel into place.
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There are three drive bezel inserts that are available. 

Item Description

1 Diskette drive bezel

2 Hard drive bezel

3 3.5” drive bezel
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7.7 Cable Management 
The Small Form Factor chassis is a very compact computer and proper routing of the internal 
cables is critical to the operation of the computer. Follow good cable management practices when 
working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of movable or rotating parts like the power supply and drive cage to 
prevent them from being cut or crimped when the component is lowered into its normal 
position.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 connector on the system board, 
always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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7.7.1 Cable Connections
System board connectors are color-coded to make it easier to find the proper connection.

Cable To Cable Designator

Power Supply System board, 24-pin P1

Power Supply Diskette drive P2

Power Supply CPU power, 6-pin P3

Power Supply 1st SATA Hard drive P4

Power Supply 2nd SATA Hard drive P5

Power Supply Optical drive P7

Cable To PCA Designator

Diskette drive System board P10, FLOPPY (Black)

1st SATA Hard drive System board P60, SATA 0 (Dark Blue) 

2nd SATA Hard drive if no 
ODD/1st ODD

System board P61, SATA 1 (White)

2nd SATA Hard drive if ODD 
present

System board P62, SATA 2 (Light blue)

Serial port A System board P54, COM A

Serial port B System board P52, COM B

Hood lock solenoid System board P124, HLCK

Heatsink fan System board P8, CPU FAN 

Hood Sensor System board P125, HSENSE

Front power button/LED System board P5, Pb/LED

Front I/O USB System board P24, FRNT USB (Yellow)

Speaker System board P6, SPKR 

Front audio System board P23, FRTNT AUD, (Blue)

Chassis fan System board P9, CH FAN
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7.8 Memory 

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Section 5.2, “Electrostatic Discharge Information” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock 
(Section 7.2).

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

4. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Refer to Appendix F, “Memory” for the correct sequence for installing memory 
modules to get optimal performance.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

5. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.

6. Repeat steps 4 and 5 for any additional modules that you want to install.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.

7.9 Vertically Oriented Expansion Card 

7.9.1 Expansion Card Retainer 
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer cover (Section 7.5).

5. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

6. Remove the single screw that keeps the card retainer in place 2 and slide the retainer to the 
left to remove it from the chassis 3.

To install the card retainer, reverse the removal procedure.
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7.9.2 PCI Expansion Card 
1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 

unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer cover. (Section 7.5).

5. Identify the slot into which you want to insert the expansion card.

6. Release the slot cover retention latch that secures the PCI slot covers by lifting the green tab 
on the latch and rotating the latch to the full open position 1.

7. Remove the slot cover by sliding it up and out of the computer 2.
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8. Install the expansion card by sliding the card under the slot cover retention latch then 
pressing the card down into the slot on the system board.

✎ Be sure not to scrape other components in the chassis when installing an expansion card.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

✎ When you install an expansion card, make sure the metal bracket on the card slides into the slot 
on the back of the computer then press down firmly on the card so that the whole connector seats 
properly in the expansion card slot.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.9.3 PCI Express Expansion Card
To remove a PCI Express expansion card:

1. If you have locked the Smart Cover Lock, restart the computer and enter Computer Setup to 
unlock the lock.

2. Turn off the computer properly through the operating system, then turn off any external 
devices.

3. Disconnect the power cord from the power outlet and disconnect any external devices.

4. Remove the computer cover. (Section 7.5).

5. Release the slot cover retention latch on the back of the computer that secures the PCI slot 
covers by lifting the green tab on the latch and rotating the latch to the open position.

6. Pull the retention arm on the back of the PCI Express expansion socket away from the card 
(on x16 card socket only) and carefully rock the card back and forth until the connectors pull 
free from the socket. Pull the expansion card straight up from the socket then away from the 
inside of the chassis. Be sure not to scrape the card against the other components.

7. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot.

8. Rotate the slot cover retention latch back in place to secure the expansion cards and 
expansion slot covers.

Ä
CAUTION: All expansion card slots on the rear of the computer must contain either an expansion card 
or slot cover for proper cooling of internal components during operation.
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7.10 PCI Riser Card Assembly and Backwall
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock 

(Section 7.2).

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5). 

4. Remove all PCI and PCI Express expansion cards from the PCI expansion slots 
(Section 7.9).

5. Rotate the optical and diskette drive cage to its upright position.

6. Remove the security clip (Section 7.4.1), rotate the power supply to its full upright 
position 1, then lift the power supply straight up and out of the chassis 2.
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7. Remove the SmartCover lock from the backwall of the chassis using the special security 
wrench and disconnect its cable from the system board. (Section 7.2)

8. Disconnect the data and power cables from the system board.

9. Disconnect the “Serial A” cable from the system board, remove the two screws that secure 
the serial connector to the backwall, then remove the serial connector.

10. Remove the fan shroud by lifting it up and out (Section 7.12).

11. Remove the chassis fan (Section 7.18)
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12. Remove the long mounting screw that secures the system board tray to the chassis.

13. Slide the system board tray assembly towards the front of the chassis about 6 cm (1/4 inch) 
and lift the system board up and out of the chassis.
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14. Remove the three screws that secure the backwall assembly to the chassis 1, then slide the 
backwall assembly a few millimeters/inches toward the space vacated by the power supply 
and lift out(2.

15. Slide the new backwall onto the rear chassis 1. Secure it with the three screws removed from 
the old backwall 2.
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16. Install the serial connector into the new backwall using the two screws that were removed 
from the serial connector in a previous step. Reconnect the “Serial A” cable to the system 
board.

17. Install the system board tray assembly. Be sure the keyhole slot on the system board sits 
properly over the locking pins. When the system board is in position, replace the long 
mounting screw to secure the system board to the chassis.

18. Install the chassis fan and connect the control cable to the system board.

19. Reconnect all power and data cables to the system board. Be sure to use proper cable 
handling and placement precautions.

20. Install the power supply. Rotate it to its normal operating position. Be sure to use proper 
cable handling and placement precautions.

21. Install the full-height PCI expansion card in the available slot in the new PCI riser card cage 
assembly. 

22. Install the new PCI riser card cage assembly on the new backwall by aligning the cage with 
the guide rails on the backwall. Press down firmly on the cage to secure it in place on the 
backwall. Be sure the riser card in the cage is properly seated in the PCI expansion slot on 
the system board.
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23. Rotate the drive cage back down to its normal position. Be sure to use proper cable handling 
and placement precautions.

Ä
CAUTION: Cables are very sensitive. Overbending, creasing, or pinching can damage cables.

24. Replace the fan shroud on top of the fan.

25. Replace the computer cover.

7.11 Drives
A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

7.11.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions
Item Description Item Description

1 3.5-inch, internal, standard hard 
drive bay

3 3.5-inch drive bay (1.44-MB diskette 
drive shown)*

2 5.25-inch drive bay for optional 
drives

*A 3.5-inch diskette drive, hard drive, or media card reader may be installed in this bay but the 
correct bezel must be installed to ensure proper air flow. 
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7.11.2 Optical Drive 

Ä
CAUTION: All removable media should be taken out of the drives before removing the drive from the 
computer.

✎ An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD Combo 
drive.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 
7.2).

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5). 

4. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

5. Disconnect the power and data cables from the rear of the optical drive.
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6. Rotate the drive cage down to its normal position before trying to remove the drive. 

7. Press the green drive retainer latch and slide the drive forward and lift it from the drive cage.

8. When replacing the drive, transfer the four screws from the old drive to the new one. The 
screws take the place of drive rails.

Ä
CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal 
components of the drive.
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7.11.3 External 3.5-inch Drive 
1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock (Section 

7.2).

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5).

4. Remove the optical drive (Section 7.11.2).

5. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

6. Disconnect the signal 1 and power 2 cables from the drive. The other end of the cables 
should remain connected to the system board. (Diskette drive is shown.)

7. Rotate the drive cage down to its normal position before trying to remove the drive.
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8. Press the green drive retention latch 1 located on the side of the diskette drive to disengage 
the drive from the drive cage and slide the diskette drive forward approximately 6mm 
(1/4 inch) 2.

9. Lift the rear of the drive up so that the rear guide screws clear the top of the drive cage 1. 
As the drive rises it automatically slides forward until it is free from the drive cage 2.

To replace the drive, reverse the removal procedure making sure you rotate the rear of the drive 
down, pivoting on the front screws.

✎ When replacing the drive, transfer the four metric screws from the old drive to the new one. The 
screws take the place of drive rails. 
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7.11.4 Primary Hard Drive 
A Torx T-15 screwdriver is needed to remove and install the guide screws on a hard drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. Refer to Section 5.2, “Electrostatic Discharge Information” for more 
information about preventing electrostatic damage.

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. If you have locked the Smart Cover Lock, use Computer Setup to unlock the lock 
(Section 7.2).

2. Prepare the computer for disassembly (Section 7.1).

3. Remove the computer cover (Section 7.5).

4. Rotate the drive cage to its upright position by pulling on the green-tabbed lip.

✎ It is not necessary to remove the drives from the drive cage.
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5. Remove the security clip that secures the backwall to the power supply.

6. Rotate the power supply to its full upright position. 
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7. Disconnect the power and data cables from the back of the hard drive.

8. Pull the tab that locks the drive in place away from the drive 1, slide the hard drive toward 
the front of the computer, then lift it up and out of the bay 2.

To install a hard drive, reverse the above procedure.

✎ The replacement hard drive kit includes several data cables. Make sure to use the cable that is 
exactly the same as the factory-installed cable.

✎ If the system has only one SATA hard drive, the data cable must be connected to the dark blue 
connector labeled SATA0 first to avoid any hard drive performance problems.
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✎ When replacing the hard drive, transfer the four screws from the old drive to the new one. The 
screws take the place of drive rails. You will need a Torx T-15 screwdriver to remove and 
re-install the guide screws. HP has provided four extra 6-32 standard guide screws on the front of 
the chassis, under the computer cover. The 6-32 standard guide screws are silver and are used 
only for the hard drive.

✎ If you replaced the primary hard drive, insert the Restore Plus! CD to restore the operating 
system, software drivers, and any software applications that were preinstalled on the computer. 
Follow the instructions in the guide included with the Restore Plus! CD. When the restore 
process has completed, reinstall any personal files that you backed up before replacing the hard 
drive.

7.12 Fan Shroud 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Lift up on the fan shroud 1, rotate the rear of the shroud up 2 (pivoting on its top front lip) 
and out of the chassis 3. 

When replacing the shroud, make sure that it does not get caught on the wires from either the fan 
or the speaker. 
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7.13 Front I/O Devices 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the two screws that secure the front I/O device to the chassis 1.

4. Rotate the drive cage to its full upright position.

5. Disconnect the front I/O cable from the system board.

6. Push the front I/O device into the chassis 2 and snake the cable through the tunnel 3 to 
remove the device from the chassis. 

To reinstall the front I/O device, reverse the removal procedure.
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7.14 Heatsink 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.12).

4. Disconnect the fan control cable from the system board.

5. Loosen the four captive screws that secure the heatsink to the system board tray.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

6. Lift the heatsink from atop the processor and set it on its side to keep from contaminating the 
work area with thermal grease.

When reinstalling the heatsink, make sure that its bottom has been cleaned with an alcohol wipe 
and fresh thermal grease has been applied to the top of the processor.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

Ä
CAUTION: Failure to install the fan shroud may cause the computer to overheat.
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7.15 Processor 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.12).

4. Disconnect the heatsink control cable from the system board and remove the heatsink 
(Section 7.14).

5. Rotate the locking lever to its full open position 1.

6. Raise and rotate the microprocessor retainer to its fully open position 2.

7. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 6.
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3. If reusing the existing heatsink, clean the bottom of the heatsink with the alcohol pad 
provided in the spares kit.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply thermal 
grease to the top of the processor from the syringe supplied in the spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the 
heatsink atop the processor.

5. Go to step 7.

6. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

7. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board. 

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be 
found on the Web at: http:\\h18000.www1.hp.com/support/files.
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7.16 Speaker 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.12).

4. Remove any memory modules that might interfere with the screwdriver used for removing 
the speaker.

5. Disconnect the speaker wire from the system board.

6. Remove the two screws that secure the speaker to the chassis 1.

7. Rotate the top of the speaker back to clear the lip on the top of the chassis, then lift the 
speaker up and out of the chassis 2.

To install the speaker, reverse the removal procedures.
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7.17 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the security clip.

4. Rotate the drive cage up and disconnect the power cables from all of the drives.

5. Disconnect the power cables from the system board.

6. Release the power supply cable from the cable retaining clips on the bottom of the chassis 
under the drive cage.

7. Disconnect the hood sensor from the system board and remove the sensor from the power 
supply if required (Section 7.3).
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8. Rotate the power supply to its full upright position 1, then lift the power supply straight up 
and out of the chassis 2.

To install the power supply, reverse the removal procedure.

Ä
CAUTION: When installing the power supply cables, make sure they are properly positioned so they 
are not cut by the drive cage and are not pinched by the rotating power supply.
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7.18 Chassis Fan 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the fan shroud (Section 7.12).

4. Disconnect the chassis fan cable from the system board. 

5. Remove the four screws that secure the fan to the chassis, then remove the fan from the 
chassis.

To install the chassis fan, reverse the removal procedure. Be sure to orient the air flow into the 
unit. The molded grille on the chassis fan should face the inside of the chassis. 
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7.19 System Board 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove all PCI and PCI Express expansion boards (Section 7.9).

4. Remove the fan shroud from the chassis (Section 7.11).

5. Remove the chassis fan from the chassis (Section 7.18)

6. Rotate the drive cage to its full upright position.

7. Remove the security clip (Section 7.4.1) and rotate the power supply to its full upright 
position.

8. Disconnect all data and power cables from the system board.
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9. Disconnect the serial port from the system board.

10. Disconnect the balance of the cables from the system board.

11. Remove the long mounting screw that secures the system board tray to the chassis.
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12. Slide the system board tray assembly towards the front of the chassis, about 6 mm (1/4 inch) 
and lift the system board up and out of the chassis.

13. Remove the heatsink from the system board and the system board tray (Section 7.14).

To install the system board, reverse the removal procedure.

✎ The heatsink should be installed on the system board before the system board is reinstalled in the 
chassis.

Ä
CAUTION: Before reinstalling the heatsink you must clean the top of the processor and the bottom of the 
heatsink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply thermal 
grease to the top of the processor from the syringe supplied in the spares kit.

✎ When reinstalling the system board it is important to secure the system board and tray to the 
chassis with the long retaining screw before performing any subsequent steps. 

Ä
CAUTION: When reconnecting the cables it is important that they be positioned so they do not interfere 
with the rotation of the drive cage or power supply.
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7.20 Drive Clutch Components
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove the optical drive and any other drive in the rotating drive cage (Section 7.11.2 and 
Section 7.11.3).

4. Remove the chassis fan (Section 7.18).

5. Remove the system board (Section 7.19).

6. Remove the five screws that secure the clutch base to the chassis.

7. Hold the drive cage in the up position while removing the clutch base from the floor of the 
chassis.

Ä
CAUTION: When moving the clutch base be careful not to damage the wires that are threaded through 
it.
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8. Hold the drive cage in the upright position while removing the two screws that secure the 
clutch finger assembly to the drive cage.

✎ The clutch finger assembly doe not have to be removed to remove the power switch.

To replace the drive clutch components, reverse the removal procedure.
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7.21 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer cover (Section 7.5).

3. Remove all drives from the rotating drive cage (Section 7.11.2 and Section 7.11.3).

4. Remove the chassis fan (Section 7.18).

5. Remove the system board (Section 7.19).

6. Remove the drive ckutch base (Section 7.20).

7. Disconnect the power switch/LED cable from the system board. 

8. Squeeze the switch holder retaining clips together at the front of the chassis 1 and push the 
switch assembly out of the chassis 2. Push the two LEDs out of the chassis 3.

9. If necessary, the LED holders may also be removed by squeezing the clips and pushing them 
out of the front of the chassis.

To install the power switch and LEDs, reverse the removal procedure. 
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7.22 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C).
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup (F10) 
Utility Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 7.1).

2. Remove the computer access panel (Section 7.5).

✎ It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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7.22.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.22.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery. When the battery pops up, lift it out 1.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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7.22.3 Type 3 Battery Holder
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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8
Removal and Replacement Procedures -

Ultra-Slim Desktop (USDT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

8.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 8.2, 
“External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any compact disc from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby,” or “Suspend” modes. The power cord should always be disconnected 
before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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8. If the PC is mounted in the accessory mounting stand, loosen the thumbscrew that secures 
the computer to the stand 1.

9. Slide the computer forward until it is disengaged from the hooks on the front of the tower 
stand, then lift the computer off the stand 2 and lay the computer down on its rubber feet.
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8.2 External Security Devices

8.2.1 Installing a Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 

8.2.2 Installing a Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
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8.3 Computer Access Panel 
1. Prepare the computer for disassembly (Section 8.1).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Lay the computer down so the rubber feet rest on a solid surface.

3. Loosen the captive thumbscrew 1 that secures the access panel to the computer chassis. 

4. Slide the top access panel back about 1.3 cm, (1/2 inch), then lift it off the unit 2.

To install the access panel, reverse the removal procedure.



Service Reference Guide, dc7700 433612-001 8–5

Removal and Replacement Procedures - Ultra-Slim Desktop (USDT) Chassis

8.4 Optical Drive

Ä
CAUTION: The flat ribbon cable at the back of the optical drive must be disconnected before either the 
front panel assembly or the optical drive are removed. Failure to remove the cable will result in destroying 
the cable.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the access panel (Section 8.3).

3. Push the release latch on the side of the optical drive towards the outside of the computer 1 
and slide the drive out of the computer through the front bezel 2.

4. Disconnect the flat ribbon cable from the back of the optical drive.
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Before the new optical drive can be used, the release latch must be attached.

1. Peel the backing off the adhesive on the release latch.

2. Without allowing the release latch to touch the optical drive, carefully align the holes on the 
release latch with the pins on the side of the optical drive. Make sure the release latch is 
oriented properly.

3. Insert the pin at the front of the optical drive into the hole at the end of the release latch 1, 
and press firmly.

4. Insert the second pin 2, and press the entire release latch firmly to fasten the latch securely 
to the optical drive.

To install the optical drive, reverse the removal steps.
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8.5 Front Panel Assembly
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Lift up on the two green locking levers on the left and right sides of the chassis. This will 
unlatch the front panel assembly and push it about 1.3 cm (1/2 inch) out of the chassis. The 
assembly will automatically stop at that distance.

4. Disconnect the fan and speaker cables from the system board. 

5. Lift the left lever again 1 and pull the front panel assembly straight out of the chassis 2.

To reinstall the front panel assembly, reverse the removal procedure.



8–8 433612-001 Service Reference Guide, dc7700

Removal and Replacement Procedures - Ultra-Slim Desktop (USDT) Chassis

8.6 Front Bezel
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the fan and speaker cables from the system board. 

5. Remove the front panel assembly (Section 8.5).

6. Use a #0 Phillips screwdriver to remove the four screws that secure the front bezel to the 
front panel assembly 1.

7. Release the catch 2 that keeps the top of the bezel in place. 

8. Pull the front bezel away from the assembly 3.

To reinstall the front bezel, reverse the removal procedures.
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8.7 Chassis Fan
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the fan and speaker cables from the system board. 

5. Remove the front panel assembly (Section 8.5).

6. Remove the four screws that secure the chassis fan to the housing 1.

7. Remove the fan 2.

To install the fan assembly, reverse the removal procedures, making sure that the fan cable is 
located near the top of the assembly nearest the center of the front panel assembly.
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8.8 Speaker 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the fan and speaker cables from the system board.

5. Remove the front panel assembly (Section 8.5).

6. Remove the two screws 1 that secure the speaker to the front panel then remove the 
speaker 2.

To install the speaker, reverse the removal procedure.
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8.9 Cable Management
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the 
parts are moved.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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8.9.1 Cable Connections
All cable connectors on the system board are color-coded for ease of installation. 

System Board Connections

Power Supply Connections

System Board Connector Description

Optical data/power P21, SECONDARY

Heatsink fan P8, CPU FAN

Chassis fan P9, CH FAN

Front LED/Power button P5, PB/LED, (black)

Front I/O USB P24, FRNT USB, (yellow)

Front I/O audio P23, FRNT AUD, (blue)

Speaker P6, SPKR

Serial port A P54, COM A

Parallel connector P126, PAR

Hood sensor P125, HSENSE

SATA hard drive P60, SATA0, (dark blue)

Connector ID Description

P1 Main power

P2 Hard drive

P3 CPU power
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8.10 Memory 

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you are discharged of static electricity by briefly touching 
a grounded metal object. Refer to Section 5.2, “Electrostatic Discharge Information” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

✎ You many need to remove the expansion card cage if it has a full-height card installed.

3. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. If you are replacing a memory module, place it in the socket vacated by its 
predecessor. Push the module down into the socket, ensuring that the module is fully inserted 
and properly seated. Make sure the latches are in the closed position 3.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 

4. Repeat step 3 for any additional modules that you want to install.
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✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

8.11 Expansion Card Cage
The computer supports two different expansion card cages:

■ a PCI Express card cage that will support a full-height, full-length PCI Express X16 card

■ a standard PCI card cage that will support a full-height, 6.60-in. long PCI card

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Rotate the bail handle on the expansion card cage 1 and lift the cage straight up 2.

A PCI Express card cage is illustrated.

To install the cage, align the cage in the guides on the chassis and press it firmly into place.
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8.12 Expansion Card
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Open the latch 1 by squeezing the retainer fingers together and rotate the latch out of the 
way 2. 

If removing a standard PCI card continue with step 5.

If removing a PCI Express card go to step 7.

5. For a standard PCI expansion card, lay the card cage on its edge and hold it firmly in place. 
Grasp the card and carefully rock it back and forth until the connectors pull free from the 
card cage. Pull the expansion card straight out 3 to remove it from the cage. Be sure not to 
scrape the card against the cage. 

Store the removed card in anti-static packaging.

6. If you are not installing a new expansion card, install an expansion slot cover to close the 
open slot and continue with step 8.

If you are installing a new expansion card, continue with step 8.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot 
cover for proper cooling of internal components during operation.
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7. For a PCI Express expansion card, lay the card cage on its edge and hold it firmly in place. 
Pull the retention arm on the back if the PCI Express expansion socket away from the card 
and carefully rock it back and forth until the connectors pull free from the card cage. Pull the 
expansion card straight out (3) to remove it from the cage. Be sure not to scrape the card 
against the cage.

8. Slide the bracket on the end of the expansion card down into the slot and press the card 
firmly into the socket. 

✎ When you install an expansion card, make sure you press firmly on the card so that the whole 
connector seats properly in the expansion card socket on the riser board.

9. Close the latch firmly to secure the card in place.

10. Install the expansion card cage into the computer.

11. Reconfigure the computer, if necessary. Refer to the Computer Setup (F10) Utility Guide on 
the Documentation and Diagnostics CD for instructions about using Computer Setup.
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8.13 Expansion Card Retaining Latch
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the expansion card cage (Section 8.11).

4. Open the latch 1 by squeezing the retainer fingers together, then rotate the latch out of the 
way 2. 

5. Use a thin, flat-blade screwdriver to pry the damaged locking lever off the expansion card 
cage 3. 

6. Remove the locking lever.

To install the replacement locking lever, spread the pivot pin area and push it onto the ear of the 
expansion card cage so the pins snap into their receptacles.

Complete the assembly by locking the expansion card in place and reinstalling the expansion 
card cage.
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8.14 Hard Drive 
A Torx T-15 screwdriver is needed to remove and install the guide screws on a hard drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. Refer to Section 5.2, “Electrostatic Discharge Information” for more 
information about preventing electrostatic damage.

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Remove the optical drive (Section 8.4).

4. Disconnect the three front I/O, fan, and speaker cables from the system board. 

5. Remove the front panel assembly (Section 8.5).

6. Disconnect the power and data cables from the hard drive. 



Service Reference Guide, dc7700 433612-001 8–19

Removal and Replacement Procedures - Ultra-Slim Desktop (USDT) Chassis

7. Pull the drive release lever away from the hard drive 1, then lift the cable-end of the drive 
up 2 and pull it towards the center of the chassis 3 to remove it from the drive cage.

Follow proper cable management techniques when handling all cables (Section 8.9).

8. Remove the four guide screws (two on each side) from the old drive. You will need these 
screws to install a new drive.

9. Store the removed drive in anti-static packaging.

To install a drive, reverse the removal procedure.

Ä
CAUTION: When installing the hard drive, ensure that cable are not cut or pinched.
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8.15 Front I/O Device 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Remove the front panel assembly (Section 8.5).

5. Disconnect the three front I/O, fan, and speaker cables from the system board. 

6. Remove the hard drive (Section 8.14).

7. Remove the two screws that hold the front I/O device in place 1.

8. Remove the I/O device assembly from the chassis to access the audio cable.

9. Disconnect the audio cable from the system board and pull that cable through the tunnel 
opening in the chassis.

10. Disconnect the remaining I/O cables from the system board.

To install the front I/O device, follow this sequence:

1. Thread the audio cable through the tunnel in the chassis and attach it to the front I/O board.

2. Attach the front USB cable and the power switch/LED cable to the front I/O board.

3. Attach the front I/O board to the chassis with two screws.

4. Plug the cables into the system board.

✎ All cables are color coded to match their connectors on the front I/O board and are keyed to 
prevent improper connections.
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8.16 Heatsink Assembly 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the three front I/O, fan, and speaker cables from the system board.

5. Remove the front panel assembly (Section 8.5).

6. Disconnect the heatsink fan cable from the system board.

7. Unscrew the four screws that secure the heatsink to the system board, then lift the heatsink 
with the shroud from the system board.

Ä
CAUTION: Heatsink retaining screws should be removed in diagonally opposite pairs (as in an X) to 
even the downward forces on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

8. Lay the heatsink on its top in a safe area to prevent the thermal grease from contaminating 
the work surface.

If resuing the existing heatsink go to step 1.

If uisng a new heatsink, go to step 3.

1. If reusing the existing heatsink, clean bottom of the heatsink and apply the thermal grease 
provided in the spares kit to the top of the processor.

2. Position the heatsink atop the processor

3. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

4. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable and the thermal sensor cable to the system board.
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Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

8.17 Processor
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the three front I/O, fan, and speaker cables from the system board.

5. Remove the front panel assembly (Section 8.5).

6. Remove the heatsink (Section 8.16).

7. Rotate the processor locking lever to its full open position 1.

8. Raise and rotate the microprocessor retainer to its fully open position 2.

9. Carefully lift the processor from the socket 3. 

Ä
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling 
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the 
system board.

Ä
CAUTION: The heatsink must be installed within 24 hours of installing the processor to prevent damage 
to the processor’s solder connections.

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3.

If using a new heatsink, go to step 5.
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3. If reusing the existing heatsink, clean bottom of the heatsink and apply the thermal grease 
provided in the spares kit to the top of the processor.

4. Position the heatsink atop the processor.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the 4 captive screws and 
attach the heatsink control cable to the system board.

Ä
CAUTION: Heatsink retaining screws should be tightened in diagonally opposite pairs (as in an X) to 
evenly seat the heatsink on the processor. This is especially important as the pins on the socket are very 
fragile and any damage to them may require replacing the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the latest version of the BIOS is being used on the computer. The latest system BIOS can be 
found on the Web at: http://h18000.www1.hp.com/support/files.
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8.18 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment, the power cord should 
be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the power supply cable from the hard drive and the 6-pin power supply cable on 
the system board alongside the heatsink.

5. Slide the power supply towards the front of the chassis 1 about 1.3 cm (1/2 inch) then slide 
it towards the center of the chassis and rotate it up 2 to access the main cable connection 
beneath it.

6. Disconnect the power cable from the system board.

✎ There are slots on the chassis that match with clips on the bottom of the power supply for positive 
retention.

7. Remove the power supply from the chassis.

To install the power supply, reverse the removal procedure. Make sure the power supply engages 
the clips on the chassis when sliding it into place.

✎ When installing the power supply make sure the cables are routed properly and do not interfere 
with the access panel installation.
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8.19 System Board 
1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove the optical drive (Section 8.4).

4. Disconnect the three front I/O, fan, and speaker cables from the system board.

5. Remove the front panel assembly (Section 8.5).

6. Remove the memory modules (Section 8.10).

7. Remove the expansion card cage (Section 8.11).

8. Remove the hard drive (Section 8.14).

9. Remove the heatsink (Section 8.16).

10. Remove the power supply (Section 8.18).

11. Disconnect all cables connected to the system board, noting their location for reinstallation.

12. Remove the thumbscrew that secures the system board to the chassis 1. 

13. Slide the system board towards the front of the chassis 2, making sure that all keyhole 
retainers are clear before lifting the system board from the chassis.

Ä
CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.

To install the system board, reverse the removal procedure.

✎ When installing the system board make sure that the board is pressed firmly against the floor of 
the chassis to allow the keys to lock into the keyhole slots on the system board.
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8.20 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C).
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Computer Setup (F10) 
Utility Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 8.1).

2. Remove the computer access panel (Section 8.3).

3. Remove athe optical drive (Section 8.4).

4. Disconnect the three front I/O, fan, and speaker cables from the system board.

5. Remove the power supply to access the battery (Section 8.18).

6. Depending on the type of battery holder on the system board, complete the following 
instructions to replace the battery:
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8.20.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. After the battery has been replaced, reverse the disassembly procedure.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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8.20.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp 1 that extends above one 

edge of the battery. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 
with the positive side up 2. Push the other edge down until the clamp snaps over the other 
edge of the battery.

3. After the battery has been replaced, reverse the disassembly procedure.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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8.20.3 Type 3 Battery Holder
1. Pull back on the clip 1 that holds the battery in place, then remove the battery 2.

2. Insert the new battery and position the clip back in place.

3. After the battery has been replaced, reverse the disassembly procedure.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide.
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A
Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. 
Some of these connectors may not be used on the product being serviced.

Keyboard
Connector and Icon Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Mouse
Connector and Icon Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Ethernet BNC
Connector and Icon Pin Signal

1 (Center) Data

2 (Shield) Ground
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Ethernet RJ-45
Connector and Icon Pin Signal

1
2
3
4

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused

5
6
7
8

Unused
(-) Receive Data
Unused
Unused

Ethernet AUI

Connector and Icon

Pin Signal Pin Signal

1
2
3
4

Ground
Negative AUI Differential Collision
Positive AUI Differential Collision
Negative AUI Differential Transmit

9
10
11
12

Positive AUI Differential Receive
+12V
Ground
Ground

5
6
7
8

Positive AUI Differential Transmit
Ground
Ground
Negative AUI Differential Receive

13
14
15
16

Unused
Unused
Unused
Unused

Parallel Interface

Connector and Icon

Pin Signal Pin Signal Pin Signal

1
2
3

Strobe
Data Bit 0
Data Bit 1

7
8
9

Data Bit 5
Data Bit 6
Data Bit 7

13
14
15

Select
Auto Linefeed
Error

4
5
6

Data Bit 2
Data Bit 3
Data Bit 4

10
11
12

Acknowledge
Busy
Paper End

16
17
18-25

Initialize Printer
Select IN
Signal Ground
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Serial Interface, Powered and Non-Powered
Connector and Icon Pin Signal

1
2
3

Carrier Detect (12V if powered)
Receive Data
Transmit Data

4
5
6

Data Terminal Ready
Signal Ground
Data Set Ready

7
8
9

Request to Send
Clear to Send
Ring Indicator (5V if powered)

USB
Connector and Icon Pin Signal

1
2
3
4

+5 VDC
- Data
+ Data
Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_left

2 (Ring) Power_Right

3 (Shield) Ground

1 2 31 2 3

Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Left

2 (Ring) Audio_Right

3 (Shield) Ground

1 2 3

Line-In Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left

2 (Ring) Audio_In_Right

3 (Shield) Ground

1 2 3
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Line-Out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left

2 (Ring) Audio_Out_Right

3 (Shield) Ground

1 2 3

External Infrared Transceiver
Connector and Icon

Pin Signal Pin Signal Pin Signal

1
2
3

Transmit
Receive
Ground

4
5
6

5V
Mode
Not Used

7
8

Not Used
Not Used

Monitor
Connector and Icon

Pin Signal Pin Signal Pin Signal

1
2
3

Red Analog
Green Analog
Blue Analog

6
7
8

Ground
Ground
Ground

11
12
13

Not used
DDC Serial Data
Horizontal Sync

4
5

Not used
Ground

9
10

+5V (fused)
Ground

14
15

Vertical Sync
DDC Serial Clock
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ATA/ATAPI (IDE) Standard Drive Cable
Connector

Pin Signal Pin Signal Pin Signal

1
2
3
4
5

Reset
Ground
DD7
DD8
DD6

15
16
17
18
19

DD1
DD14
DD0
DD15
Ground

29
30
31
32
33

DMAK
Ground
INTRQ
IOCS16
DA1

6
7
8
9
10

DD9
DD5
DD10
DD4
DD11

20
21
22
23
24

(Key)
DMARQ
Ground
DIOW
Ground

34
35
36
37
38

PDIAG (cable detect)
DA0
DA2
CS1FX
CS3FX

11
12
13
14

DD3
DD12
DD2
DD13

25
26
27
28

DIOR
Ground
IORDY
CSEL

39
40

DASP
Ground

CD-ROM 50-Pin Connector
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5

Audio L-ch
Audio R-ch
Audio GND
GND
RESET-

14
15
16
17
18

DD12
DD3
DD13
DD2
DD14

27
28
29
30
31

IORDY
DMACK-
INTRQ
IOCS16-
DA1

40
41
42
43
44

+5V
+5V
+5V
GND
GND

6
7
8
9
10

DD8
DD7
DD9
DD6
DD10

19
20
21
22
23

DD1
DD15
DD0
DMARQ
GND

32
33
34
35
36

PDIAG-
DAO
DA2
CS1FX-
CS3FX-

45
46
47
48
49

GND
GND
CSEL
GND
Vendor-specific

11
12
13

DD5
DD11
DD4

24
25
26

DIOR-
DIOW-
GND

37
38
39

DASP-
+5V
+5V

50 Vendor-specific
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24-Pin Power (CMT and MT models)
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5
6

+3.3 V
+3.3 V
GND
+5 V
GND
+5 V

7
8
9
10
11
12

GND
POK
+5 Vaux
+12 V
+12 V
+3.3 V

13
14
15
16
17
18

+3.3 V
-12 V
GND
PSON
GND
GND

19
20
21
22
23
24

GND
open
+5 V
+5 V
+5 V
GND

24

12

13

1

24-Pin MicroFit Power (USDT, SFF, and ST models)
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5
6

+5 Vaux
GND
+5 V
+5 V
PS_ON
GND

7
8
9
10
11
12

PWRGD
+3.3 V
+3.3 V
Tach
GND
Fan-CMD

13
14
15
16
17
18

+12 V
+5 V Sense
GND
+5 V
+5 V
+3.3 V

19
20
21
22
23
24

GND
+3.3 Sense
+3.3 V
+3.3 V
GND
-12 V

24

12

13�

1

4-Pin Power (for CPU) (MT and CMT models)
Connector and Icon Pin CMT and MT Signal

1 GND

2 GND

3 +12 V CPU

4 -12 V CPU
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6-Pin Power (for CPU) (USDT, SFF, and ST models)
Connector and Icon Pin Signal

1 GND

2 GND

3 GND

4 12 V CPU

5 12 V CPU

6 +12 V 

64

SATA Data and Power 

Drive Connector

Pin Signal Pin Signal Pin Signal Pin Signal

S1
S5

Ground
B-

S2
S6

A+
B+

S3
S7

A-
Ground

S4 Ground

P1
P5
P9
P13

V 3.3
Ground
V 5
V 12

P2
P6
P10
P14

V 3.3
Ground
Ground
V 12

P3
P7
P11
P15

V 3.3
V 5
Reserved
V 12

P4
P8
P12

Ground
V 5
Ground

*S = Data, P = Power
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PCI Express 
x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5

PRSNT1#
+12V
+12V
GND
JTAG2

6
7
8
9
10

JTAG3
JTAG4
JTAG5
+3.3v
+3.3v

11
12
13
14
15

PERST#
GND
REFCLK+
REFCLK-
GND

16
17
18
19
20

PERp0
PERn0
GND
RSVD
GND

21
22
23
24
25

PERp1
PERn1
GND
GND
PERp2

26
27
28
29
30

PERn(2)
GND
GND
PERp3
PERn3

31
32
33
34
35

GND
RSVD
RSVD
GND
PERp4

36
37
38
39
40

PERn4
GND
GND
PERp5
PERn5

41
42
43
44
45

GND
GND
PERp6
PERn6
GND

46
47
48
49
50

GND
PERp7
PERn7
GND
RSVD

51
52
53
54
55

GND
PERp8
PERn8
GND
GND

56
57
58
59
60

PERp9
PERn9
GND
GND
PERp10

61
62
63
64
65

PERn10
GND
GND
PERp11
PERn11

66
67
68
69
70

GND
GND
PERp12
PERn12
GND

71
72
73
74
75

GND
PERp13
PERn13
GND
GND

76
77
78
79
80

PERp14
PERn14
GND
GND
PERp15

81
82

PERn15
GND

Pin B information is on the next page
Notes:
x1 PCI Express uses pins 1-18
x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49
x16 PCI Express uses pins 1-8
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Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5

+12V
+12V
RSVD
GND
SMCLK

6
7
8
9
10

SMDAT
GND
+3.3v
JTAG1
3.3vAux

11
12
13
14
15

WAKE#
RSVD
GND
PETp0
PETn0

16
17
18
19
20

GND
PRSNT2#
GND
PETp1
PETn1

21
22
23
24
25

GND
GND
PETp2
PETn2
GND

26
27
28
29
30

GND
PETp3
PETn3
GND
RSVD

31
32
33
34
35

PRSNT2#
GND
PETp4
PETn4
GND

36
37
38
39
40

GND
PETp5
PETn5
GND
GND

41
42
43
44
45

PETp6
PRTn6
GND
GND
PETp7

46
47
48
49
50

PETn7
GND
PRSNT2#
GND
PETp8

51
52
53
54
55

PETn8
GND
GND
PETp9
PETn9

56
57
58
59
60

GND
GND
PETp10
PETn10
GND

61
62
63
64
65

GND
PETp11
PETn11
GND
GND

66
67
68
69
70

PETp12
PETn12
GND
GND
PETp13

71
72
73
74
75

PETn13
GND
GND
PETp14
PETn14

76
77
78
79
80

GND
GND
PETp15
PETn15
GND

81
82

PRSNT2#
RSVD

Notes:
x1 PCI Express uses pins 1-18
x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49
x16 PCI Express uses pins 1-82

PCI Express 
x1, x4, x8, and x16 PCI Express Connector
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DVI Connector
Connector and Icon

Pin Signal Pin Signal

1
2
3
4

T.M.D.S. Data2-
T.M.D.S. Data2+
T.M.D.S. Data2/4 Shield
T.M.D.S. Data4-

13
14
15
16

T.M.D.S. Data3+
+5V Power
Ground (for +5V)
Hot Plug Detect

5
6
7
8

T.M.D.S. Data4+
DDC Clock
DDC Data
No Connect

17
18
19
20

T.M.D.S. Data0-
T.M.D.S. Data0+
T.M.D.S. Data0/5 Shield
T.M.D.S. Data5-

9
10
11
12

T.M.D.S. Data1-
T.M.D.S. Data1+
T.M.D.S. Data1/3 Shield
T.M.D.S. Data3-

21
22
23
24

T.M.D.S. Data5+
T.M.D.S. Data Shield
T.M.D.S. Clock+
T.M.D.S. Clock-



Service Reference Guide, dc7700 433612-001 B–1

B
Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch 
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 
volts AC. Power supplies on those computers that do not have external power switches are 
equipped with internal switches that sense the incoming voltage and automatically switch to the 
proper voltage.

The power cord set received with the computer meets the requirements for use in the country 
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you 
use the computer.

General Requirements
The requirements listed below are applicable to all countries: 

1. The power cord must be approved by an acceptable accredited agency responsible for 
evaluation in the country where the power cord set will be installed. 

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a 
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system. 

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the 
cord must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items 
placed upon it or against it. Particular attention should be paid to the plug, electrical outlet, and 
the point where the cord exits from the product.

Å
WARNING: Do not operate this product with a damaged power cord set. If the power cord set is 
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

Ä
CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country
Accrediting

Agency Country
Accrediting

Agency

Australia (1)
Austria (1)
Belgium (1) 
Canada (2)

EANSW
OVE
CEBC
CSA

Italy (1)
Japan (3)
Norway (1)
Sweden (1)

IMQ
METI
NEMKO
SEMKO

Denmark (1)
Finland (1) 
France (1) 
Germany (1) 

DEMKO
SETI
UTE
VDE

Switzerland (1)
United Kingdom (1)
United States (2)

SEV
BSI
UL

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of 
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug 
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 
250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration 
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or 
VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole grounding type 
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C
POST Error Messages

POST Error Messages
An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs 
when the system is turned on, checking assemblies within the computer and reporting any errors 
found. 

Not all computers use all of the codes listed.

POST Error Messages

Screen Message Probable Cause Recommended Action

101-Option ROM 
Checksum Error

System ROM or 
expansion board option 
ROM checksum.

1. Verify the correct ROM.
2. Flash the ROM if needed.
3. If an expansion card was recently 

added, remove it and see if the 
problem remains. 

4. Clear CMOS.
5. If the message disappears, there 

may be a problem with the 
expansion card.

6. Replace the system board.

103-System Board 
Failure

DMA or timers. 1. Clear CMOS.
2. Remove expansion boards.
3. Replace the system board.

110-Out of Memory 
Space for Option 
ROMs

Recently added PCI 
expansion card contains 
an option ROM too large 
to download during 
POST.

1. If a PCI expansion card was recently 
added, remove it to see if the 
problem remains.

2. In Computer Setup, set Advanced 
> Device Options > NIC PXE 
Option ROM Download to 
Disable to prevent PXE option ROM 
for the internal NIC from being 
downloaded during POST to free 
more memory for an expansion 
card’s option ROM. Internal PXE 
option ROM is used for booting from 
the NIC to a PXE server.

3. Ensure that the ACPI/USB Buffers @ 
Top of Memory setting in Computer 
Setup is enabled.
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162-System Options Not 
Set

Configuration incorrect.
RTC (real-time clock) 
battery may need to be 
replaced. 

Run Computer Setup and check 
configuration in Advanced > 
Onboard Devices.
Reset the date and time under Control 
Panel. If the problem persists, replace 
the RTC battery.

163-Time & Date Not 
Set

Invalid time or date in 
configuration memory. 
RTC (real-time clock) 
battery may need to be 
replaced. 

Reset the date and time under Control 
Panel (Computer Setup can also be 
used). If the problem persists, replace the 
RTC battery. 

CMOS jumper may not 
be properly installed.

Check for proper placement of the 
CMOS jumper, if applicable.

164-Memory Size Error Memory amount has 
changed since the last 
boot (memory added or 
removed).

Press the F1 key to save the memory 
changes.

Memory configuration is 
incorrect.

1. Run Computer Setup (F10 Setup) or 
Windows utilities.

2. Make sure memory module(s) are 
installed properly.

3. If third party memory has been 
added, test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Run Computer Setup (F10 Setup) or 
Windows utilities.

2. Ensure memory modules are 
installed correctly.

3. Verify proper memory module type.
4. Remove and replace the identified 

faulty memory module(s).
5. If the error persists after replacing 

memory modules, replace the system 
board.

213-Incompatible 
memory Module in 
memory Socket(s) 
X,X, X

A memory module in 
memory socket identified 
in the error message is 
missing critical SPD 
information, or is 
incompatible with the 
chipset.

1. Verify proper memory module type.
2. Try another memory socket.
3. Replace memory with a module 

conforming to the SPD standard.

214-DIMM 
Configuration Warning

Populated DIMM 
configuration is not 
optimized.

Rearrange the DIMMS so that each 
channel has the same amount of 
memory.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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219-ECC Memory 
Module Detected. ECC 
Modules not supported 
on this platform

Recently added memory 
module(s) support ECC 
memory error correction.

1. If additional memory was recently 
added, remove it to see if the 
problem remains.

2. Check product documentation for 
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing 
pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

303-Keyboard 
Controller Error

I/O board keyboard 
controller.

1. Reconnect keyboard with computer 
turned off.

2. Replace the system board.

304-Keyboard or 
System Unit Error

Keyboard failure. 1. Reconnect the keyboard with 
computer turned off.

2. Ensure that none of the keys are 
depressed.

3. Replace keyboard.
4. Replace system board. 

404-Parallel Port 
Address Conflict 
Detected

Both external and internal 
ports are assigned to 
parallel port X.

1. Remove any parallel port expansion 
cards.

2. Clear CMOS.
3. Reconfigure card resources and/or 

run Computer Setup.

410-Audio Interrupt 
Conflict

IRQ address conflicts with 
another device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

411-Network Interface 
Card Interrupt Conflict

IRQ address conflicts with 
another device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

501-Display Adapter 
Failure

Graphics display 
controller.

1. Reseat the graphics card (if 
applicable).

2. Clear CMOS.
3. Verify that the monitor is attached 

and turned on.
4. Replace the graphics card (if 

applicable).

510-Flash Screen image 
corrupted

Flash Screen image has 
errors.

Reflash the system ROM with the latest 
BIOS image

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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511-CPU, CPUA, or 
CPUB Fan not detected

CPU fan is not connected 
or may have 
malfunctioned.

1. Reseat the CPU fan.
2. Reseat fan cable.
3. Replace the CPU fan.

512-Chassis, rear 
chassis, or front chassis 
fan not detected

Chassis, rear chassis, or 
front chassis fan is not 
connected or may have 
malfunctioned.

1. Reseat chassis, rear chassis, or front 
chassis fan.

2. Reseat fan cable.
3. Replace chassis, rear chassis, or 

front chassis fan.

514-CPU or Chassis Fan 
not detected.

CPU or chassis fan is not 
connected or may have 
malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.
3. Replace CPU or chassis fan.

601-Diskette Controller 
Error

Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

1. Run Computer Setup (F10 Setup).
2. Check and/or replace cables.
3. Clear CMOS.
4. Replace diskette drive. 
5. Replace the system board.

605-Diskette Drive Type 
Error

Mismatch in drive type. 1. Run Computer Setup (F10 Setup).
2. Disconnect any other diskette 

controller devices (tape drives).
3. Clear CMOS.

610-External Storage 
Device Failure

External tape drive not 
connected.

Reinstall tape drive or press F1 and 
allow system to reconfigure without the 
drive.

611-Primary Floppy Port 
Address Assignment 
Conflict

Configuration error. Run Computer Setup and check the 
configuration in Advanced > 
Onboard Devices.

660-Display cache is 
detected unreliable

Integrated graphics 
controller display cache 
is not working properly 
and will be disabled.

Replace system board if minimal 
graphics degrading is an issue.

912-Computer Cover 
Has Been Removed 
Since Last System Start 
Up

Computer cover was 
removed since the last 
system startup.

No action required.

917-Front Audio not 
Connected

Front audio harness has 
been detached or 
unseated from the system 
board.

Reconnect or replace front audio 
harness.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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918-Front USB Not 
Connected

Front USB harness has 
been detached or 
unseated from system 
board.

Reconnect or replace front USB harness.

921-Device in PCI 
Express slot failed to 
initialize.

There is an 
incompatibility/problem 
with this device and the 
system or PCI Express Link 
could not be retrained to 
an x1.

Try rebooting the system. If the error 
reoccurs, the device may not work with 
this system.

1151-Serial Port A 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM1.

1. Remove any serial port expansion 
cards.

2. Clear CMOS.
3. Reconfigure card resources and/or 

run Computer Setup or Windows 
utilities.

1152-Serial Port B 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM2.

1. Remove any serial port expansion 
cards.

2. Clear CMOS.
3. Reconfigure card resources and/or 

run Computer Setup or Windows 
utilities.

1155-Serial Port Address 
Conflict Detected

Both external and internal 
serial ports are assigned 
to same IRQ.

1. Remove any serial port expansion 
cards.

2. Clear CMOS.
3. Reconfigure card resources and/or 

run Computer Setup or Windows 
utilities.

1201-System Audio 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

1202-MIDI Port Address 
Conflict Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

1203-Game Port 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ 
in Advanced > Onboard Devices.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1720-SMART Hard 
Drive Detects Imminent 
Failure

Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an erroneous 
error message.)

1. Determine if hard drive is giving 
correct error message. Enter 
Computer Setup and run the Drive 
Protection System test under 
Storage > DPS Self-test.

2. Apply firmware patch if applicable 
(available at www.hp.com/support).

3. Back up contents and replace hard 
drive.

1796-SATA Cabling 
Error

One or more SATA 
devices are improperly 
attached. For optimal 
performance, the SATA 0 
and SATA 1 connectors 
must be used before 
SATA 2 and SATA 3.

Ensure SATA connectors are used in 
ascending order. For one device, use 
SATA 0. For two devices, use SATA 0 
and SATA 1. For three devices, use SATA 
0, SATA1, and SATA 2.

1797-SATA Drivelock is 
not supported in RAID 
mode.

Drivelock is enabled on 
one or more SATA hard 
drives, and they cannot 
be accessed while the 
system is configured for 
RAID mode.

Either remove the Drivelocked SATA 
device or disable the Drivelock feature. 
To disable the Drivelock feature, enter 
Computer Setup, change Storage > 
Storage Options > SATA 
Emulation to IDE, and select File > 
Save Changes and Exit. Reenter 
Computer Setup and select Security > 
Drivelock. For each listed 
Drivelock-capable SATA device, ensure 
Drivelock is Disabled. Lastly, change 
Storage > Storage Options > 
SATA Emulation back to RAID and 
select File > Save Changes and 
Exit.

1801-Microcode Patch 
Error

Processor not supported 
by ROM BIOS.

1. Upgrade BIOS to proper version.
2. Change the processor.

2200-PMM Allocation 
Error during MEBx 
Download

Memory error during 
POST execution of the 
Management Engine 
(ME) BIOS Extensions 
option ROM

1. Reboot the computer.
2. Unplug the power cord, re-seat the 

memory modules, and reboot the 
computer.

3. If the memory configuration was 
recently changed, unplug the 
computer, restore the original 
memory configuration, and reboot 
the computer.

4. If the error persists, replace the 
system board.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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2201-MEBx Module did 
not checksum correctly

Memory error during 
POST execution of the 
Management Engine 
(ME) BIOS Extensions 
option ROM

1. Reboot the computer.
2. Unplug the power cord, re-seat the 

memory modules, and reboot the 
computer.

3. If the memory configuration was 
recently changed, unplug the power 
cord, restore the original memory 
configuration, and reboot the 
computer.

4. If the error persists, replace the 
system board.

2202-PMM 
Deallocation Error 
during MEBx cleanup

Memory error during 
POST execution of the 
Management Engine 
(ME) BIOS Extensions 
option ROM

1. Reboot the computer.
2. Unplug the power cord, re-seat the 

memory modules, and reboot the 
computer.

3. If the memory configuration was 
recently changed, unplug the power 
cord, restore the original memory 
configuration, and reboot the 
computer.

4. If the error persists, replace the 
system board.

2203-Setup error 
during MEBx execution

MEBx selection or exit 
resulted in a setup failure. 1. Reboot the computer.

2. Unplug the power cord, re-seat the 
memory modules, and reboot the 
computer.

3. If the memory configuration was 
recently changed, unplug the power 
cord, restore the original memory 
configuration, and reboot the 
computer.

4. If the error persists, replace the 
system board.

2204-Inventory error 
during MEBx execution

BIOS information passed 
to the MEBx resulted in a 
failure.

1. Reboot the computer.
2. If the error persists, update to the 

latest BIOS version.
3. If the error still persists, replace the 

system board.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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2205-Interface error 
during MEBx execution

MEBx operation 
experienced a hardware 
error during 
communication with ME.

1. Reboot the computer.
2. If the error persists, update to the 

latest BIOS version.
3. If the error still persists, replace the 

system board.

Invalid Electronic Serial 
Number.

Electronic serial number 
has become corrupted.

1. Run Computer Setup. If Setup 
already has data in the field or will 
not allow the serial number to be 
entered, download from 
http://www.hp.com and run 
SP5572.EXE (SNZERO.EXE).

2. Run Computer Setup and try to enter 
serial number under Security, System 
ID, then save changes.

Network Server Mode 
Active and No 
Keyboard Attached

Keyboard failure while 
Network Server Mode 
enabled.

1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing 
pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and diagnostic 
utilities.

System will not boot 
without fan.

CPU fan not installed or 
disconnected in VSFF 
chassis.

1. Remove the computer cover, press 
the power button, and see if the 
processor fan spins. If not spinning, 
make sure the fan cable is plugged 
onto the system board header. 
Ensure the heatsink is properly 
seated and installed.

2. If the fan is plugged in and the 
heatsink is properly seated but the 
fan does not spin, then replace the 
heatsink-fan assembly.

POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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POST Diagnostic Front Panel LEDs and Audible Codes
This section covers the front panel LED codes as well as the audible codes that may occur before 
or during POST that do not necessarily have an error code or text message associated with them.

Å
WARNING: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

Look for the LED between the DIMM sockets. If the LED is illuminated, the system still has power. Power off 
the computer and remove the power cord before proceeding.

✎ If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be 
performed.

No all diagnostic lights and audible codes are available on all models.

POST Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds.

None Computer in 
Suspend to RAM 
mode (some 
models only) or 
normal Suspend 
mode.

None required. Press any key or move the 
mouse to wake the computer.

Red Power LED 
flashes two times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

2 Processor thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The heatsink/fan 
assembly is not 
properly attached 
to the processor. 

1. Ensure that the computer air vents are 
not blocked and the processor cooling 
fan is running.

2. Open hood, press power button, and 
see if the processor fan spins. If the 
processor fan is not spinning, make 
sure the fan's cable is plugged onto 
the system board header.

3. If fan is plugged in, but is not 
spinning, then replace heatsink-fan 
assembly.



C–10 433612-001 Service Reference Guide, dc7700

POST Error Messages

Red Power LED 
flashes three times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

3 Processor not 
installed (not an 
indicator of bad 
processor).

1. Check to see that the processor is 
present.

2. Reseat the processor.

Red Power LED 
flashes four times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

4 Power failure 
(power supply is 
overloaded).

1. Open the hood and ensure the 4 or 
6-wire power supply cable is seated 
into the connector on the system 
board.

2. Check if a device is causing the 
problem by removing ALL attached 
devices (such as hard, diskette, or 
optical drives, and expansion cards). 
Power on the system. If the system 
enters the POST, then power off and 
replace one device at a time and 
repeat this procedure until failure 
occurs. Replace the device that is 
causing the failure. Continue adding 
devices one at a time to ensure all 
devices are functioning properly.

3. Replace the power supply.
4. Replace the system board.

Red Power LED 
flashes five times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

5 Pre-video memory 
error.

Ä To avoid damage to the DIMMs or the 
system board, you must unplug the 
computer power cord before 
attempting to reseat, install, or remove 
a DIMM module.

1. Reseat DIMMs.
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory with HP 

memory.
4. Replace the system board.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes six times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

6 Pre-video 
graphics error. 

For systems with a graphics card:
1. Reseat the graphics card.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.

Red Power LED 
flashes seven 
times, once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

7 System board 
failure (ROM 
detected failure 
prior to video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

8 Invalid ROM 
based on bad 
checksum.

1. Reflash the ROM with the latest BIOS 
image. See the “Boot Block 
Emergency Recovery Mode” section of 
the Desktop Management Guide on 
the Documentation and Diagnostics 
CD.

2. Replace the system board.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes nine times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

9 System powers on 
but is unable to 
boot.

1. Check that the voltage selector, 
located on the rear of the power 
supply (some models), is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.

2. Replace the system board.
3. Replace the processor.

Red Power LED 
flashes ten times, 
once every 
second, followed 
by a two second 
pause. Beeps stop 
after fifth iteration 
but LEDs continue 
until problem is 
solved.

10 Bad option card. 1. Check each option card by removing 
the card (one at a time if multiple 
cards), then power on the system to 
see if fault goes away.

2. Once a bad card is identified, remove 
and replace the bad option card.

3. Replace the system board.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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System does not 
power on and 
LEDs are not 
flashing.

None System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED turns 
green, the power button is working 
correctly. Try the following:

1. Check that the voltage selector (some 
models), located on the rear of the 
power supply, is set to the appropriate 
voltage. Proper voltage setting 
depends on your region.

2. Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED does 
not turn on green then:

1. Check that the unit is plugged into a 
working AC outlet.

2. Open hood and check that the power 
button harness is properly connected 
to the system board.

3. Check that both power supply cables 
are properly connected to the system 
board.

4. Check to see if the 5 V_aux light on 
the system board is turned on. If it is 
turned on, then replace the power 
button harness.

5. If the 5 V_aux light on the system 
board is not turned on, remove the 
expansion cards one at a time until 
the 5 V_aux light on the system board 
turns on. If the problem persists, 
replace the power supply.

POST Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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D
Troubleshooting Without Diagnostics

Preliminary Checklist
This section describes some simple, preliminary tests and guidelines for troubleshooting the 
computer without using the diagnostics.

■ Are the computer and monitor connected to a working electrical outlet?

■ Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?

■ Is the computer turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed 
(embedded video on some models only) and a single monitor, the monitor must be plugged 
into the monitor connector on the source selected as the primary VGA adapter. During boot, 
the other monitor connectors are disabled and if the monitor is connected into these ports, the 
monitor will not function. You can select which source will be the default VGA source in 
Computer (F10) Setup.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the computer after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all bootable media (diskette, CD, or USB device) from the system before turning on 
the system.

■ Are all switches set correctly?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?
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Solving Minor Problems

Solving Minor Problems
Problem Cause Possible Solution

Computer appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

1. Press and hold the power button 
for at least four seconds until the 
computer turns off.

2. Disconnect electrical plug from 
outlet.

Computer will not 
respond to USB 
keyboard or mouse.

Computer is in 
standby mode.

Press the power button or press any 
key to resume from standby mode.

ÄWhen attempting to resume from 
standby mode, do not hold 
down the power button for more 
than four seconds. Otherwise, 
the computer will shut down and 
you will lose any unsaved data.

System has locked up. Restart computer.

Computer date and 
time display is incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

✎ Connecting the 
computer to a live 
AC outlet prolongs 
the life of the RTC 
battery.

1. Reset the date and time under 
Control Panel. Computer Setup 
can also be used.

2. Replace the RTC battery.

Computer appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is established.

Establish a network connection, or 
use Computer Setup or Microsoft 
Windows Device Manager to disable 
the network controller.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The Num 
Lock key can be disabled (or 
enabled) in Computer Setup.

There is no sound or 
sound volume is too 
low.

There is no sound or 
sound volume is too low.

1. Check the F10 BIOS settings to 
make sure the internal system 
speaker is not muted (this setting 
does not affect the external 
speakers).

2. Make sure the external speakers 
are properly connected and 
powered on and that the 
speakers' volume control is set 
correctly.

3. Use the system volume control 
available in the operating system 
to make sure the speakers are not 
muted or to increase the volume.
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Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

1. Unlock the Smart Cover Lock 
using Computer Setup.

2. Use the Smart Cover FailSafe Key 
in case of forgotten password, 
power loss, or computer 
malfunction.

Poor performance is 
experienced.

Processor is hot. 1. Ensure airflow to the computer is 
not blocked. Leave a 10.2-cm 
(4-inch) clearance on all vented 
sides of the computer and above 
the monitor to permit the required 
airflow.

2. Ensure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Ensure the processor heatsink is 
installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously 
accessed did not release 
reserved memory back to 
the system

Restart the computer.

Virus resident of the hard 
drive.

Run virus protection program.

Too many applications 
running.

1. Close unnecessary applications.
2. Add more memory.

Some software 
applications, especially 
games, are stressful on the 
graphics subsystem.

1. Lower the display resolution for 
the current application or consult 
the documentation that came with 
the application for suggestions on 
how to improve performance by 
adjusting parameters in the 
application.

2. Add more memory.
3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Computer powered off 
automatically and the 
Power LED flashes Red 
two times, once every 
second, followed by a 
two second pause, and 
the computer beeps two 
times. Beeps continue 
for five iterations after 
which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked or 
not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure computer air vents are not 
blocked and the cooling fan is 
running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If not spinning, make sure 
the fan's cable is plugged onto 
the system board header.

3. Replace the processor 
heatsink-fan assembly.

System does not power 
on and the LEDs on the 
front of the computer 
are not flashing.

System unable to power 
on.

Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED turns green, then:

1. Check that the voltage selector, 
located on the rear of the power 
supply on some models, is set to 
the appropriate voltage. Proper 
voltage setting depends on your 
region.

2. Remove the expansion cards one 
at a time until the 5V_aux light on 
the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for 
less than 4 seconds. The hard drive 
LED does not turn on green.

1. Check that the unit is plugged 
into a working AC outlet.

2. Open hood and check that the 
power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. Check to see if the 5V_aux light 
on the system board is turned on. 
If it is turned on, then replace the 
power button harness.

5. If the 5V_aux light on the system 
board is off, then replace the 
power supply.

6. Replace the system board.

Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems

Solving Power Supply Problems
Problem Cause Solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of computer 
chassis (some models) is 
not switched to correct 
line voltage (115V or 
230V).

Select the proper AC voltage using 
the selector switch.

Power supply will not 
turn on because of 
internal power supply 
fault.

Replace the power supply.

Computer powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps two times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink/fan 
assembly is not properly 
attached to the 
processor.

1. Ensure that the computer air 
vents are not blocked and the 
cooling fan is running.

2. Open hood, press the power 
button, and see if the processor 
fan spins. If the processor fan is 
not spinning, make sure the 
fan's cable is plugged onto the 
system board header.

3. If the fan is pugged in and 
seated but not spinning, replace 
the processor fan.
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Power LED flashes Red, four 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps four times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector 
(some models), is set to the 
appropriate voltage. Proper 
voltage depends on the region.

2. Open the hood and ensure the 
4- or 6-wire power supply cable 
is seated into the connector on 
the system board.

3. Check if a device is causing the 
problem by removing ALL 
attached devices (such as hard, 
diskette or optical drives, and 
expansion cards). Power on the 
system. If the system enters the 
POST, then power off and 
replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the 
device causing the failure. 
Continue adding devices one at 
a time to ensure all devices are 
functioning properly.

4. Replace the power supply.
5. Replace the system board.

Solving Power Supply Problems (Continued)

Problem Cause Solution
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Solving Diskette Problems

Solving Diskette Problems
Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive cable is not 
properly connected.

Reconnect power cable. Ensure that 
all four pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cables.

Removable drive is not 
seated properly.

Reseat the drive.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.
1. From Windows Explorer select 

the disk (A) drive.
2. Right-click the drive letter and 

select Format.
3. Select the desired options, and 

click Start to begin formatting 
the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is 
left on the diskette.

1. Use another diskette.
2. Delete unneeded files from 

diskette.

Legacy diskette writes 
are disabled in 
Computer Setup.

Enter Computer Setup and enable 
Legacy Diskette Write in 
Storage > Storage Options.

Diskette is damaged. Replace the damaged diskette.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be 
write-protected.

Open the locking device on the 
diskette.
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Cannot format diskette.
(continued)

Legacy diskette writes 
are disabled in 
Computer Setup.

Enter Computer Setup and enable 
Legacy Diskette Write in 
Storage > Storage Options.

A problem has occurred 
with a disk transaction.

The directory structure is 
bad, or there is a 
problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

You are using the wrong 
diskette type for the 
drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart the computer by pressing the 
power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

1. Run Computer Setup and 
enable diskette boot in 
Storage > Boot Order.

2. Run Computer Setup and 
enable diskette boot in 
Storage > Storage 
Options > Removable 
Media Boot.

✎ Both steps should be used as 
the Removable Media 
Boot function overrides the 
Boot Order enable 
command.

Network server mode is 
enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in 
Security > Password Options.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options> 
Removable Media Boot.

Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Solving Hard Drive Problems
Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

Use a utility to locate and block 
usage of bad sectors. If necessary, 
reformat the hard disk.
In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found (identified). Cable could be loose. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

1. See reconfiguration directions in 
the Solving Hardware 
Installation Problems section. If 
the system still does not 
recognize the new device, 
check to see if the device is 
listed within Computer Setup. If 
it is listed, the probable cause is 
a driver problem. If it is not 
listed, the probable cause is a 
hardware problem.

2. If this is a newly installed drive, 
enter Setup and try adding a 
POST delay under Advanced 
> Power-On.

The device is attached 
to a SATA port that has 
been disabled in 
Computer Setup.

Run Computer Setup and ensure the 
device’s SATA port is enabled in 
Storage > Storage Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR 
missing message

System is trying to start 
from a non bootable 
diskette.

Remove the diskette from the diskette 
drive.
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Nonsystem disk/NTLDR 
missing message
(continued)

System is trying to start 
from the hard drive, but 
the hard drive may have 
been damaged.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check hard drive format using 
fdisk: 
If NTFS formatting, use a third 
party reader to evaluate the 
drive.
If FAT32 formatting, the hard 
drive cannot be accessed. 

System files missing or 
not properly installed.

1. Insert a bootable system diskette 
and restart.

2. Check hard drive format using 
fdisk: 
If NTFS formatting, use a third 
party reader to evaluate the 
drive.
If FAT32 formatting, the hard 
drive cannot be accessed. 

3. Install system files for the 
appropriate operating system.

Hard drive boot 
disabled in Computer 
Setup.

Run the Computer Setup utility and 
enable the hard drive entry in the 
Storage > Boot Order list.

Bootable hard drive is 
not attached as first in a 
multi-hard drive 
configuration.

If attempting to boot from a hard 
drive, ensure it is attached to system 
board connector labeled P60 
SATA 0.

Bootable hard drive's 
controller is not listed 
first in the Boot Order.

Run the Computer Setup utility and 
select Storage > Boot Order 
and ensure the bootable hard 
drive's controller is listed 
immediately under the Hard Drive 
entry.

Computer will not boot 
from hard drive.

The device is attached 
to a SATA port that has 
been disabled in 
Computer Setup.

Run the Computer Setup utility and 
ensure the device's SATA port is 
enabled in Storage > Storage 
Options.

Boot order is not 
correct.

Run the Computer Setup utility and 
change boot sequence in Storage 
> Boot Order.

Hard Drive's “Emulation 
Type” is set to “None.”

Run the Computer Setup utility and 
change the “Emulation Type” to 
“Hard Disk” in the device's details 
under Storage > Device 
Configuration.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Solving Media Card Reader Problems

Computer will not boot 
from hard drive.
(continued)

The device is attached 
to a SATA port that has 
been disabled in 
Computer Setup.

Run the Computer Setup utility and 
ensure the device's SATA port is 
enabled in Storage > Storage 
Options.

Hard drive is damaged. Observe if the front panel Power LED 
is blinking RED and if any beeps are 
heard.
See the Worldwide Limited 
Warranty for terms and conditions.

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

Attempt the normal Windows “Shut 
Down” procedure. If this fails, press 
the power button for four or more 
seconds to turn off the power. To 
restart the computer, press the 
power button.

Solving Hard Drive Problems (Continued)

Problem Cause Solution

Solving Media Card Reader Problems
Problem Cause Solution

Media card will not work in 
a digital camera after 
formatting it in Microsoft 
Windows XP.

By default, Windows XP 
will format any media 
card with a capacity 
greater than 32MB with 
the FAT32 format. Most 
digital cameras use the 
FAT (FAT16 & FAT12) 
format and can not 
operate with a FAT32 
formatted card.

Either format the media card in the 
digital camera or select FAT file 
system to format the media card in a 
computer with Windows XP.

A write-protected or locked 
error occurs when 
attempting to write to the 
media card.

Media card is locked. 
Locking the media card 
is a safety feature that 
prevents writing to and 
deleting from an 
SD/Memory Stick/ PRO 
card.

If using an SD card, make sure that 
the lock tab located on the right of 
the SD card is not in the locked 
position. If using a Memory 
Stick/PRO card, make sure that the 
lock tab located on the bottom of 
the Memory Stick/PRO card is not 
in the locked position.

Cannot write to the media 
card.

The media card is a 
read-only memory 
(ROM) card.

Check the manufacturer’s 
documentation included with your 
card to see if it writable. Refer to the 
previous section for a list of 
compatible cards.
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Unable to access data on 
the media card after 
inserting it into a slot.

The media card is not 
inserted properly, is 
inserted in the wrong 
slot, or is not supported.

Ensure that the card is inserted 
properly with the gold contact on 
the correct side. The green LED will 
light if inserted properly.

Do not know how to 
remove a media card 
correctly.

The computer’s software 
is used to safely eject 
the card.

Open My Computer, right-click 
on the corresponding drive icon, 
and select Eject. Then pull the card 
out of the slot.

✎ Never remove the card when 
the green LED is flashing.

After installing the media 
card reader and booting to 
Windows, the reader and 
the inserted cards are not 
recognized by the 
computer.

The operating system 
needs time to recognize 
the device if the reader 
was just installed into 
the computer and you 
are turning the PC on 
for the first time.

Wait a few seconds so that the 
operating system can recognize the 
reader and the available ports, and 
then recognize whatever media is 
inserted in the reader.

After inserting a media 
card in the reader, the 
computer attempts to boot 
from the media card.

The inserted media card 
has boot capability.

If you do not want to boot from the 
media card, remove it during boot 
or do not select the option to boot 
from the inserted media card during 
the boot process.

Computer will not boot 
from a USB removable 
drive or media that is 
inserted in the USB port on 
the media card reader.

The media card reader 
is connected to the 
computer via the PCI 
card, which is not 
supported on the HP 
Desktop BIOS.

The bootable USB device will have 
boot support if you connect the 
media card reader to an available 
USB connector on the computer’s 
system board. If no connector is 
available, plug the bootable device 
into a different USB port on the 
computer.

After installing the media 
card reader, the front USB 
ports on the computer do 
not work.

The USB cable for the 
front USB ports was 
disconnected so that the 
system board connector 
could be used for the 
reader.

Reconnect the cable for the front 
USB ports. Install the PCI card and 
connect the media reader to the 
USB connector on the PCI card.

Solving Media Card Reader Problems
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Solving Display Problems

Solving Display Problems
Problem Cause Solution

Blank screen (no video). Monitor is not turned on 
and monitor light is not 
on.

Turn on the monitor and check that 
the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections 
are not correct.

Check the cable connections from 
the monitor to the computer and to 
the electrical outlet.

Screen blanking utility 
installed or energy 
saver features enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

System ROM is 
corrupted; system is 
running in Boot Block 
Emergency Recovery 
Mode (indicated by 
eight red blinks from the 
power LED and eight 
simultaneous beeps).

Reflash the system ROM with the 
latest BIOS image.

Fixed-sync monitor will 
not sync at the 
resolution chosen.

Ensure that the monitor can accept 
the same horizontal scan rate as the 
resolution chosen.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

ÄWhen attempting to resume 
from standby mode, do 
not hold down the power 
button for more than four 
seconds. Otherwise, the 
computer will shut down 
and you will lose any 
unsaved data.

Monitor cable plugged 
into the wrong 
connector.

If the computer system has both 
an integrated graphics connector 
and an add-in graphics card 
connector, plug the monitor cable 
into the graphics card connector on 
the back of the computer.
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Blank screen (no video).
(continued)

Monitor settings in the 
computer are not 
compatible with the 
monitor.

1. Restart the computer and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode 
and press Enter.

3. In Windows Control Panel, 
double-click the Display icon 
and select the Settings tab.

4. Use the sliding control to reset 
the resolution.

Cannot enable integrated 
graphics after installing a 
PCI Express graphics card.

On systems with Intel 
integrated graphics, the 
integrated graphics 
cannot be enabled after 
installing a PCI Express 
graphics card.

The integrated graphics can be 
enabled in Computer Setup if a 
standard PCI graphics card is 
installed.

Blank screen and the 
power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video memory error. 1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Blank screen and the 
power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Solving Display Problems (Continued)

Problem Cause Solution
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Blank screen and the 
power LED flashes Red 
seven times, once every 
second, followed by a two 
second pause, and the 
computer beeps seven 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

System board failure 
(ROM detected failure 
prior to video.)

Replace the system board.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller 
was upgraded, the 
correct video drivers 
may not be loaded.

Install the video drivers included in 
the upgrade kit.

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor connections 
may be incomplete or 
the monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Solving Display Problems (Continued)

Problem Cause Solution
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Image is not centered. Position may need 
adjustment.

Press the Menu button to access the 
OSD menu. Select 
ImageControl/Horizontal 
Position or VerticalPosition to 
adjust the horizontal or vertical 
position of the image.

“No Connection, Check 
Signal Cable” displays on 
screen.

Monitor video cable is 
disconnected.

Connect the video cable between 
the monitor and computer.

Ä Ensure the computer power is 
off while connecting the video 
cable.

“Out of Range” displays on 
screen.

Video resolution and 
refresh rate are set 
higher than what the 
monitor supports.

Restart the computer and enter Safe 
Mode. Change the settings to a 
supported setting then restart the 
computer so that the new settings 
take effect.

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing coil 
has been activated.

None. It is normal for the 
degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some monitors 
to make a clicking noise when 
turned on and off, when going in 
and out of standby mode, and when 
changing resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are too 
high.

Lower brightness and/or contrast 
settings.

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen.
(flat panel monitors using 
an analog VGA input 
connection only)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display 
menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen 
display functions. To download 
a SoftPaq that will assist you 
with the synchronization, go to 
the following Web site, select 
the appropriate monitor, and 
download either SP32347 or 
SP32202: 
http://www.hp.com/support

Graphics card is not 
seated properly or is 
bad.

1. Reseat the graphics card.
2. Replace the graphics card.

Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems

Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy 
the symbol from the Character Map 
into a document.

Solving Display Problems (Continued)

Problem Cause Solution

Solving Audio Problems
Problem Cause Solution

Sound cuts in and out. Processor resources are 
being used by other 
applications.

Shut down all open 
processor-intensive applications.

Direct sound latency, 
common in many media 
player applications.

In Windows XP:
1. From the Control Panel, 

select Sounds and Audio 
Devices.

2. On the Audio tab, select a 
device from the Sound 
Playback list.

3. Click the Advanced, button 
and select the Performance 
tab.

4. Set the Hardware 
acceleration slider to None 
and the Sample rate 
conversion quality slider to 
Good and retest the audio.

5. Set the Hardware 
acceleration slider to Full 
and the Sample rate 
conversion quality slider to 
Best and retest the audio.

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on 
the taskbar, then make sure that 
Mute is not selected and use the 
volume slider to adjust the volume.

Audio is hidden in 
Computer Setup.

Enable the audio in Computer 
Setup: Security > Device 
Security >Audio.

The external speakers 
are not turned on.

Turn on the external speakers.
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Sound does not come 
out of the speaker or 
headphones.
(continued)

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Digital CD audio is not 
enabled.

Enable digital CD audio:
1. From the Control Panel, select 

System.
2. On the Hardware tab, click 

the Device Manager button.
3. Right-click on the CD/DVD 

device and select Properties.
4. On the Properties tab, make 

sure “Enable digital CD 
audio for this CD-ROM 
device” is checked.

Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, 
Speech and Audio 
Devices, then click Sounds 
and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

ÄWhen attempting to resume 
from standby mode, do 
not hold down the power 
button for more than four 
seconds. Otherwise, the 
computer will shut down 
and any unsaved data will 
be lost.

Sound from headphones is 
not clear or muffled.

Headphones are 
plugged into the rear 
audio output connector. 
The rear audio 
connector is for 
powered audio devices 
and is not designed for 
headphone use.

Plug the headphones into the 
headphone connector on the front of 
the computer.

Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Printer Problems

Computer appears to be 
locked up while recording 
audio.

The hard disk may be 
full.

Before recording, make sure there is 
enough free space on the hard disk. 
You can also try recording the audio 
file in a compressed format.

Solving Audio Problems (Continued)

Problem Cause Solution

Solving Printer Problems
Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
driver for the 
application are not 
installed.

1. Install the correct printer driver 
for the application.

2. Try printing using the 
MS-DOS command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being 
used. If the printer works, reload 
the printer driver.

If you are on a network, 
you may not have made 
the connection to the 
printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables and check the 
power cord and electrical outlet.

Printer prints garbled 
information.

The correct printer 
driver for the 
application is not 
installed.

Install the correct printer driver for 
the application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

Check the paper tray and refill it if 
it is empty. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard and Mouse Problems
Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. On the Windows Desktop, click 
Start.

2. Click Shut Down. The Shut 
Down Windows dialog box is 
displayed.

3. Select Shut down.
4. After the shutdown is complete, 

reconnect the keyboard to the 
back of the computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using 
the mouse and then restart the 
computer.

Keyboard needs 
repairs.

See the Worldwide Limited 
Warranty for terms and conditions.

Wireless device error. 1. Check software, if available, for 
device status.

2. Check/replace device batteries.
3. Reset receiver and keyboard.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

ÄWhen attempting to resume 
from standby mode, do 
not hold down the power 
button for more than four 
seconds. Otherwise, the 
computer will shut down 
and any unsaved data will 
be lost.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled 
(or enabled) in Computer Setup.



Service Reference Guide, dc7700 433612-001 D–21

Troubleshooting Without Diagnostics

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

1. Press Ctrl and Esc at the same 
time (or press the Windows 
logo key) to display the Start 
menu.

2. Use the up or down arrow key 
to select Shut Down and then 
press Enter.

3. Use the up or down arrow 
key to select the Shut Down 
option and then press Enter.

4. After the shutdown is complete, 
plug the mouse connector into 
the back of the computer (or the 
keyboard) and restart.

Program in use has 
stopped responding 
to commands.

Shut down the computer using the 
keyboard and then restart the 
computer.

Mouse may need 
cleaning.

Remove the roller ball cover on the 
mouse and clean the internal 
components.

Mouse may need 
repair.

See the Worldwide Limited 
Warranty for terms and conditions.

Wireless device error. 1. Check software, if available, for 
device status.

2. Check/replace device batteries.
3. Reset receiver and mouse.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

ÄWhen attempting to resume 
from standby mode, do 
not hold down the power 
button for more than four 
seconds. Otherwise, the 
computer will shut down 
and you will lose any 
unsaved data.

Mouse will only move 
vertically or horizontally, or 
movement is jerky.

Mouse roller ball or the 
rotating encoder shafts 
that make contact with 
the ball are dirty.

Remove roller ball cover from the 
bottom of the mouse and clean the 
internal components with a mouse 
cleaning kit.

Solving Keyboard and Mouse Problems (Continued)

Problem Cause Solution
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an 
additional diskette drive. If you install a plug and play device, Windows XP automatically 
recognizes the device and configures the computer. If you install a non–plug and play device, you 
must reconfigure the computer after completing installation of the new hardware. In Windows 
XP, use the Add Hardware Wizard and follow the instructions that appear on the screen.

Å
WARNING: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

Look for the LED between the DIMM sockets. If the LED is illuminated, the system still has power. Power off 
the computer and remove the power cord before proceeding.

Solving Hardware Installation Problems
Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of changes 
to the configuration, you 
did not accept them.

Reboot the computer and follow the 
instructions for accepting the 
changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows XP Device Manager 
to deselect the automatic settings for 
the board and choose a basic 
configuration that does not cause a 
resource conflict. You can also use 
Computer Setup to reconfigure or 
disable devices to resolve the 
resource conflict.

USB ports on the 
computer are disabled 
in Computer Setup.

Enter Computer Setup (F10) and 
enable the USB ports.
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Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to 
determine if you are using the 
correct memory modules and to 
verify the proper installation.

✎ DIMM 1 must always be 
installed.

2. Observe the beeps and LED 
lights on the front of the 
computer. See Appendix C 
“POST Error Messages” to 
determine possible causes.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

Ä To avoid damage to the 
DIMMs or the system board, 
you must unplug the computer 
power cord before attempting 
to reseat, install, or remove a 
DIMM module.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

✎ DIMM 1 must always be 
installed.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Graphics card is not 
seated properly or is 
bad, or system board is 
bad.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Power LED flashes Red ten 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps ten times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved

Bad option card. 1. Check each option card by 
removing the cards one at time 
(if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once bad card is identified, 
remove and replace bad option 
card.

3. Replace the system board.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems
Problem Cause Solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Enable Wake-on-LAN.
1. Select Start > Control 

Panel.
2. Double-click Network 

Connections.
3. Double-click Local Area 

Connection.
4. Click Properties.
5. Click Configure.
6. Click the Power 

Management tab, then 
select the check box to Allow 
this device to bring the 
computer out of standby.

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via the 
Device Manager.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light 
never flashes.

✎ The network status 
light should flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Check for the device status within 
Windows, such as Device 
Manager for driver load and the 
Network Connections applet 
within Windows for link status.

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via Device 
Manager.

Network driver is not 
properly loaded.

Reinstall network drivers. 

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the correct 
operating mode. 
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Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
is defective.

Replace the system board (NIC is 
integral to the system board).

Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are not 
loaded, or driver 
parameters do not match 
current configuration.

Make sure the network drivers are 
loaded and that the driver 
parameters match the configuration 
of the network controller.
Make sure the correct network client 
and protocol is installed.

The network controller is 
not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Network controller stops 
working without apparent 
cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using 
the Restore Plus! CD.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

Solving Network Problems (Continued)

Problem Cause Solution
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Network controller stops 
working without apparent 
cause.
(continued)

The network controller is 
defective.

Replace the system board.

New network card will 
not boot.

New network card may be 
defective or may not meet 
industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence 
to boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that 
the Remote System Installation 
Server contains the NIC drivers for 
your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems

Ä
CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on 
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must 
unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory. 
Otherwise, the system will not boot the operating system.

✎ The memory count will be affected by configurations with the Management Engine (ME) 
enabled. The ME uses 8MB of system memory in single channel mode or 16 MB of memory in 
dual-channel mode to download, decompress, and execute the ME firmware for Out-of-Band 
(OOB), third-party data storage, and other management functions.

Solving Memory Problems
Problem Cause Solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

A memory module is 
not installed in the 
XMM1 socket.

Ensure that a memory module is 
installed in the black XMM1 socket 
on the system board. This socket 
must be populated with a memory 
module.

Memory module is not 
the correct type or 
speed grade for this 
system or the new 
memory module is not 
seated properly.

Replace module with the correct 
industry-standard device for the 
computer. On some models, ECC 
and non-ECC memory modules 
cannot be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during POST 
is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Integrated graphics may 
use system memory.

No action required.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more 
memory to the computer.
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Solving Processor Problems
.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. Beeps 
continue for five iterations 
after which the LED flashes 
will continue until the 
problem is resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Solving Memory Problems (Continued)

Problem Cause Solution

Solving Processor Problems
Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Power LED flashes Red 
three times, once every 
second, followed by a two 
second pause, and the 
computer beeps three 
times. Beeps continue for 
five iterations after which 
the LED flashes will 
continue until the problem 
is resolved.

Processor is not seated 
properly or not 
installed.

1. Check to see that the processor 
is present.

2. Reseat the processor.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems
Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

The device is attached 
to a SATA port that has 
been disabled in the 
Computer Setup utility.

Run the Computer Setup utility and 
ensure the device's SATA port is 
enabled in Storage > Storage 
Options.

Removable Media Boot 
is disenabled through 
the Computer Setup 
utility.

Run the Computer Setup utility and 
enable booting to removable media 
in Storage > Storage Options. 
Ensure CDROM is enabled in 
Storage > Boot Order.

Network Server Mode 
is enabled in Computer 
Setup.

Run the Computer Setup utility and 
disable Network Server Mode in 
Security > Password Options. 

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

Boot order not correct. Run Computer Setup and change 
boot sequence in Storage > Boot 
Order.

Drive not found (identified). Cable could be loose. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

See reconfiguration directions in the 
Solving Hardware Installation 
Problems section. If the system still 
does not recognize the new device, 
check to see if the device is listed 
within Computer Setup. If it is listed, 
the probable cause is a driver 
problem. If it is not listed, the 
probable cause is a hardware 
problem.
If this is a newly installed drive, run 
the Computer Setup utility and try 
adding a POST delay under 
Advanced > Power-On.

The device is attached 
to a SATA port that has 
been disabled in 
Computer Setup.

Run the Computer Setup utility and 
ensure the device's SATA port is 
enabled in Storage > Storage 
Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

CD-ROM or DVD devices 
are not detected or driver is 
not loaded.

Drive is not connected 
properly or not properly 
configured.

See the documentation that came 
with the optional device.
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Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Damaged media. Replace media.

Movie rating locked out 
by parental lock.

Use DVD software to remove 
parental lock.

Media installed upside 
down.

Reinstall media.

Cannot eject compact disc 
(tray-load unit).

Disc not properly seated 
in the drive.

1. Turn off the computer and insert 
a thin metal rod into the 
emergency eject hole and push 
firmly. 

2. Slowly pull the tray out from the 
drive until the tray is fully 
extended, then remove the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

Media has been 
inserted upside down.

Re-insert the Media with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove 
or uninstall the device in 
question.

2. Restart the computer and let 
Windows detect the device.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower recording 
speed.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

USDT computer boots too 
slowly after removing a 
CD-ROM or DVD drive.

The system is searching 
for the drive during boot 
because the drive cable 
is still attached to the 
system board.

Disconnect the drive cable from the 
system board.

Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution
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Solving Drive Key Problems

Solving Drive Key Problems
Problem Cause Solution

Drive Key is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for 
the Drive Key in Windows XP.

USB Drive Key not found 
(identified).

The device is attached 
to a USB port that has 
been hidden in 
Computer Setup.

Run the Computer Setup utility and 
ensure that Device available is 
selected for All USB Ports and 
Front USB Ports under Security 
> Device Security.

The device was not 
properly seated before 
power-up.

Ensure the device is fully inserted 
into the USB port before applying 
power to the system.

System will not boot from 
USB Drive Key.

Boot order is not 
correct.

Run the Computer Setup utility and 
change boot sequence in Storage 
> Boot Order.

Removable Media Boot 
is disabled in the 
Computer Setup utility.

Run the Computer Setup utility and 
enable booting to removable media 
in Storage > Storage Options. 
Ensure USB is enabled in Storage 
> Boot Order.

The image on the 
device is not bootable.

Follow the procedures described in 
the “ROM Flash: Replicating the 
Setup: Creating a Bootable Device: 
Supported USB Flash Media 
Device” section of the Service 
Reference Guide.

The computer boots to DOS 
after making a bootable 
Drive Key.

Drive Key is bootable. Install the Drive Key after the 
operating system boots.
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Solving Front Panel Component Problems
Solving Front Panel Component Problems
Problem Cause Solution

A USB device, headphone, 
or microphone is not 
recognized by the 
computer.

It is not properly 
connected.

1. Turn off the computer.
2. Reconnect the device to the front of 

the computer and restart the 
computer.

The device does not 
have power.

If the USB device requires AC power, 
be sure one end is connected to the 
device and one end is connected to a 
live outlet.

The correct device 
driver is not installed.

1. Install the correct driver for the 
device.

2. You might need to reboot the 
computer.

The cable from the 
device to the computer 
does not work.

1. If possible, replace the cable.
2. Restart the computer.

The device is not 
working.

1. Replace the device.
2. Restart the computer.
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Solving Internet Access Problems

Solving Internet Access Problems
Problem Cause Solution

Unable to connect to the 
Internet.

Internet Service Provider 
(ISP) account is not set 
up properly.

Verify Internet settings or contact the 
ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the 
quick setup documentation.

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/DSL modem is 
not plugged in.

Plug in cable/DSL modem. You 
should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 UTP cable is 
disconnected.

Connect the CAT5 UTP cable 
between the cable modem and the 
computers’s RJ-45 connector. (If the 
connection is good, the “PC” LED 
light on the front of the cable/DSL 
modem will be on.)

IP address is not 
configured properly.

Contact the ISP for the correct IP 
address.

Cookies are corrupted. Windows XP
1. Select Start > Control 

Panel.
2. Double-click Internet 

Options.
3. On the General tab, click the 

Delete Cookies button.
Windows 2000

1. Select Start > Settings > 
Control Panel.

2. Double-click Internet 
Options.

3. On the General tab, click the 
Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to the 
ISP before some 
programs will start.

Log on to the ISP and launch the 
desired program.
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Internet takes too long to 
download Web sites.

Modem is not set up 
properly.

Verify that the correct modem speed 
and COM port are selected.
For Windows XP

1. Select Start > Control 
Panel.

2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port your 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Windows 2000
1. Select Start > Settings > 

Control Panel.
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port the 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

Solving Internet Access Problems (Continued)

Problem Cause Solution
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Solving Software Problems
Most software problems occur as a result of the following:

■ The application was not installed or configured correctly.

■ There is insufficient memory available to run the application.

■ There is a conflict between applications.

■ Be sure that all the needed device drivers have been installed.

■ If you have installed an operating system other than the factory-installed operating system, 
check to be sure it is supported on the system.

Internet takes too long to 
download Web sites.
(continued)

Modem is not set up 
properly.
(continued)

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Solving Internet Access Problems (Continued)

Problem Cause Solution

Solving Software Problems
Problem Cause Solution

Computer will not continue 
and no HP logo screen has 
appeared.

POST error has 
occurred.

Observe the beeps and LED lights on 
the front of the computer. See 
Appendix C, POST Error Messages to 
determine possible causes.
See the Restore Kit or the Worldwide 
Limited Warranty for terms and 
conditions.

Computer will not continue 
after HP logo screen has 
appeared.

System files may be 
damaged.

Use recovery diskette to scan hard 
drive for errors.

“Illegal Operation has 
Occurred” error message is 
displayed.

Software being used is 
not Microsoft-certified 
for your version of 
Windows.

Verify that the software is certified by 
Microsoft for your version of Windows 
(see program packaging for this 
information).

Configuration files are 
corrupt.

If possible, save all data, close all 
programs, and restart the computer.
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E
System Board and Riser Board Reference

Designators

These reference designators are used on most but not all HP system and riser boards.

Designator Component
BAT
CR1
CR2
CR3
CR4

Battery socket/Battery
LED - 5V_Aux (on)
Health-LED
UID LED
Power LED

CR35
E14
E15
E16
E25
E49/JP49

Hard drive activity LED
Boot block header/jumper
Boot block recovery header
ROM recovery header
CPLD programming header
Clear Password header/jumper

E50
J7
J9
J10
J11

Clear CMOS header
RJ45 jack
Stacked RJ45/Dual USB
Quad stacked USB
First IEEE 1394 connector

J12 
J13
J14
J20 - 29
J30

Second IEEE 1394 connector
SPDIF input
SPDIF output
PCI slots
PCI extender slot (male)

J31 - J35
J37
J38
J39
J40

PCI Express slots
Primary SCSI connector
Secondary SCSI connector
Stacked parallel/SCSI connector
AGP slot

J41
J50
J51
J52
J53

x16 PCI Express slot for graphics
First parallel port
Second parallel port
Double-stacked parallel port, Top = Port B, Bottom = Port A
Parallel port over single Serial Port

J54
J55
J65
J66
J67

Parallel port over Serial Port and Video Port
Parallel port over dual VGA ports
DVI connector
Keyboard connector, PS/2 (Closest to power supply)
Mouse connector, PS/2
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J68
J69
J70
J71
J72

Stacked mouse (Top)/keyboard (Bottom) connector
Video connector, VGA
Primary single USB connector
Secondary single USB port
Microphone jack

J73
J74
J75
J76
J77

Line-in jack
Line-out jack
Headphone jack
Volume control
Double-stacked headphone (Bottom)/microphone (Top) connector

J78
J80
J81
J82
J83

Double-stacked line-in (Top)/line-out (Bottom) connector
Stacked serial/audio connector
Primary double-stack USB, Top = Port 2, Bottom = Port 1
Secondary double-stack USB, Top = Port 4, Bottom = Port 3
Triple-stacked audio jack (line in, line out/headphone, microphone)

J101
J9020-J9029
J9030-J9034
JP49/E49
L1

Security board connector - for security card
PCI slots on riser card
PCI express slots on riser card
Clear password header/jumper
USB front port choke (1st)

L2
L3
L4
L5
P1

USB rear port choke (1st)
USB rear port choke (2nd)
USB rear port choke (3rd)
USB front port choke (2nd)
P/S connector (20 or 24 pin)

P2
P3
P4
P5
P6

Second P/S connector (as required)
Processor 12V header 
Secondary Processor 12V header
Main Power/HDD LED connector 
Speaker connector

P7
P8
P9
P10
P11

Analog audio connector (from CD-ROM)
Primary chassis fan header or primary CPU heatsink fan
Secondary chassis fan header
Diskette drive connector
Auxiliary Audio connector

P12
P13
P15
P16
P17

Alert on LAN connector
VRM module footprint
AUI connector
Fan command/fan sink header (may be 2 or 4 pin)
Digital audio expansion header

P18
P19
P20
P21
P22

SPDIF internal input header
SPDIF internal output header
Primary IDE connector
Secondary IDE/MultiBay connector
Header for NEWCARD

Designator Component (Continued)
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P23
P24
P25 
P26
P27

Header for front panel audio 
Header for front panel USB
Internal USB connector 1
Internal USB connector 2
MultiBay header

P29
P30
P40
P41
P52

SCSI LED connector
PCI extender slot (female)
Blade PC graphics connector (outboard)
Blade PC graphics connector (inboard)
Second serial port 

P54
P55
P58
P60
P61

Primary serial port
Double stack serial port, Top = Serial B, Bottom = Serial A
Riser edge connector (male-mates with J30)
Primary Serial ATA (SATA) connector
Second Serial ATA (SATA) connector

P62
P63
P64
P65
P66

Third Serial ATA (SATA) connector
Fourth Serial ATA (SATA) connector
VSFF expansion connector
Graphics option connector
Fifth Serial ATA (SATA) connector

P67
P68
P69
P70
P71

Sixth Serial ATA (SATA) connector
Seventh Serial ATA (SATA) connector
Eighth Serial ATA (SATA) connector
Primary (CPU) fan header for fansink
Secondary CPU fan header for fansink

P80
P81
P82
P83
P84

Primary Serial Attached SCSI (SAS) connector
Second Serial Attached SCSI (SAS) connector
Third Serial Attached SCSI (SAS) connector
Fourth Serial Attached SCSI (SAS) connector
Fifth Serial Attached (SAS) connector

P85
P86
P87
P101
P106

Sixth Serial Attached (SAS) connector
Seventh Serial Attached (SAS) connector
Eighth Serial Attached (SAS) connector
Security board connector, system board
Secondary speaker connector

P124
P125
P126
P150
P216
SW2

Hood lock header
Hood sensor header
Flying parallel port header
Media reader header
White box chassis fan header
Security hood switch on riser card

SW50
U2
U3
U4
U5

Clear CMOS switch/push button
Single chip solution (combined northbridge/southbridge)
North bridge
South bridge
Super I/O

Designator Component (Continued)
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U6
U7
U10
U11
U12

Clock chip
64 bit Bridge
LOM1
LOM1 EEPROM
LOM1 PHY

U13
U14
U16
U17
U18

Audio Codec
Audio amplifier
LOM2
LOM2 EEPROM
LOM2 PHY

U19
U20
U21
U29
U30
U31

SPI ROM - SOIC-8 footprint
Fan controller
SPI ROM - SO16 footprint
TMDS controller
Parallel port diode array
First serial port transceiver 

U32
U46
U50
U51
U52

Second serial port transceiver
VRM controller
USB front port power switch
First USB rear port power switch
Second USB rear port power switch

U53
XBT
XMM1
XMM2 - XMM5
XU1

Third USB rear port power switch
Battery retainer
Memory slot. DIMM1 or RIMM1 populated and tested
Following memory slots
Primary processor socket 

XU2
XU15/U15
XU19/U19
Y1
Y2

Secondary processor socket
System ROM and Socket (Socket = XU15, ROM = U15)
SPI ROM and socket (XU19 = socket, U19 = SPI ROM)
Primary (TH) system clock crystal
Secondary (SMT) system clock crystal

Y3
Y4
Y5/H5

Primary NIC clock crystal
Secondary NIC clock crystal
RTC clock crystal/tie-down

Designator Component (Continued)
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F
Memory

The dx7300 and dc7700 series computers with Intel-based processors come with double data rate 
2 synchronous dynamic random access memory (DDR2-SDRAM) dual inline memory modules 
(DIMMs). 

ÄCAUTION: DDR and DDR2 memory modules are not interchangeable.

DDR2-SDRAM DIMMs 
The memory sockets on the system board can be populated with up to four industry-standard 
DIMMs. These memory module sockets are populated with at least one preinstalled memory 
module. To achieve the maximum memory support, you can populate the system board with up 
to 8GB of memory configured in a high-performing dual channel mode.

For proper system operation, the DDR2-SDRAM DIMMs must be:

■ industry-standard 240-pin

■ unbuffered PC2-4300 533 MHz-compliant, PC2-5300 667 MHz-compliant, or PC2-6400 
800 MHz-compliant

■ 1.8volt DDR2-SDRAM DIMMs

The DDR2-SDRAM DIMMs must also:

■ support CAS latency 4 (DDR2/533 MHz and DDR2/667 MHz) and CAS latency 5 
(DDR2/667 MHz and DDR2/800 MHz)

■ contain the mandatory JEDEC SPD information

In addition, the computer supports:

■ 256Mbit, 512Mbit, AND 1 Gbit non-ECC memory technologies

■ single-sided and double-sided DIMMS 

■ DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM 
are not supported

✎ The system will not start if you install unsupported DIMMs.

DIMM Sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are 
labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM2 operate in memory 
channel A. Sockets XMM3 and XMM4 operate in memory channel B.
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Memory

The system board shown may differ from the one in your product.

 

The system will automatically operate in single channel mode, dual channel mode, or flex mode, 
depending on how the DIMMs are installed.

■ The system will operate in single channel mode if the DIMM sockets are populated in one 
channel only.

■ The system will operate in a higher-performing dual channel mode if the total memory 
capacity of the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in 
Channel B. The technology and device width can vary between the channels. For example, if 
Channel A is populated with two 256MB DIMMs and Channel B is populated with one 
512MB DIMM, the system will operate in dual channel mode.

■ The system will operate in flex mode if the total memory capacity of the DIMMs in Channel 
A is not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the 
channel populated with the least amount of memory describes the total amount of memory 
assigned to dual channel and the remainder is assigned to single channel. For optimal speed, 
the channels should be balanced so that the largest amount of memory is spread between the 
two channels. For example, if you are populating the sockets with one 1GB DIMM, two 
512MB DIMMs, and one 256MB DIMM, one channel should be populated with the 1GB 
DIMM and one 256MB DIMM and the other channel should be populated with the two 
512MB DIMMs. With this configuration, 2 GB will run as dual channel and 256 MB will run 
as single channel.

■ In any mode, the maximum operational speed is determined by the slowest DIMM in the 
system.

Item Description Socket Color

1 DIMM socket XMM1, Channel A Black

2 DIMM socket XMM2, Channel A White

3 DIMM socket XMM3, Channel B White

4 DIMM socket XMM4, Channel B White
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Index

4-pin power pin assignments A–6
24-pin MicroFit power pin assignments A–6
24-pin power pin assignments A–6
6-pin power pin assignments A–7

A
access panel

CMT removal and replacement 6–5
USDT removal and replacement 8–4

Active Management Technology 3–7
adding devices 1–1
Altiris, Deployment Solution Agent 3–2
asset tracking 3–16
ATA/ATAPI (IDE) drive cable pin assignments 

A–5

B
Backup and Recovery Manager 1–2
backwall, SFF removal and replacement 7–17
battery

CMT removal and replacement 6–29
disposal 5–9
SFF removal and replacement 7–45
USDT removal and replacement 8–26

bezel blank, CMT removal and replacement 6–8
bezel insert, SFF removal and replacement 7–8
blank screen D–13
Boot Block Emergency Recovery Mode 3–10

C
cable

CMT hard drive removal and replacement 6–20
proper handling 5–8

cable connections
CMT 6–10
SFF 7–11
USDT 8–12

cable lock 3–25
CMT 6–4
SFF 7–5
USDT 8–3

cable management
CMT 6–9

SFF 7–10
USDT 8–11

cable pinouts
SATA data 4–2
SATA power 4–2

cautions
AC power 5–1
adding devices 1–1
cables 5–8
cooling fan 5–7
cover lock security 3–24
electrostatic discharge 5–3
FailSafe Key 3–25
keyboard cleaning 5–6
keyboard keys 5–6
operating system installation 1–1
protecting ROM BIOS 3–9

CD-ROM connector pin assignments A–5
change notification (PCN) 3–8
changing password 3–21
chassis

CMT illustrated 5–1
SFF illustrated 5–2
USDT illustrated 5–2

chassis fan
CMT removal and replacement 6–36
SFF removal and replacement 7–38
USDT removal and replacement 8–9

chassis types, illustrated 5–1
cleaning

computer 5–6
keyboard 5–6
monitor 5–7
mouse 5–7
safety precautions 5–6

clearing password 3–22
CMT

5.25" drive bezel removal and replacement 6–7
access panel removal and replacement 6–5
battery removal and replacement 6–29
bezel blank removal and replacement 6–8
cable connections 6–10
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Index

cable lock removal and replacement 6–4
cable management 6–9
chassis fan removal and replacement 6–36
chassis, illustrated 5–1
desktop to minitower conversion 6–39
disassembly preparation 6–1
diskette drive bezel removal and replacement 

6–8
diskette drive removal and replacement 6–25
drive positions 6–19
expansion card guide removal and replacement 

6–18
expansion card removal and replacement 6–13
expansion card retainer latch removal and 

replacement 6–16
expansion slot cover removal and replacement 

6–13, 6–16
external security 6–4
FailSafe key 6–2
front bezel removal and replacement 6–6
front I/O device removal and replacement 6–26
hard drive cable removal and replacement 6–20
hard drive removal and replacement 6–20
heatsink removal and replacement 6–33
hood sensor removal and replacement 6–3
memory removal and replacement 6–11
minitower to desktop conversion 6–42
optical drive removal and replacement 6–22
padlock removal and replacement 6–4
PCI Express card removal and replacement 

6–14
PCI retainer latch removal and replacement 

6–16
power supply removal and replacement 6–37
power switch assembly removal and 

replacement 6–27
preparation for disassembly 6–1
processor removal and replacement 6–34
Smart Cover Lock removal and replacement 6–2
speaker removal and replacement 6–35
system board connections 6–10
system board removal and replacement 6–28
tamper-proof screws 6–2

computer cleaning 5–6
computer cover, SFF removal and replacement 7–7
computer pauses D–2
Computer Setup

accessing 2–3
Advanced menu 2–11
File menu 2–4

overview 2–2
Security menu 2–8
Storage menu 2–5

configuration settings, recovering 2–14
configuring power button 3–15
connections

CMT system board 6–10
SFF system board 7–11
USDT power supply 8–12
USDT system board 8–12

connector pin assignments A–1 to A–10
conversion

CMT desktop to minitower 6–39
CMT minitower to desktop 6–42

Convertible Minitower See CMT
country-specific power cord set requirements B–2
cover lock, smart 3–24

D
date and time display problems D–2
DDR2 memory F–1
deleting password 3–21
delimiter characters, table 3–22
device drivers, installing 1–1
diagnostic tool for hard drives 3–26
diagnostics utility 2–14 to 2–18
DIMMs F–1
disassembly preparation

CMT 6–1
SFF 7–1
USDT 8–1

diskette drive
CMT removal and replacement 6–25
SFF removal and replacement 7–25

diskette drive bezel
CMT removal and replacement 6–8
SFF removal and replacement 7–8

drive
CMT diskette drive removal and replacement 

6–25
CMT hard drive removal and replacement 6–20
CMT optical drive removal and replacement 

6–22
hard drive capacities 4–3
hard drive partition size 4–3
protecting 3–26
SFF external removal and replacement 7–25
SFF hard drive removal and replacement 7–27
SFF optical drive removal and replacement 

7–23
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Index

SFF, external, removal and replacement 7–25
USDT hard drive removal and replacement 

8–18
USDT optical drive removal and replacement 

8–5
drive bezel

CMT removal and replacement 6–7
SFF removal and replacement 7–8

drive bezel inserts
CMT 6–7
SFF 7–9

drive key, problem solving D–31
drive positions

CMT 6–19
SFF 7–22

Drivelock security 3–22
dual-state power button 3–15
DVI pin assignments A–10

E
electrostatic discharge. See ESD
entering

power-on password 3–20
setup password 3–20

error messages, POST C–1 to C–13
ESD (electrostatic discharge)

materials and equipment 5–4
preventing damage 5–3

Ethernet
AUI pin assignments A–2
BNC pin assignments A–1
RJ-45 pin assignments A–2

expansion card
CMT guide removal and replacement 6–18
CMT PCI Express removal and replacement 

6–14
CMT removal and replacement 6–13
SFF PCI Express removal and replacement 7–16
SFF removal and replacement 7–14
SFF retainer removal and replacement 7–13
USDT removal and replacement 8–15
USDTcage removal and replacement 8–14

expansion card retaining latch, USDT removal and 
replacement 8–17

expansion slot cover
CMT removal and replacement 6–13
SFF removal and replacement 7–14

external 3.5-inch drive
SFF removal and replacement 7–25

F
FailSafe key 3–25

CMT 6–2
SFF 7–2

fan shroud, SFF removal and replacement 7–30
fan, power supply 5–7
Fault Notification and Recovery 3–26
fingerprint identification technology 3–26
flashing LEDs C–9
front bezel

CMT removal and replacement 6–6
USDT removal and replacement 8–7

front I/O device
CMT removal and replacement 6–26
SFF removal and replacement 7–31
USDT removal and replacement 8–20

G
general power cord set requirements B–1
grounding methods 5–4

H
hard drive

capacities 4–3
CMT removal and replacement 6–20
diagnostic tool 3–26
proper handling 5–8
SATA characteristics 4–1
SFF removal and relacement 7–27
USDT removal and replacement 8–18

hardware, Proactive Change Notification (PCN) 
3–8

headphone pin assignments A–3
heatsink

CMT removal and replacement 6–33
SFF removal and replacement 7–32
USDT removal and replacement 8–21

hood sensor
CMT removal and replacement 6–3
SFF removal and replacement 7–4

HP Backup and Recovery Manager 1–2, 3–2
HP Client Foundation Suite 3–5
HP Client Manager 3–4
HP Client Premium Suite 3–5
HP Insight Diagnostics 2–14 to 2–18
HP OpenView Client Configuration Manager 3–6
HP OpenView PC Management Solution 3–6
HP OpenView See HP OpenView
HP ProtectTools Security Manager 3–5
HP System Software Manager 3–4
HPQFlash 3–10
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I
image deployment methods 3–1
infrared (IR) transceiver, external, pin assignments 

A–4
initial configuration 3–1
Insight Diagnostics 2–14 to 2–18
Intel Active Management Technology 3–7

K
key, FailSafe 3–25
keyboard

cleaning 5–6
delimiter characters, national 3–22
pin assignments A–1

L
LEDs

blinking power C–9
blinking PS/2 keyboard C–9

line-in audio pin assignments A–3
line-out audio pin assignments A–4
locking Smart Cover Lock 3–25

M
memory

CMT removal and replacement 6–11
DDR2 specifications F–1
problem solving D–27
SFF removal and replacement 7–12
socket assignments F–2
USDT removal and replacement 8–13

microphone pin assignments A–3
monitor

blank screen D–13
blurry video D–15
cleaning 5–7
dim characters D–15
pin assignments A–4

mouse
pin assignments A–1

mouse cleaning 5–7

N
national keyboard delimiter characters 3–22
notification of hardware and software changes 

(PCN) 3–8

O
operating guidelines 5–5
optical drive

CMT removal and replacement 6–22
SFF removal and replacement 7–23

USDT removal and replacement 8–5
overheating, prevention 5–5

P
padlock

CMT 6–4
SFF 7–6
USDT 8–3

parallel interface pin assignments A–2
partition, hard drive 4–3
password

changing 3–21
clearing 3–22
deleting 3–21
options 2–8
power-on 2–8, 3–20
security 3–19
setup 2–8, 3–19, 3–20

PCI expansion card cage, USDT 8–14
PCI Express expansion card

CMT removal and replacement 6–14
SFF removal and replacement 7–16
USDT cage 8–14
USDT removal and replacement 8–15

PCI Express pin assignments A–8
PCN (Proactive Change Notification) 3–8
POST error messages C–1 to C–13
power button

configuring 3–15
dual-state 3–15

power cord set requirements
country specific B–2
general B–1

power supply
CMT removal and replacement 6–37
fan 5–7
SFF removal and replacement 7–36
surge-tolerant 3–26
USDT connections 8–12
USDT removal and replacement 8–24

power switch assembly
CMT removal and replacement 6–27
SFF removal and replacement 7–44

power-on password
changing 3–21
deleting 3–21
entering 3–20

Power-On Self-Test (POST) 2–1
Preboot Execution Environment (PXE) 3–3
Proactive Change Notification (PCN) 3–8
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problems, solving
audio D–17
CD-ROM and DVD drives D–29
diskette D–7
display D–13
drive key D–31
front panel components D–32
hard drive D–9
hardware installation D–22
Internet access D–33
keyboard D–20
media card reader D–11
memory D–27
mouse D–20
network D–24
optical drives D–29
power supply D–5
printer D–19
processor D–28
software D–35
Wake-on-LAN D–24

processor
CMT removal and replacement 6–34
problem solving D–28
SFF removal and replacement 7–33
USDT removal and replacement 8–22

protecting ROM BIOS 3–9
PXE (Preboot Execution Environment) 3–3

R
recovery

configuration settings 2–14
creating disc recovery set 1–2
software 3–1

reference designators ?? to E–4
reference designators E–1
Remote ROM BIOS Flash 3–9
remote setup 3–3
Remote System Installation 3–3
removal and replacement

CMT 5.25" drive bezel 6–7
CMT access panel 6–5
CMT battery 6–29
CMT bezel blank 6–8
CMT cable lock 6–4
CMT chassis fan 6–36
CMT diskette drive 6–25
CMT diskette drive bezel 6–8
CMT expansion card 6–13
CMT expansion card guide 6–18

CMT expansion slot cover 6–13, 6–16
CMT front bezel 6–6
CMT front I/O device 6–26
CMT hard drive 6–20
CMT hard drive cable 6–20
CMT heatsink 6–33
CMT hood sensor 6–3
CMT memory 6–11
CMT optical drive 6–22
CMT padlock 6–4
CMT PCI Express card 6–14
CMT PCI retainer latch 6–16
CMT power supply 6–37
CMT power switch assembly 6–27
CMT processor 6–34
CMT Smart Cover Lock 6–2
CMT speaker 6–35
CMT system board 6–28
SFF backwall 7–17
SFF battery 7–45
SFF bezel insert 7–8
SFF cable lock 7–5
SFF chassis fan 7–38
SFF computer cover 7–7
SFF drive bezel 7–8
SFF expansion card 7–14
SFF expansion card retainer 7–13
SFF external 3.5-inch drive 7–25
SFF fan shroud 7–30
SFF front I/O device 7–31
SFF hard drive 7–27
SFF heatsink 7–32
SFF hood sensor 7–4
SFF memory 7–12
SFF optical drive 7–23
SFF padlock 7–6
SFF PCI Express expansion card 7–16
SFF power supply 7–36
SFF power switch assembly 7–44
SFF processor 7–33
SFF riser card assembly 7–17
SFF Smart Cover Lock 7–2
SFF speaker 7–35
SFF system board 7–39
USDT access panel 8–4
USDT battery 8–26
USDT cable lock 8–3
USDT chassis fan 8–9
USDT expansion card 8–15
USDT expansion card retaining latch 8–17
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USDT front bezel 8–7
USDT front I/O device 8–20
USDT hard drive 8–18
USDT heatsink assembly 8–21
USDT memory 8–13
USDT optical drive 8–5
USDT padlock 8–3
USDT PCI Express expansion card 8–15
USDT power supply 8–24
USDT processor 8–22
USDT riser board 8–14
USDT speaker 8–10
USDT system board 8–25

replicating the setup 3–11 to 3–15
Restore Plus! CD 1–2
retired solutions 3–9
riser board

reference designators E–1
SFF removal and replacement 7–17
USDT removal and replacement 8–14

riser card,SFF removal and replacement 7–17
ROM flash, BIOS, ROM 3–9

S
safety precautions, cleaning 5–6
SATA

connectors on system board 4–1
data cable pinouts 4–2
hard drive characteristics 4–1
pin assignments A–7
power cable pinouts 4–2

screws, correct size 5–8
SDRAM (synchronous dynamic random access 

memory) F–1
security

CMT 6–4
DriveLock 3–22
fingerprint identification technology 3–26
HP ProtectTools Security Manager 3–5
password 3–19
SFF 7–5
USDT 8–3

security features
overview 3–17

serial interface pin assignments A–3
service considerations 5–7
setup password

changing 3–21
deleting 3–21
entering 3–20

setting 3–19
setup, Windows 1–1
SFF

backwall removal and replacement 7–17
battery removal and replacement 7–45
bezel insert removal and replacement 7–8
cable connections 7–11
cable lock removal and replacement 7–5
cable management 7–10
chassis fan removal and replacement 7–38
chassis, illustrated 5–2
computer cover removal and replacement 7–7
disassembly preparation 7–1
drive bezel inserts 7–9
drive bezel removal and replacement 7–8
drive positions 7–22
expansion card removal and replacement 7–14
expansion card retainer removal and 

replacement 7–13
external 3.5-inch drive removal and replacement 

7–25
external drive removal and replacement 7–25
external security 7–5
FailSafe key 7–2
fan shroud removal and replacement 7–30
front I/O device removal and replacement 7–31
hard drive removal and replacement 7–27
heatsink removal and replacement 7–32
hood sensor removal and replacement 7–4
memory removal and replacement 7–12
optical drive removal and replacement 7–23
padlock removal and replacement 7–6
PCI Express expansion card removal and 

replacement 7–16
power supply removal and replacement 7–36
power switch assembly removal and 

replacement 7–44
preparation for disassembly 7–1
processor removal and replacement 7–33
riser card assembly removal and replacement 

7–17
Smart Cover Lock removal and replacement 7–2
speaker removal and replacement 7–35
system board connections 7–11
system board removal and replacement 7–39
tamper-proof screws 7–2

Small Form Factor. See SFF
Smart Cover Lock

CMT removal and replacement 6–2
locking 3–25
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SFF removal and replacement 7–2
unlocking 3–25

Smart Cover Sensor
protection levels 3–24
setting 3–24

software
Altiris Deployment Solution Agent 3–2
asset tracking 3–16
Boot Block Emergency Recovery Mode 3–10
Computer Setup Utilities 2–1
Drive Protection System 3–26
Fault Notification and Recovery 3–26
HP Backup and Recovery Manager 1–2, 3–2
HP Client Foundation Suite 3–5
HP Client Manger 3–4
HP Client Premium Suite 3–5
HP Insight Diagnostics 2–14 to 2–18
HP OpenView Client Configuration Manager 

3–6
HP OpenView Management Solution 3–6
HP ProtectTools Security Manager 3–5
HP System Software Manager 3–4
HPQFlash 3–10
image deployment 3–1
Intel Active Management Technology 3–7
Proactive Change Notification (PCN) 3–8
recovery 3–1
Remote ROM BIOS Flash 3–9
Remote System Installation 3–3
Restore Plus! CD 1–2
retired solutions 3–9
servicing computer 5–7
Subscriber’s Choice 3–9
updating and management 3–3

spare part number
tamper resistant wrench 5–7
Torx T-15 screwdriver 5–7

speaker
CMT removal and replacement 6–35
SFF removal and replacement 7–35
USDT removal and replacement 8–10

static electricity 5–3
Subscriber’s Choice 3–9
surge-tolerant power supply 3–26
system board

CMT removal and replacement 6–28
reference designators E–1
SATA connectors 4–1
SFF removal and replacement 7–39
USDT removal and replacement 8–25

T
tamper-proof screws

CMT 6–2
SFF 7–2
tool 5–7

temperature control 5–5
thermal sensor 3–26
tools, servicing 5–7
Torx T-15 screwdriver 5–7
troubleshooting D–1 to D–35

U
Ultra-Slim Desktop See USDT
unlocking Smart Cover Lock 3–25
USB pin assignments A–3
USDT

access panel removal and replacement 8–4
battery removal and replacement 8–26
cable connections 8–12
cable lock removal and replacement 8–3
cable management 8–11
chassis fan removal and replacement 8–9
chassis illustrated 5–2
disassembly preparation 8–1
expansion card cages 8–14
expansion card removal and replacement 8–15
expansion card retaining latch removal and 

replacement 8–17
external security 8–3
front bezel removal and replacement 8–7
front I/O device removal and replacement 8–20
hard drive removal and replacement 8–18
heatsink assembly removal and replacement 

8–21
memory removal and replacement 8–13
optical drive removal and replacement 8–5
padlock removal and replacement 8–3
PCI expansion card cage 8–14
PCI Express expansion card cage 8–14
PCI Express expansion card removal and 

replacement 8–15
power supply connections 8–12
power supply removal and replacement 8–24
preparation for disassembly 8–1
processor removal and replacement 8–22
riser board removal and replacement 8–14
speaker removal and replacement 8–10
system board connections 8–12
system board removal and replacement 8–25
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Index

V
ventilation, proper 5–5

W
Wake-on-LAN feature D–24
Web sites

HP Client Foundation Suite 3–5
HP Client Management Premium Suite 3–5
HP Client Manager 3–5
HP OpenView Client Configuration Manager 

3–6
HP OpenView Management Suite 3–6
HP ProtectTools Security Manager 3–5
HPQFlash 3–10

Proactive Change Notification (PCN) 3–8
Remote ROM BIOS Flash 3–9
replicating setup 3–12
replicating setup, BIOS utility 3–12
Restore Plus! CD 1–2
ROM BIOS Flash 3–9
Subscriber’s Choice 3–9
support software 3–16
support software CD subscription 1–1

wrench, tamper-resistant
CMT 6–2
SFF 7–2


